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Get Help

There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications

Use help icons @ to access help in the application. If you don't see any help icons on your page, click your user image
or name in the global header and select Show Help Icons.

Get Training

Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community

Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You can
join forums to connect with other customers, post questions, and watch events.

Share Your Feedback

We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!
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1 Implementing Oracle Permitting and
Licensing Using Functional Setup Manager

Security Details for Implementing Oracle Permitting and
Licensing

This topic describes important security roles, requirements, or considerations specific to implementing Oracle
Permitting and Licensing.

Primary Role Access Description Associated Job Roles and Abstract Roles
Application Implementation Consultant Configure Oracle Permitting and Licensing Application Implementation Consultant
offerings.

For more information on creating roles for Oracle Permitting and Licensing, see Creating Custom Roles for Oracle
Permitting and Licensing.

For more information on all the predefined security data such as abstract roles, job roles, privileges and so on, see the
Security Reference for Oracle Permitting and Licensing.

Using Functional Setup Manager

This topic discusses how to use the Functional Setup Manager.

Oracle Functional Setup Manager provides an integrated, end-to-end process for functional administrators to manage
the implementation and maintenance of Oracle Permitting and Licensing services.

Business users configure features and manage setup data using the Functional Setup Manager. Subscription to
offerings, enabling functional areas, opting in features, and setting up guided end-to-end tasks pertaining to the
offerings are all driven through the Functional Setup Manager.

For a detailed understanding of the Functional Setup Manager, see the Oracle Fusion Cloud Applications
documentation: Using Functional Setup Manager.

Viewing Offerings and Functional Areas
To view the Public Sector offerings and their functional areas in Functional Setup Manager:

1. Select Navigator > Setup and Maintenance or select the Setup and Maintenance tile on the springboard.
2. Select a Public Sector offering from the Setup drop-down list.

The page lists all the functional areas on the left and the corresponding tasks on the right.

ORACLE
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Note: When configuring your offering using Functional Setup Manager, configure the functional areas in the order
they appear in Functional Setup Manager from top-to-bottom. Functional areas depend on the configuration data for
the functional areas appearing before them in the list.

Working with Help Links

You enable Help links in Functional Setup Manager during your implementation so that you can directly access related
documentation. To enable Help links:

1. Select Navigator > Setup and Maintenance or select the Setup and Maintenance tile on the springboard.
Select an Oracle Permitting and Licensing offering from the Setup drop-down list.

The page lists all the functional areas on the left and the corresponding tasks on the right.

3. Click View in the Task section and select Columns > Help. This option is turned off by default.

4. To view Help icons in the tasks list, select the Settings and Actions button in the header and click Show Help
Icons.

Selecting Feature Opt In

At the top of the Functional Areas section, use the Change Feature Opt In link to display the Opt In page for your
offering. Each offering, such as Permits or Business Licenses, provides a set of standard features, and each offering has
a different set of opt in features that you can choose to enable additionally. After you enable an op in feature, the setup
pages for that feature will be displayed within the functional areas within Functional Setup Manager for that offering.

Note: The reference entity feature is included for internal testing and demonstration purposes only. Reference
entities aren't supported for production use. Reference entities are planned to be supported in a future release only.

Feature Business License Code Enforcement Permits Planning and Zoning
Solution Packages X X X X
Permit Inspections X

Business License X

Inspection

Reference Entities X X X X
Permit Types X

Accounting X X X X
OPA Questionaire X X
Digital Assistant X X
System Administration X X X X
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Feature Business License Code Enforcement Permits Planning and Zoning

Application Extensions X X X X

Migrating Data From Your Test Environment to Your
Production Environment

This topic describes the utilities used to migrate setup data from your test environment to your production
environment.

In your pod you have these environments:

Environment Description

Test The test environment is where you learn about the product, enter your setup and configuration data,
and test your changes. For example, this is where you add the data for setting up your agency, create
your permits, specify branding modifications for your site, and so on.

Production The production environment is the environment your agency employees and your end users access
to complete transactions. The production environment reflects the “finished product” of what was
configured and tested in the test environment.

After you have made changes and tested them in the test environment, you then migrate any changed metadata and
setup data from your test environment to your production environment. You use the Functional Setup Manager export
and import utilities to complete these tasks.

For more information on the Functional Setup Manager export and import utilities, see Using Functional Setup
Manager.

For more information on managing transaction type data, see:

« Managing Transaction Type Configurations.

- Oracle Public Sector Community Development: Test to Production (Doc ID 2551940.1) on My Oracle Support.
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2 Setting Up Geographical Information

Importing Geographies

Use the Manage Geographies task to import geographical information.

The Manage Geographies task of the Agency Profile functional area in Oracle Functional Setup Manager enables you to
import geographies into your interface tables. For detailed instructions on importing geographies, see the Oracle Fusion
Cloud Applications documentation: "Geographies" in Implementing Applications.

Importing geographies automatically populates data for the following tasks:

- Manage Countries (Setting Up Counties)

- Manage States (Setting Up States)

- Manage Counties (Setting Up Counties)

- Manage Cities (Setting Up Cities)

- Manage Public Sector Currencies (Setting Up Currencies)

Setting Up Countries

A country definition includes the country name and various identifying codes.

You add, modify, and delete countries on the Country page.

Adding a Country

1. Select Common Setup > Country.
2. Onthe Country page, click Add.
3. Onthe Country Details page, enter values for the following fields:

Page Element Description

Country Code Enter a the unique code that your system uses for the country. For example, you might enter
FRA for France.

ISO Alpha 2 Code Enter the two-letter International Organization of Standardization (ISO) code for the country.
For example, you would enter FR as the code for France.

ISO Numeric 3 Code Enter the three-digit United Nations (UN) M.49 code for the country. For example, you would
enter 250 as the code for France.

Country Name Enter the name of the country as it appears in your system.

ORACLE


https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FACIA

Oracle Public Sector Permitting and Licensing Chapter 2

Implementing Your Agency Setting Up Geographical Information
Page Element Description
4. C(lick Save.

Modifying a Country

1. Select Common Setup > Country.
2. Click a row on the Country page.
3. On the Country Details page you can:

o Update the country field values.
Note: You cannot edit the Country Code.

o Delete the country. You will be prompted to confirm the permanent deletion.

4. C(lick Save.

Deleting Countries

Select Common Setup > Country.

Click Edit.

Select the checkboxes next to all the countries you want to delete.
Click Delete. You will be prompted to confirm the permanent deletion.

PUWNA

Setting Up States

A state definition includes information such as the state name, country, and various ID codes.

You add, modify, and delete states on the State page.

Adding a State

1. Select Common Setup > State.
2. On the State page, click Add.
3. On the State Details page, enter values for the following fields:

Page Element Description

Country Enter the code for the country that the state is in.

State Code ISO Enter the International Organization of Standardization (ISO) code for the state.
Code Enter the unique code that your system uses for the state.

ORACLE
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Page Element Description
State Name Enter the name of the state.
Type Enter the subdivision type.
GNIS ID Enter the Geographic Names Information System (GNIS) ID for the state’s location.
4. Click Save.

Modifying a State

1. Select Common Setup > State.
2. Click a row on the State page.
3. On the State Details page you can:

o Update the state field values.
Note: You cannot edit the Country or State Code ISO fields.

o Delete the state. You will be prompted to confirm the permanent deletion.

4. C(lick Save.
Deleting States
1. Select Common Setup > State.
2. C(lick Edit.
3. Select the checkboxes next to all the states you want to delete.
4. C(lick Delete. You will be prompted to confirm the permanent deletion.

Setting Up Cities
A city definition includes information such as the city name, country, state, and certain ID codes.

You add, modify, and delete cities on the City page.

Adding a City

1. Select Common Setup > City.
2. On the City page, click Add.
3. On the City Details page, enter values for the following fields:

Page Element

Country Code and State Code

ORACLE
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Enter the codes for the country and state in which the city is located.
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Page Element Description
County Enter the five-digit International Committee for Information Technology Standards (INCITS)

code for the county in which the city is located.

FIPS Code Enter the seven-digit Federal Information Processing Standard (FIPS) code for the city.
City Name Enter the name of the city.
GNIS ID Enter the Geographic Names Information System (GNIS) ID for the city’s location.

4. Click Save.

Modifying a City

1. Select Common Setup > City.
2. Click a row on the City page.
3. On the City Details page you can:

o Update the city field values.
Note: You cannot edit the Country Code, State Code, or County fields.

o Delete the city. You will be prompted to confirm the permanent deletion.
4. C(lick Save.

Deleting Cities

Select Common Setup > City.

Click Edit.

Select the checkboxes next to all the cities you want to delete.

Click Delete. You will be prompted to confirm the permanent deletion.

POUNa

Setting Up Counties

A county definition includes information such as the county name, country, state, and certain ID codes.

You add, modify, and delete counties on the County page.

Adding a County

1. Select Common Setup > County.
2. Onthe County page, click Add.
3. On the County Details page, enter values for the following fields:

ORACLE
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Page Element

Country and State

INCITS Code

County Name
FIPS Code

GNISID

4. C(lick Save.

Modifying a County

1. Select Common Setup > County.
2. Click a row on the County page.

Chapter 2
Setting Up Geographical Information

Description

Enter the codes for the country and state that the county is in.

Enter the five-digit International Committee for Information Technology Standards (INCITS)
code for the county.

Enter the name of the county.

Enter the seven-digit Federal Information Processing Standard (FIPS) code for the county.

Enter the Geographic Names Information System (GNIS) ID for the county’s location.

3. On the County Details page you can:

o Update the county field values.

Note: You cannot edit the Country, State, or INCITS Code fields.

o Delete the county. You will be prompted to confirm the permanent deletion.

4. Click Save.

Deleting Counties

Click Edit.

PUOUNA

Select Common Setup > County.

Select the checkboxes next to all the counties you want to delete.
Click Delete. You will be prompted to confirm the permanent deletion.

Setting Up Currencies

A currency definition includes currency codes, a description, and the number of decimals that can be used to represent

an amount in the currency.

You add, modify, and delete currencies on the Currency page.
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Adding a Currency

1. Select Common Setup > Currency.
2. Onthe Currency page, click Add.
3. On the Currency Details page, enter values for the following fields:

Page Element Description
Currency Code Enter a the unique code that your system uses for the currency.
ISO Code Enter the three-digit International Organization of Standardization (ISO) 4217 numeric code for

the currency. For example, you would enter 840 for the US dollar.
Description Enter a short description of the currency.

Decimal Position Enter the number of decimal places that can be used to represent an amount for the currency.
For example, the United States dollar uses two decimal positions.

4. C(lick Save.

Modifying a Currency

1. Select Common Setup > Currency.
2. Click a row on the Currency page.
3. Onthe Currency Details page you can:

o Update the currency field values.

Note: You cannot edit the Currency Code field.

o Delete the currency. You will be prompted to confirm the permanent deletion.

4. Click Save.

Deleting Currencies

Select Common Setup > Currency.

Click Edit.

Select the checkboxes next to all the currencies you want to delete.
Click Delete. You will be prompted to confirm the permanent deletion.

PUOUNA
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5 Setting Up Your Agency

Setting Up Agencies

An agency is an organization that offers a range of services to its constituents, including issuing permits and licenses.
You set up a variety of agency-level settings, including options for plan reviews and inspections, on the Agency Details -
Agency Information page.

Oracle Permitting and Licensing doesn't currently support multiple agencies, so you can set up exactly one agency, with
agency ID 1.

Here's how to access the Agency setup:

1. In the Functional Setup Manager, select Setup: Public Sector <Offering> > Functional Area: Agency Profile >
Task: Manage Agencies.

2. Onthe Agency page, click the row for your agency.
3. Onthe Agency Details page, select the Agency Information tab.

Managing Agency Information

Administrators add and modify agency information on the Agency Details — Agency Information page.

1. Onthe Agency Details page, click the Agency Information tab.
2. Enter values for these fields in the General section:

Page Element Description

Agency ID Enter the number 7 as the ID for your agency.

Name Enter a name for the agency.

Description Enter a short description for the agency.

Country Enter the country in which the agency is located.

Currency Enter the currency that the agency uses for financial transactions.

This value is informational only. It does not affect the currencies for fees, cash drawers, or
payment adaptors.

Time Zone Select your agency’s local time zone. All times displayed in Oracle Permitting and Licensing use
this time zone.

n
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Page Element

Time Format, Date Format, and
Number Format

Oracle Policy Automation ID

Chapter 3
Setting Up Your Agency

Description

Select the default formats that the agency uses to display times, dates, and numbers for
anonymous users.

Enter the unique identifier for an agency-wide Oracle Intelligent Advisor policy model.

Oracle Intelligent Advisor is a separate Oracle product. Oracle Intelligent Advisor policy models
provide logic models for questionnaires that help public users determine which applications
they need to complete.

The policy model that you enter here is used by offerings that do not have an offering-specific
policy model. To specify an offering-level policy definition, select the Features tab on the
Agency Information page, then click the Options link for the offering.

For more information on Oracle Intelligent Advisor, see Overview of Oracle Intelligent Advisor
Configuration.

3. Inthe Payments section, you can configure the payment settings.

Page Element

Partial Payments

Payment Allocation Order

Description

Select a value to indicate whether partial payment is allowed only for agency users, allowed for
all users, or not allowed.

Select a value to prioritize the payment allocation either as oldest or newest. The selected order
first applies to the applications and then the fees.

4. Inthe Oracle Financials section, you can configure these settings.

Page Element

Financials Cloud Ledger

Description

ORACLE

Description

Enter the Oracle Financials Cloud General Ledger you are integrating with for importing
account information.

For more information, see Using Subledger Accounting.

Enter a description.

12


https://www.oracle.com/pls/topic/lookup?ctx=fa26c&id=u30206003
https://www.oracle.com/pls/topic/lookup?ctx=fa26c&id=u30206003
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FAUSL

Oracle Public Sector Permitting and Licensing Chapter 3
Implementing Your Agency Setting Up Your Agency

5. Inthe Property section, you can configure these property settings.

Page Element Description

Parcel Owner Format This field is reserved for future functionality. Currently, regardless of your selection, parcels
have one field to identify the parcel owner and an additional field to identify a secondary owner.

Hide property owners from public Turn on this switch to hide property owner information from public users.

users

Users can create a new address on Enables registered users to create a new address on the Search Property page during
applications application intake.

Identify and import property Enables registered users to identify and import property information using the GIS.

information using GIS

6. In the Business section, you can configure these business settings.

Page Element Description
Business Number Rule Select the autonumbering rule to increment numbers for businesses.
Note:

This field is required if the Business Licenses offering is enabled for your agency.
Autonumbering rules need to be defined after you create the agency, so be sure to return to
the agency pages to add the business number rule that you define.

Location Number Rule Select the autonumbering rule to increment numbers for business locations.

Note:

This field is required if the Business Licenses offering is enabled for your agency.
Autonumbering rules need to be defined after you create the agency, so be sure to return to
the agency pages to add the location number rule that you define.

7. Inthe Search section, you can search an agency using the default search filter or type.

Page Element Description

Default Search Filter Select a default search filter. The available search filters are Address, Parcel, and Owner.

13
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Page Element Description
Default Search Type Select the default search type. The available search types are Starts with and Contains.

8. Inthe Copy Applications section, you can define the number of copies that can be created for an application.

Page Element Description

Maximum Copies Allowed Use the increment and decrement buttons to increase or decrease the number of copies that
can be created for an application at a time. By default, this is set to five, but the agency can
enter any number between 0 to 100.

9. The fields in the Business Rules Framework section apply to setting up email notifications for business rules in
a status of Error and for setting up automated retries for unsuccessful business rule actions.

For more information on setting up email notifications and automated action retries, see Viewing Business Rule
Logs and Scheduling Automated Retry.

10. In the Plan Reviews section, you can set up plan reviews with these options for both the Permits and Planning
and Zoning offerings.

Page Element Description

Default Plan Review Date Type Filter = Select a default value for the date type filter on the Plan Reviews console page for agency staff:

o Cycle Due - The date when the plan review cycle is scheduled to be completed.
o Cycle Created - The date when the plan review cycle was created.

o Reviewer Due - The date by which the plan reviewer must provide a decision.

o Reviewer Decision - The date when the plan reviewer provided a decision.

o Cycle Decision - The date when the cycle decision was provided.

o AllDates - All date types.

Default Plan Review Date Filter Select a value in the time period filter to correspond with the date type filter on the Plan
Reviews console page for agency staff:

o Today

o Yesterday

o Tomorrow

o Last 14 Days or Next 14 Days
o Last 30 Days or Next 30 Days

You can't select specific dates as the default date value.

Exclude Saturday and Sunday Turn on this switch to calculate plan review due dates not counting Saturday and Sunday. The
holiday calendar is always taken into account to exclude holidays.

14
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Page Element Description

For more information. see Setting Up Plan Review Due Dates.

For more information about the agency's Plan Reviews list page, see Using the Plan Review Console.
11. Inthe Inspections section, you can set up inspections with these options for both the Permits and Business
Licenses offerings.

Page Element Description

Default Inspection Status Filter Select a default value for the inspection status filter on the Inspections list page for agency staff
displayed using the Redwood Experience:

o Pending - Displays inspections with no inspector assigned and the status is Pending.
o Requested - Displays inspections that were requested and the status is Requested.

o Scheduled - Displays inspections that were scheduled and the status is Scheduled.

o Completed - Displays inspections with a Completed status.

o Canceled - Displays inspections with a Canceled status.

This field is optional but defaults to Requested for a new agency or offering implementation. If
the default value is blank, inspections with any of the listed status types are displayed.

Note:
This field is only available when your agency has enabled the agency's Inspections list page
using the Redwood Experience in the Functional Setup Manager.

Default Inspection Date Filter Select a value in the time period filter to correspond with the date type filter on the Inspections
list page for agency staff displayed using the Redwood Experience:

o Today

o Yesterday

o Tomorrow

o Next Week or Last Week

o Next Month or Last Month

Inspection Count Limit Enter the maximum number of inspections in a day that can be assigned to an inspector. The
default value is 20.

For more information about the Inspections list for agency staff, see Managing Inspections for an Agency.

15
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12. In the Application section, you can do this setup:

Page Element Description

Automatic Saving for Intake Forms Enables agencies to automatically save the applications for intake forms.

Enable images on apply page Enables agencies to attach images to display group definitions. The images can help convey
the type of applications within that group. After enabling, you can use the Application Display
Group Details page to upload an appropriate image for that display group.

For more information, see Setting Up Application Display Groups.

Guest users can estimate fees Enables guest users (that is, nonregistered users) to estimate fees prior to submitting an
application.

For more information, see Estimating Fees.

13. Click Save.

Adding an Agency Address

Administrators add and modify agency addresses on the Agency Details — Addresses page.

1. Onthe Agency Details page, select the Addresses tab.
2. Onthe Addresses page, and the + Add button.
3. Onthe Addresses drawer, enter values for the following fields:

Page Element Description

Address ID Enter a unique ID for the address.

From Date and To Date Enter the date range for which the address is valid.
Address fields The address fields comprise the agency address.

o The Country/Region field displays United States.
o Enter the street address in Address Line 1and Address Line 2.

o Select a city from the City drop-down list. The options are displayed with the city and state
combination. When you select the city, the state is automatically added to the State field.

o After you select a city and state, click the Postal Code drop-down list, where the
appropriate postal code for the city and state appears.

Primary Turn on the switch to indicate that this is the primary address for the agency. An agency may
have only a single primary address.

16
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4. Click Save.

Modifying or Deleting an Agency Address

1. Onthe Agency Details page, select the Addresses tab.
2. Onthe Addresses page, click an address row.
3. Onthe Addresses drawer, you can do this:

o Update the agency address field values.

Note: You can't change a primary address row to nonprimary one. Instead, when you update a
nonprimary row to primary, all other address rows are saved as nonprimary.

Click Save to save your changes.

o Delete the address. Click Delete for the address on the drawer. You will be prompted to confirm the
permanent deletion.

Note: You can't delete the primary address; select a different address as primary first, then delete the
address.

4. Click Save.

Adding Agency Languages
On the Agency Details page, select the Languages tab.

For information on adding languages and establishing language defaults for an agency, see Setting Up Languages.

Configuring Agency-Level Options for Specific Offerings

On the Agency Details page, select the Features tab.

The Features tab lists the Public Sector offerings that are enabled in Functional Setup Manager (FSM) for your agency.
Use the Review Options button to configure offering-specific settings.

For more information about configuring these options, see
Permits: Setting Up Agency-Level Options for Permits
Planning Applications: Setting Up Agency-Level Options for Planning Applications
- Code Enforcement: Setting Up Agency-Level Options for Code Enforcement

Business Licenses: Setting Up Agency-Level Options for Business Licenses

Configuring Agency-Level Email

On the Agency Details page, select the Email Configuration tab.

For more information about managing the agency sender email address used in communications such as ad hoc
communications, see Setting Up Agency-Level Email.
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Setting Up Related Transaction Linking

The Related Transactions tab allows you to set up access for your users to link their applications with other related
transactions. You control the way related transactions are linked with applications based on whether an applicant or a
contact user is working with the application.

On the Agency Details page, select the Related Transactions tab.

Turn on the switches to allow linking related transactions for applicants and contacts:

- Applicants can link transactions to only their own applications
- Applicants can link transactions to any application
- Contacts can link transactions to any application that they manage

- Contacts can link transactions to any other application

Note: If none of the setup options are turned on, then the Link and Actions options on the Related Transactions
page won't be available for applicants and contacts.
Click Save.

See Working with Related Transactions.

Setting Up Languages

Add languages and establish language defaults for your agency.
To enable user language preference and locale support you must:
1. Define the supported languages for your agency.

2. Define the default language for anonymous user setup.

Adding Supported Agency Languages

Supported languages are available for users to select as the default language on the My Preferences page accessed
from the profile icon in the global banner. Additionally, you must select one supported language as the default language
for anonymous user setup.

1. Select the Setup and Maintenance tile on the Agency Springboard to access the Functional Setup Manager.

2. From the Setup drop-down list, select your offering.

3. From the Functional Areas list in the left panel, select Agency Profile.

4. The right panel shows the required tasks for the selected functional area. Select All Tasks from the Show drop-
down list and then select Manage Agencies from the tasks list.

5. Click the row for your agency on the Agency Information tab.

6. Select the Languages tab.

7. Click + Add.
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8. Enter values for the following fields:

Page Elements Definition
Language Select the language you want to add.
Primary Select to indicate that this is the primary language for the agency. An agency may have only

one primary language.

From Date and To Date Enter the date range for which the language is valid.

9. Click Save.

Define the Default Language for Anonymous User Setup

Select the Setup and Maintenance tile on the Agency Springboard to access the Functional Setup Manager.
From the Setup drop-down list, select Public Sector Permits or Public Sector Planning and Zoning.

From the Functional Areas list in the left panel, select Application Extensions.

Select the Manage Applications Core Administrator Profile Values task.

P WNa

This is an example of the Manage Applications Core Administrator Profile Values page.

Manage Applications Core Administrator Profile Values @ [ save [ save and Close [ cancel

4 Search : Profile Option

search || Reset

Search Results
4 Search Results : Profile Options
Viewv i Detach
Profile Option Code Profile Display Name Application Module StartDate EndDate  Description

FND_LANGUAGE Defautt Language Oracle Middleware Exten... Application Common 4128109 Speciy the defaultlanguage, which can also be setin preferences

4 FND_LANGUAGE: Profile Values

actons v Viewv 4 % [ = vetacn

* Profile Level Product Name User Name.

g

5. Enter FND_LANGUAGE in the Profile Option Code field and click Search.

6. Add a profile value with a Profile Level of Site and a Profile Value of the supported language that you want to
establish as the default.

7. Click Save and Close.

Setting Up Agency Integrations

Add Oracle Integration Cloud (OIC) integrations for your agency.
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Adding an Agency Integration

You can define and enable the OIC integrations on the Integrations tab of the Agency Information page. For example,
you can add an integration that publishes your agency's accounting information to OIC where it can be transformed and
imported by third-party applications.

For more information on publishing accounting information to OIC, see Setting Up OIC to Publish Public Sector
Accounting Information (Doc ID 2784020.1) in My Oracle Support.

1. Select Common Setup > Agency.
2. Click the row for your agency on the Agency Information tab.
3. Select the Integrations tab.
4. Click Add.
5. Enter values for the following fields:
Page Elements Definition
Integration Type Select the type of integration that you want to add.
Note:
Currently, the only valid value for this field is Publish Accounting, which enables you to
publish your agency's accounting information to OIC.
Integration Name and Integration Enter the exact name and version number of the OIC integration that you want to add for your
Version agency.
Integration Parameter This field is reserved for future use. It is not used for publishing accounting information.
Integration Enabled Turn this switch on to enable the integration.
When a Publish Accounting integration is enabled, the Export Journals to ERP process
publishes accounting information to OIC. For more information on the Export Journal to ERP
process, see Exporting Journal Entries.
6. Click Save.

Setting Up Conditions

A condition indicates a dependency or contingency for completing the application process. You set up, modify, and
delete condition definitions on the Conditions page.
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Conditions Overview

A condition indicates a status, criterion, or action that you can apply to an object in the system, such as an address,
parcel, person, contractor license, business license, or transaction. A transaction can be a permit, planning application,
or business license application.

Conditions are defined with a severity that might affect operations when applied. Condition rules with a Hold severity
prevent one or more of the operations that are selected at the time of applying the condition. Condition rules with a
Lock severity prevent all operations as described in the table here.

Rule Applicable Objects Usage
Prevent Application Progress: Address, Parcel, Person, Business License, and = Agency staff applies a condition to a record
. Business License Amendment Contractor License that prevents an applicant from submitting any
) _ new permit, planning application, or business
- Business License Renewal license that contains the address, parcel,

person, business license, or contractor license.
License amendment and renewal are related to
business license.

Prevent Workflow Advancement Address, Parcel, Person, Contractor License, Agency staff applies a condition to a permit,
business license, and Transaction planning application, or business license
application record that prevents workflow
from advancing. The workflow tasks cannot be
completed until the condition is resolved.

Prevent Issue or Final Address, Parcel, Person, Contractor License, Agency staff applies a condition to a
business license, and Transaction transaction record that prevents the permit,
planning, or business application cycle from
completing its final step until the condition is
resolved.

This rule can be used to prevent the issuance
of the permit or business license certificate.
Additionally, the same rule can also applied to
prevent the final workflow task.

Your workflow process definition must explicitly
identify the final human task that is blocked by
this condition. Use the PSC_FINAL_ACTIVITY
custom property to identify this task. See Using
Custom Properties.

Prevent Payment Address, Parcel, Person, Contractor License, Agency staff applies a condition to a
business license, and Transaction transaction application record that prevents a
user from processing a payment.

Prevent Inspection Schedule Address, Parcel, Person, Contractor License, This condition rule prevents agency staff from
business license, and Transaction scheduling a new permit inspection. It does not
affect existing inspections that have already
been scheduled.

Prevent Inspection Result Address, Parcel, Person, Contractor License, This condition rule prevents agency staff from
and Transaction finalizing the permit inspection results.
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Rule Applicable Objects Usage
Prevent Final Inspection Address, Parcel, Person, Contractor License, Agency staff applies a condition to a permit
and Transaction to prevent adding or proceeding with a final
inspection.

Setting Up and Applying Conditions Using Business Rules Framework

The Business Rules Framework enables you to set up conditions that should apply to a permit, planning application, or
business license application based on the criteria you define in the business rules.

You must configure the Workflow to trigger the Business Rules Framework process, which in turn applies the condition
to the submitted transaction. The submitted applications are listed in the Transactions page with the conditions applied,
ready for further processing.

Note: Ensure that the appropriate workflow definition is set up for the business license, permit, or planning
application type that will associate with the condition. See Setting Up Permit Types, Setting Up Planning Application
Types, and Setting Up Business License Types.

For more information on adding and configuring events with business rules for conditions, see Setting Up Apply
Condition Actions. For information on viewing the applied conditions and resolving them, see Working with Application
Conditions

Viewing Business Rules Information

Apart from the condition information, the condition details page shows the business rules framework information
related to the condition in use:

- Offering: The offering for which the condition is used.

- Event Name: The name of the event that defines the business rules.

- Event Description: The description of the event.

« Rule Name: The name of the rule that defines the criteria and the condition action.
- Enabled: The switch shows if the business rule is enabled for the current condition.

I Note: The Business Rules Framework section is applicable only to conditions with object type Transaction.

Adding Condition Definitions

To add condition definitions:

1. Select Common Setup > Condition.
2. Onthe Condition page, click the Add New button.
3. Onthe Condition Details page, enter values for the following fields:

Page Element Description

Condition Name Enter a unique condition name.
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Page Element Description
Object Type Select an object type to categorize the condition, based on the object type to which it is applied:
o Address
o Parcel
o Person

o Contractor License
o Business License

o Transaction

Display Message Enter a message that is displayed to external users.
Severity Select a severity level for each condition from these options:
o Lock

At the most severe level, the Lock condition suspends all operations, including workflow
advancing, payment processing, inspection scheduling, and inspection results.

o Hold

Agency staff can select which rules to apply to conditions with the Hold level of severity.
o Notice

The Notice level functions as an alert and has no effect on operations.
For more information, see Working with Application Conditions.

For information on conditions on business licenses, see Applying Conditions to Licenses.

Apply Condition to Transactions Applies the condition automatically to any existing permit and planning applications belonging
to the address, parcel, person, business license, or contractor license.

The condition on business license will apply only to the license renewal and amendment
applications.

You turn off the switch to disable the condition from automatically applying to the existing
transactions.

Note:
This switch is not available by default for the Transactions object type.

At the time of applying the condition, users can decide to enable or disable the option on the
Condition Details page.

Condition Rules Select the rules for the condition. Condition rules are applied by default depending on the
severity of the condition:
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Description

o Lock severity: All condition rules are automatically applied and no actions can be taken
until the condition is resolved.

o Hold severity: Select one or more default condition rules.
o Notice severity: No condition rules apply.

See the list of available condition rules in the "Conditions Overview" section of this topic.

Select the level of priority for this condition:

o High
o Low

o Medium
Enter a description of the condition.
Enter any additional information regarding this condition.
Turn on this switch to allow parcel conditions to be automatically resolved by the Parcel Import

process.

A condition will be automatically resolved only when the parcel import option is selected to
resolve the parcel or address condition if it's not found in the import file.

A condition will also be resolved by the Parcel Import Process when an existing condition is
found in the import file, and the status field for that condition is set to Resolve in the import file.

This section shows the details of this condition’s association with the events in the Business
Rules Framework.

4. Verify that the Enabled switch is turned on. New conditions are active by default.

Note: You can't disable or delete the condition if it's being used by the Business Rules Framework to
automatically apply conditions or if the condition is already applied to any object.

5. Click Save.

Modifying Conditions

1. Select Common Setup > Condition.

2. Click a row on the Condition page.

3. On the Condition Details page you can update the display message, severity, description, and the Enable

switch.
4. Click Save.

ORACLE
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Deleting Conditions

You can delete a condition only if it isn't being used. If you try to delete a condition that is applied to a transaction,

or contractor license, or business license, you will see an error message stating that you can't remove the condition
because it has already been applied.

You also can't delete or disable a condition in the condition setup when the condition is used by the Business Rules
Framework in the Apply Condition action.

1. Select Common Setup > Condition
2. Click a row on the Condition page.
3. On the Condition Details page, click Delete to delete the condition.

Setting Up Autonumbering

Set up autonumber rules to increment identifying numbers for documents such as permits and invoices. The identifying
numbers can include multiple parts, and each part can represent either a sequential number, static text, or a date.

You add, modify, and delete autonumber rules on the Autonumber page.

This example illustrates the Autonumber Details page.

Autonumber Details

Rule Header

* Rule Name Sample
* Description  Sample
* Maximum Size 17
* Number Type Permit
Reset Sequential Number = Yearly
Rule Definition
Number of Parts 3 ¥ Next Number Preview PER-1000000-JUL18
Part 1 Statictext ¥ PER Separator -

Part2  Sequential ¥ 1000000

Part3 Date ¥ MMMYY

Maximum Length 7

Adding an Autonumber Rule

1. Select Common Setup > Autonumber.
2. On the Autonumber page, click Add.

ORACLE

Copy Existing Rule

Zero-
padding

Separator -

-

Cancel Save
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3. Onthe Autonumber Details page, enter values for the fields in the Rule Header section:

Page Element

Rule Name

Copy Existing Rule

Description

Maximum Size

Number Type

ORACLE

Description

Enter a unique name for the rule. The name can’t include spaces.

Click this link to copy the rule definition from an existing autonumber rule. The copy action
copies the number type and the reset frequency as well as the actual rule definition.

Clicking the link opens a a modal window with a list of existing autonumber definitions. Locate
the definition you want to copy, then click the Select button for that definition

Enter a description for the autonumber rule.

Indicate the maximum length of the generated number.

Note:

As you set up your autonumber rule, take care that the maximum size of the autonumber
accommodates the maximum length of each part of the identifier plus any separators that
you define.

Select the type of object that uses this autonumber rule. When you choose an autonumber rule
for an object, only rules with the appropriate type are available.

These are the available number types:

o Business entity
o Business license
o Case

o Cashier session

Note:
If you select this number type, make sure that the rule uses only Sequential part types.

o Code inspection
o Deposit account
o Deposit slip

o Incident

o Inspection

o Invoice

o Permit

o Planning application
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Description
o Project
o Receipt

Note:
You can’t change the number type for a rule that is already in use.

The identifier that an autonumber rule generates can include a mix of static text, a date, and a
sequential number. Select how often the sequential number portion of the identifier is reset to
zero:

o Calendar month: The sequential number resets to zero at the beginning of each month.
o Calendar year: The sequential number resets to zero on January 1 of each year.

o Fiscal year: The sequential number portion resets to zero on the first day of your fiscal
year. When you select this option, the Fiscal Year End Month field appears.

o None: Sequential numbers continue to increment as defined without resetting.

If you reset the sequential number portion of the identifier on the first day of the fiscal year,
select the month when your fiscal year ends. For example, if your fiscal year end month is June,
then the sequential number resets to zero on July 1 of each year.

4. Inthe Rule Definition section of the page, enter the number of parts, or segments, for the rule:

CAUTION: The autonumber rule definition determines the system generated application ID of your
transaction such as permit, planning application, and business license.Therefore, you must define the rule in
a way that generates a unique application ID. Failing to do so can result in duplicate application IDs, which will

cause issues in the application.

Page Element

Number of Parts

ORACLE

Description

Select the number of parts, or segments, comprising the rule, up to 5 parts. Segments can be
static text, a date, or a sequential number.

For example, the identifier IVvC-0000010067-0CT10 is made of 3 segments (static text, then a
sequential number, then a date) separated by hyphens. The identifier INVOICE_001 is made of

2 segments (static text and a sequential number) separated by an underscore.

When you select the number of parts, the corresponding number of rows appear in the rule
definition grid. For example, if there are two parts, then rows labeled Part 1 and Part 2 appear.
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5. Inthe rule definition grid, select the part type for each row, then enter the related information in the additional
fields that appear.

Part Type Related Information

Static Text In the unlabeled field that appears next to the part type, enter text that remains the same for all
identifiers. For example, enter /VC or INVOICE.

Note:
Do not include spaces in the static text.

Cashier session IDs must be numeric, so don't include any static text in an autonumber
definition with the Cashier Session number type.

Sequential a. Inthe unlabeled field that appears next to the part type, enter the next document number
to use. The number must be 7 or greater. The system increases this number by one each
time a new identifier is generated and saved.

b. Inthe Maximum Length field, Enter the maximum number of digits for the sequential
number. Select a number from one to ten.

c. Select the Zero Padding checkbox to add zeros before the generated number to make up
the number of digits in the definition. For example, if the maximum length of this partis 5
digits, and the current number is 15, zero padding formats this part as 00015.

Date In the unlabeled field that appears next to the part type, select the date format.

Note:
Don't include dates for Cashier Session autonumbers, which must be numeric only.

The available date formats are made of these date codes in various combination:

o Years: YYYY represents the year with its full four digits, and YY represents the year by its
last two digits.

o Month Numbers: MM represents the month as a two-digit number.

o Month Abbreviations: MMM represents the month as a three-character abbreviation in
English, such as JAN for January. The values are not translated into the user’s session
language. Formats that include MMM are available only if the agency’s language is
English.

o Days: DD represents days as two-digit numbers. This is the only option for days.

o Quarters: Q represents quarters. For example, the code for the first quarter of the year is 1.

If you select Fiscal year in the Reset Sequential Number field, all numeric months, years, and
quarters are counted from the beginning of the fiscal year. For example, if the Fiscal Year End
Month is June, then:

o The MM value for June is 12, for July is 07, and so forth.

o The YYYY value is the calendar year when the fiscal year ends. In the year 2025, January-
June are part of the 2024-2025 fiscal year, so YYYY is 2025 during those months. But
July-December of 2025 are part of the 2025-2026 fiscal year, so YYYY is 2026 during
those months.
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Part Type Related Information

o The Q value for April through June is 4, for July through September is 7, and so forth.

6. Inthe rule grid, select a Separator to appear after each part except the last.
Select from the following separators:
o (None)
o - (hyphen)
o /(forward slash)
o *(asterisk)
7. Verify the generated number for the selected date format and separators in the Next Number Preview field.
8. Click Save.

An error appears if the overall maximum size of the autonumber doesn’t accommodate the maximum lengths
of all of the parts and separators that you define.

Modifying an Autonumber Rule

Select Common Setup > Autonumber.

On the Autonumber page, click the row you want to modify.

Update the rule header and rule definition fields on the Autonumber Details page.
Click Save.

POUNa

Deleting an Autonumber Rule

I Note: You can’t delete autonumber rules that are already in use.

1. Select Common Setup > Autonumber.
2. C(lick the row you want to modify.
3. On the Autonumber Details page, click Delete.

Setting Up Code Types

Code types are specific published codes, guidelines, ordinances, and so forth. Examples might include the International
Building Code, published by the International Code Council (ICC), and the National Fire Code, published by the National
Fire Protection Association (NFPA).

Note: Code types are not currently used in the public sector application.

You add, modify, and delete code types on the Code Type page.

Adding a Code Type

1. Select Common Setup > Code Type.
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2. Onthe Code Type page, click Add.
3. Onthe Code Type Detail page, enter values for the following fields:

Page Element Description
Code Type ID Enter a unique code type ID for a specific code type. For example, enter IFC for International Fire
Code.
Name Enter the complete name of the code type.
Description Enter a description of the code type.
4. C(Click Save.

Modifying a Code Type

Select Common Setup > Code Type.

Click a row on the Code Type page.

On the Code Type Detail page you can update the code name and description.
Click Save.

PANA

Deleting Code Types

1. Select Common Setup > Code Type.

2. To view a definition before deleting it, click the row to be deleted, then click the Delete button on the Code Type
Details page.

3. To delete one or more definitions without viewing details:

a. Click Edit.
b. Select the checkboxes next to the definitions that you want to delete.
c. Click Delete.

You will be prompted to confirm the permanent deletion.

Setting Up Code References

Code references provide detailed specifications that come from a broad range of codes, guidelines, ordinances, and
so forth. Even if the source document does not use the word “code,” use the Code References pages to enter the
information into the system. A code reference maps to a specific section in the source document.

Note: The code references described in this topic are not currently used in the public sector application. To set up
code references for code enforcement, see Setting Up Code References for Code Enforcement.

You add, modify, and delete code references on the Code Reference page.
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This example illustrates the Code Reference Details page.
Code Reference Details

* Standard Type  Electrical v
* Standard Name  General

* Code Section  2702.1.4

* Effective Start Date  7/25/18 —
Effective End Date  Open =
* Code Type IBC o,

* Description  Load Duration

E

URL  https://codes.iccsafe.org/public/docum

Content 10 @ccess instructions, place the cursor in the text editor and press Alt + 0.

Font ~ | Size ~B I U & A-B | = i «

Emergency power systems shall automatically provide secondary power within 10 seconds
after primary power is lost, unless specified otherwise in this code. Standby power systems
shall automatically provide secondary power within 60 seconds after primary power is lost,
unless specified otherwise in this code.

-

Cancel Save

Prerequisites

Before you set up code references, you must define:

- Code types, which represent specific published documents that contain codes, guidelines, and so forth.

See Setting Up Code Types.

- Standard types, which describe the different fields or disciplines that codes relate to. Examples might include
fire safety or electrical systems.

Set up standards types by defining values for the ORA_PSC_CC_STD_CODE_TYPE lookup type. Define these
values on the Lookup Type pages. See Setting Up Lookups.

Adding a Code Reference

1. Select Common Setup > Code Reference.
2. Onthe Code Reference page, click Add.
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3. Onthe Code Reference Detail page, enter values for the following fields:

Page Element

Standard Type

Standard Name

Code Section

Effective Start Date and Effective End
Date

Code Type

Description

URL

Content

4. Click Save.

Description

Select the type of standard that the code falls under. Standard types represents fields or
disciplines such as Materials, Engineering, or Installation.

Enter the title of the section that contains this code reference. This title comes from the source
document.

Enter the section number for this code reference. The number uniquely identifies this reference
within the source document.

Enter the official effective start date of the code reference, and optionally enter an end date.

Select a code type from the values that you defined on the Code Type page. The code type
identifies the source document.

See Setting Up Code Types

Enter a description of the reference.

Enter a URL link to the source document.

Enter detailed content copied from the source document.

Modifying a Code Reference

P WNa

Click Save.

Deleting a Code Reference

Select Common Setup > Code Reference.

-—
.

Select Common Setup > Code Reference.
Click a row on the Code Reference page.
On the Code Reference Detail page, make any necessary changes.

2. Click a row on the Code Reference page.
3. Onthe Code Reference Detail page, click Delete.

You will be prompted to confirm the permanent deletion.

ORACLE
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Setting Up Backdating for Cases and Incidents

Backdating during incident or case creation allows agency users to create incidents and cases with a reported date in
the past, rather than defaulting to the current system date. This helps in instances, such as weekends or holidays, when
incidents or cases may be reported but not entered directly into the system until the next business day.

Agencies can configure to allow backdating for incidents, cases or both during the intake process.

1. Navigate to Setup and Maintenance of Offerings > Offering: Code Enforcement > Change Feature Opt In.
2. C(lick the Edit icon in the Features column of the Public Sector Code Enforcement row.
3. Click the Edit icon in the Issue Intake Configuration row.
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4. Select the checkbox next to the option to enable. You can select one or both options for your agency.

This is an example of an Edit Features: Public Sector Code Enforcement page showing the options available to
enable Issue Intake Configuration.

34
ORACLE



Oracle Public Sector Permitting and Licensing Chapter 3
Implementing Your Agency Setting Up Your Agency

Feature Name : Issue Intake Configuration X

Update reported date during incident creation

|v| Update reported date during case creation

Save and Close
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Setting Up Project Types

A project type describes the kind of project that an agency staff can select at the time of creating a project. You add new
project types based on the nature of the project you are adding. Selection of a project type is mandatory while creating
a new project, so, a minimum of one project type is required to be set up.

You add, modify, and delete project types on the Project Type page.

Adding a Project Type

1. Select Common Setup > Project Type.
2. On the Project Type page, click Add.
3. Onthe Project Type Detail page, enter values for the following fields:

Page Element Description
Project Type Enter the type of project, such as Commercial Project or Residential Project.
Rule ID Select a rule ID. Rule ID is an autonumbering sequence that you set up for a particular project

type. When you are creating a project with a certain project type, a project ID is generated
based on the sequence defined for the project type.

Rule IDs are created using the Autonumber page. For more information, see Setting Up

Autonumbering.
Description Enter a description of the project type.
Long Description Enter a detailed description of the project type.
Document Group Select a document group to allow your users to organize the various categories of attachment

files into a grouping.

See Setting Up Document Categories and Subcategories and Setting Up Document Groups.

4. Verify that the Enabled switch is turned on. The switch is turned On by default for a new project type.
5. Click Save.

Modifying a Project Type

1. Select Common Setup > Project Type
2. Click a row on the Project Type page.
3. On the Project Type Detail page you can:

o Update the rule ID, description, and long description.
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o Turn off the Enabled switch to deactivate the project type.
4. C(lick Save.

Deleting a Project Type

1. Select Common Setup > Project Type

2. To view a definition before deleting it, click the row to be deleted, then click the Delete button on the Project
Type Details page.

3. To delete one or more definitions without viewing details:

a. Click Edit on the Project Type page.
b. Select the checkboxes next to the definitions that you want to delete.
c. Click Delete. You will be prompted to confirm the permanent deletion.

Note: You can delete a project type only if it is not used by any project. When you attempt to delete a project type
that is used by a project, the Public Sector Cloud Service displays a message that you cannot delete the project type as
itis already in use by a project.

Setting Up Time Rules

Transactions for permits, planning applications, and code enforcement use time rules to calculate due dates for various
activities.

Time policies, which are grouped together to form a time rule for a specific classification, are defined by priority and
occurrence of each transaction that is related to the due date type set up for the time rule.

In general, the following logic is used to calculate due date:
Due Date = Trigger date + Dates based on the time rule

If the number of transactions created exceed the policy count, then the time rule that is defined for the highest policy
occurrence will be triggered.

Based on the transaction classification, time rules are assigned to transaction types:

Transaction Assigned to

Code Enforcement Incident’s issue type and subtype. See Setting Up Agency-Level Options for Code Enforcement and
Setting Up Issue Subtypes.

Permit Permit type. See Setting Up Agency-Level Options for Permits and Setting Up Permit Types.

Planning Application Planning application type. See Setting Up Agency-Level Options for Planning Applications and Setting
Up Planning Application Types.
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Note: Agency administrators add and modify time rules and assign them to transaction types so that appropriate
rules are applied for each transaction type. Every transaction type must have a time rule assigned for every system-

defined due date type. The following table shows the various delivered due date types and their details:

Due Date Type

ORA_PER_REVIEW_DUEDT

ORA_PNZ_PLAN_REVIEW_DUEDT

ORA_ABATE_APPL_PRD_DUEDT

ORA_INC_REV_DUEDT

ORA_INIT_INS_DUEDT

ORACLE

Description

Permit plan
review

Planning and
zoning plan
review

Appeal in case
of mandatory
abatement

Incident review
date

Initial inspection
date

Classification

Permit

Planning and
Zoning

Code
Enforcement

Code
Enforcement

Code
Enforcement

Events that
calculate the
due date

Plan review
cycle creation
for a permit

Plan review
cycle creation
for a planning
application

Case status
change to

Mandatory
Abatement

Incident creation

Initial inspection
creation

Trigger Date

Cycle creation
date

Cycle creation
date

Date on which
the case status
changed to
Mandatory
Abatement

Incident report
date

Inspection
schedule date

Usage

The plan review
cycle due date
and department
due dates are
generated when
the plan review
cycle is created.
The permit

type must be
configured to
use time rules.

The plan review
cycle due date
and department
due dates are
generated when
the plan review
cycle is created.
The planning
application

type must be
configured to
use time rules.

The appeal
due date is
updated with
this date when
the case status
is changed to
mandatory
abatement.

The incident

in the worklist
is marked with
a status of
Overdue when
the calculated
review due date
is less than the
current date.

The Inspection
due date is
updated with
this date when
the initial

Policy
Occurrence
Count value

1or more

1or more

1or more

1
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Due Date Type Description

ORA_RE_INS_DUEDT Re-inspection

date

Due date for
compliance

ORA_VIOL_CMPL_PRD_DUEDT

ORA_VIOL_APPL_PRD_DUEDT
period

Due date
for citation
compliance

ORA_CITATN_CMPL_PRD_DUEDT

ORA_CITATN_DUEDT Due date
for citation

payment

ORACLE

Violation appeal

Classification

Code
Enforcement

Code
Enforcement

Code
Enforcement

Code
Enforcement

Code
Enforcement

Events that
calculate the
due date

Re-inspection
creation

- Case
creation

- Inspection
resulting in
Violation
or
Remains in
Violation.

- Case
creation

. Case status
change to
violation as
a result of
a hearing
decision.

- Inspection
resulting in
Violation
or
Remains in
Violation.

. (Citation
issuance

- Inspection
resulting in
Remains in
Citation.

Payment
initiation

Trigger Date

Reinspection
schedule date

Case creation
date

Case
creation
date

Inspection
completion
date

Hearing
decision
date

Citation
issue date

Inspection
completion
date that
resulted in
Remains in
Citation.

Citation issue
date
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Usage

inspection is
scheduled.

The Inspection
due date

is updated
with this date
when the re-
inspection is
scheduled.

The date is
displayed as

the compliance
date on the Case

page.

The value

for the policy
occurrence
count is one (1)
at the time of
case creation.

Ensures that
the Request
Appeal option
is available
only during
the calculated
appeal period.

Updates the
compliance date
displayed on
the Case detail
page.

Late feeis
added after
the citation

Policy
Occurrence
Count value

2 or more

1or more

2 or more for
subsequent
inspections
that result in
Violation or
Remains in
Violation.

1for case
creation and
2 or more
for either an
inspection
that resulted
in Remains
in Violation
or a hearing
decision that
was updated to
Violation.

The first
issuance

of citation.
Subsequently,
this rule is
applied when
citations are
issued or when
inspections
result in
Remains in
Citation.

1or more
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Due Date Type Description Classification Events that Trigger Date Usage Policy
calculate the Occurrence
due date Count value

payment due
date.

ORA_CITATN_APPL_PRD_DUEDT Citation appeal = Code Case status Citation Issue Ensures that 1or more as

period Enforcement change to Date the Request per citation
Citation. Appeal option issuance.
Inspection is available
completion date only during

the calculated
appeal period.

Adding Time Rules

You configure the time rules and policies using the Time Rule page.

1. Select Common Setup > Time Rule. The Time Rule page lists all the time rules that are configured by the
agency.

2. Click Add on the Time Rule page to add a new time rule.

3. Onthe Time Rule Detail page, add values to the following fields:

Page Element Description

Time Rule Enter a name for the time rule.
Classification Select a transaction type:

o Code Enforcement

o Planning and Zoning

o Permit
Description Enter a description about the time rule.

Due Date Type Select the type of due date, which determines the time period or due date for a transaction.

4. Verify that the Enabled switch is turned on. The option is active by default for a new time rule.
5. Inthe Time Policy section, click the Add button to define a time policy.
6. On the Time Policy Details page, select values for the time policy:

Page Element Description

Priority Select the priority for the time policy:

o High
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Page Element

Unit of Measure
Unit of Measure Value

Policy Occurrence Count

Default

Modifying Time Rules

VA WNA

Click Save to save changes.

Deleting Time Rules

Chapter 3
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Description

o Normal

Displays the unit of measure of time, which is days.

Select the number of days.

Select an occurrence count value for the event, such as an inspection.

Note: The value can't be O.

Turn on this switch to set the time policy as the default for the time rule.

The first time policy that you create for each priority type is set as the default policy. When
you create additional time policies for a priority type, you can select any one of them as the
default policy. Designating a time policy as the default removes the default designation from
the previously designated policy.

Select Common Setup > Time Rule.

Select the time rule row you want to modify.

On the Time Rule Detail page you can change the time rule description, due date type, and the time policy.
Click the Enabled switch to enable or disable the time rule.

1. Select Common Setup > Time Rule.
2. Select the time rule row you want to delete.
3. On the Time Rule Detail page, click the Delete button.

Modifying Time Policies

1. Select Common Setup > Time Rule.
On the Time Rule page, select the time policy row to open the Time Policy Detail page. You can change values
for priority, unit of measure, unit of measure value, and policy occurrence count.

3. Click Save to save any changes.

Deleting Time Policies

PUNa

Click the Delete button.

ORACLE

Select Common Setup > Time Rule.
On the Time Rule page, select the time rule row for which you want to change the time policy.
On the Time Rule Detail page, click the time policy row to open the Time Policy Detail page.
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5. To delete multiple time policies from the Time Rule Detail page, click the Edit button in the Time Policy section
and select the checkboxes for the rows you want to delete.
6. Click Delete.

Related Topics
« Setting Up Plan Review Due Dates

Setting Up Lookups

This topic describes how to add and change values that appear in lookup lists. Lookup lists are referenced by various
fields in the application that display a static set of values from which the end user can select a value.

Lookup Types and Lookup Values Overview

Lookup types in applications are used to represent a set of codes and their translated meanings. To the end users, a
lookup type displays a list of values from which they select values.

You use the Lookup Types page to access lookup types, and you use the Lookup Type Details page to modify lookup
types, add lookup values, and add lookup types, where authorized.

When working with lookups, you deal with lookup types and lookup values.

Lookup Element Description

Lookup Type Alookup type is a static list of values users view to make entries in the application. The application
references a lookup type to display its list of values.

Lookup Value Alookup value is a single item contained within a lookup type. For example, Paid is a lookup value for
the Fee Status lookup type. Lookup types typically contain numerous lookup values.

Lookup types are delivered as seed data for your service. You can only modify selected lookup types, such as Business
Type, UOM Type, Standard Code Type, and so on. Most lookup types are read-only.

Modifying Lookup Types

Lookup types can be associated with lookup lists on:

Pages in your offering.
Predefined field groups added to intake forms.
User-defined fields added to intake forms.

Note: Lookup lists created for user-defined fields in an intake form can only be viewed from the Lookup Type page
after the form has been published. Managing lookup lists for user-defined fields should be completed only within the
Intake Form Designer.

This example illustrates the Lookup Type page. Details are in the surrounding text.
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Lookup Type
+ |2
Lookup Type
ORA_PSC_PER_INS_CONTACT
ORA_PSC_PER_INS_SIG
ORA_PSC_PER_INS_SYS_STATUS
ORA_PSC_PER_ORIGINATOR
ORA_PSC_PER_OWNER_SIG
ORA_PSC_PER_PUB_USER_ENABLED
ORA_PSC_PER_RECORD_STATE
ORA_PSC_PER_REC_SYS_STATUS

Page 2 of8 (9-16 of 62 items) K <

To modify a lookup type:

Meaning

Contact method

Inspector Signature Optien
Inspection System Status
Record Originator

Owner Signature Option
Public User Enabled
Record State

Record System Status
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Search... .:‘\ Y

Application Module Configuration Level

Permits Permit Inspections Extension >
Permits Permit Inspection Setup System >
Permits Permit Inspection Setup System »
Permits Application Intake System >
Permits Permit Inspection Setup System >
Permits Application Intaks System >
Permits Application Intake System »
Permits Permit Setup System >

A Show Default A4

1. Select Common Setup > Lookups.
2. Onthe Lookup Types page use the Search box to filter the lookup types by keyword.

For example, to view the Business Type lookup type, enter business in the Search box.
3. Click on the row for the lookup type you want to view.
4. View the contents of the Lookup Type Details page.

Page Element

Lookup Type

Application

Meaning

Configuration Level

Module

Description

Description

Identifies the lookup type within the application.

Identifies the application that uses the lookup type. For example, Permits, Common
Components, and so on.

The actual Ul display name used to represent the list of values contained in the lookup type.

Indicates at what level the lookup can be modified. Options are:

o System: Only Oracle development teams can modify lookup types at this configuration
level.

o Extension: Customers can perform minimal tasks, such as add lookup values.

o User: Customers can add lookup values, delete lookup values, update the meaning, and
update the description.

The internal application module using the lookup type, such as Billing Entry, Billing Setup, and
so on.

Identifies the purpose and use of the lookup type.

5. If you need to add lookup values, refer to the following section for steps for that task.

ORACLE
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6. Click Cancel to close the lookup type, or click Save if you made any changes.

Adding Lookup Values

This example illustrated the Lookup Value Details page. Details are in the surrounding text.

Lookup Value Details

* Lookup Code
Display Sequence
Enabled

Start Date

End Date

* Meaning

Description

Public

2 v A
2018-08-17 =
2020-08-17 =

Public Sector

Cancel Save

You can add lookup values to lookup types with a configuration level set to User or Extension.

To add lookup values:

1. Select Common Setup > Lookups.
2. On the Lookup Types page use the Search box to filter the lookup types by keyword.

For example, to view the Business Type lookup type, enter business in the Search box.

3. Click on the row for the lookup type you want to view.
4. Onthe Lookup Type Details page, click Add under Lookup Value Type.

ORACLE
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5. On the Lookup Value Details page, enter these values:

Page Element

Lookup Code

Display Sequence

Enabled

Start Date

End Date

Meaning

Description

Tag

6. Click Save.

ORACLE

Description

An internal application code for each lookup value that is not visible to users. It is typically a
shorter, less user-friendly representation of the item. For example, ORA_DRIVER_LIC for State
Driver’s License, or LEN for Length, if listing units of measurement.

Note:

Lookup lists created in the designer for user-defined fields on an intake form begin with PSC.

Control in what sequence the lookup value appears in the list displayed to users, where 2
appears above 3. If you do not specify a sequence, the application displays the items in the
order they were entered.

Turn on to make a lookup value active. If a lookup value is not enabled, then the application
does not display it to the end user in the list of values for that lookup type.

Note:
It is not recommended to disable lookup values once your implementation is in production
because this can invalidate existing transaction data.

Set a start date for the lookup value to become active. Even if the lookup value is enabled, if a
start date is set, the application does not display the lookup value until the start date is reached.

Set an end date for a lookup value to no longer be displayed in a list of values.

The display name for the lookup value. End users see this value in the list of values displayed at
run time. They do not see the Lookup Code value.

Provide any additional information to help identify the purpose of the lookup value or
clarification regarding what it represents.

Tags allow you to add a label to your lookup codes. A tag can be used to categorize lookups
based on facilitating searches or guiding how a lookup should be used.
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Working with Configuration Levels

The configuration level attribute determines who can modify a lookup type and what can be modified. The
configuration levels are:

- System: Only Oracle development teams can modify lookup types at this configuration level.
- Extension: Customers can perform minimal tasks, such as add lookup values.
User: Customers can add lookup values, delete lookup values, update the meaning, and update the description.

Task User Extension System
Add a lookup type Yes No No
Delete a lookup type Yes No No
Modify lookup type meaning Yes No No
Modify lookup type description Yes No No
Add lookup values Yes Yes No
Delete lookup values Yes (if you created it) Yes (if you created it) No
Modify lookup value attributes Yes (except for Lookup Code) Yes (if you created it, and except for No
Lookup Code)

Note: You can add values to lists defined in the designer for user-defined fields. Values entered through the Lookup
Type page become available at runtime as soon as they are saved. Values added to lookup lists through the Intake
Form Designer display at runtime only after the intake form is published.

Adding Lookup Types

To add a lookup type:

1. Select Common Setup > Lookups.
2. Onthe Lookup Types page click Add for the Lookup Type grid.
3. On the Lookup Type Details page, enter these values:
o Lookup Type (The value you enter must be uppercase and can’t begin with the prefix ORA_, which is used
to distinguish your custom lookup types from delivered lookup types.)
o Meaning
o Module
o Description
4. Click Add for the Lookup Value grid for each lookup value you need to add to the lookup type.
5. Click Save.
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Managing Instructional Text

Agency staff can set up and manage instructional or assistive text that can be configured to appear on applications.

For more information about embedding instructional text in each section of the contractor field group of a contractor
registration form or business license application, see Using the Intake Form Designer for Business Licenses.

Here's how to create instructional text:

1. Select Common Setup > Instructional Text.
2. Onthe Instructional Text page, click Add.
3. Onthe Instructional Text details page, enter values for the fields:

Page Element

Text ID

Text Name

Description

Category

Effective Start Date and Effective End
Date

Show All Dates

Content

Description

Enter a unique identifier for the instructional text. The name can'’t include spaces.

Enter a name for the instructional text.

Enter a description for the instructional text.

Select a category used to filter or group the instructional text. This setup is optional. For
example, select Contractor to group instructional text set up for display on contractor sections
used for collecting contractor license information.

You can set up instructional text categories on the Lookup page. For more information, see
Setting Up Lookups.

Enter the range of dates when the instructional text is effective. If you want to leave the
effective dates open-ended, don’t enter a date for the end date.

Note:
You can't update the start date after saving the instructional text details.

Click to access the History Data page where you can update existing effective dated rows, and
add new ones.

Add content using the available formatting options in the text editor.

4. Verify that the Enabled switch is turned on. The option is active by default for new instructional text.

5. Click Save.

ORACLE

47


https://www.oracle.com/pls/topic/lookup?ctx=fa26c&id=u30247131

Oracle Public Sector Permitting and Licensing Chapter 3
Implementing Your Agency Setting Up Your Agency

Setting Up Units of Measure

Units of measure are used to express measurements such as quantity or duration. Each unit of measure must have a
unit type such as Area, Length, Time, or Volume.

You add, modify, and delete units of measure on the Unit of Measure pages.

Adding a Unit of Measure

1. Select the Setup and Maintenance tile on the Agency Springboard to access Functional Setup Manager.
2. From the Setup drop-down list, select your offering.
3. From the Functional Areas list in the left panel, select Agency Profile.
4. The right panel shows the required tasks for the selected functional area. Select All Tasks from the Show drop-
down list and then select Define Units of Measure for Public Sector from the tasks list.
5. On the Unit of Measure page, click the Add (+) button.
6. On the New unit of measure drawer, enter values for the following fields:
Page Element Description
Unit of Measure Enter a unique unit of measure ID. For example, WK for week.
Description Enter a description of the unit of measure. For example, Week.
Unit Type Select the type of measurement. The delivered unit types are Area, Length, Time, and Volume.
You can define additional values on the Lookup Type Details page. Add new values to the ORA_
PSC_CC_UOM_TYPE lookup type.
ISO Code Enter the 2-character ISO unit of measure code.
7. Click Save.

Modifying a Unit of Measure

1. Click a row on the Unit of Measure page.
2. On the Unit of measure details drawer, make the necessary modifications.
3. Click Save.

Deleting a Unit of Measure

1. Click a row on the Unit of Measure page.
2. On the Unit of measure details drawer, click the Delete button.

You will be prompted to confirm the permanent deletion.
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Setting Up Data Format Exchange Maps

The Data Format Exchange utility is a data-mapping utility that enables you to map fields between source and target
locations.

Note: This utility is useful in situations where data must be exported from or imported to Oracle Permitting and
Licensing. Currently, this utility is only used by the Export Journals to ERP process.

Business analysts create and modify Data Format Exchange maps on the Data Format Exchange page.

Adding a Data Format Exchange Map

1. Select Common Setup > Data Format Exchange.
2. On the Data Format Exchange page, click Add.
3. For the Definition step, enter values for the following fields:

Page Element Description

Mapping Name and Description Enter a name and description for the data mapping.

Source Type Select the type of source format to be included in the data mapping.
Note:

Currently, VO is the only valid value for this field.

Target Type Select the type of target format to be included in the data mapping.
Note:

Currently, CSV is the only valid value for this field.

Enabled Turn this switch on to make the data mapping available to select in the Mapping Name field
on the Export Journals to ERP page. For more information on exporting journals, see Exporting
Journal Entries.

4. Click Next.
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5. For the Source step, enter values for the following fields:

Page Element Description

Source Name Selects the source view to be included in the data mapping, such as Journals to Export.
6. Click Next.
7. For the Target step, click Upload to select a file that will be updated with the results of the field mapping.
8. C(lick Next.
9. For the Mapping step, enter values for the following fields:

Page Element Description

Target Field Displays each field in the target format.

Source Field Select the source field that you want to map to each target field.

Transform Select an option to modify the value for the target field.

Note:

Currently, Constant is the only valid value for this field.

Transform Parameter Specify the parameter used to determine the value for the target field. For example, if the target
field is Effective Date and the Transform value is Constant, the Transform Parameter might be
01/01/2018.

10. Click Submit to save the Data Format Exchange map.

Note: At any point during the process, you can click Previous to go back one step. You can also click Cancel
to exit the data mapping setup process and discard your changes.

Modifying a Data Format Exchange Map

Select Common Setup > Data Format Exchange.

Select a mapping on the Data Format Exchange page.

For the Definition step, you can enable or disable the data mapping.

Click Next.

You can’t update any fields in the Source step.

Click Next.

For the Target step, you can click the file link to download a copy of the file.
Click Next.

For the Mapping step, you can update the values of the Source Field, Transform, and Transform Parameter
fields.

VWOJOUAWNRA
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10. Click Submit to save your changes to the Data Format Exchange map.

Note: At any point during the process, you can click Previous to go back one step. You can also click Cancel
to exit the data mapping update process and discard your changes.

Setting Up Agency-Level Email

To ensure the security of agency sender email addresses used in communications and communication templates,
agency system administrators must configure agency-specific sender email IDs and use them for outbound agency
communications.

Use the Email Configuration page to define and manage these sender email addresses.

Here’s how to navigate to the agency-level email configuration:

1. When starting from Home with Ask Oracle, select Setup and Maintenance of Offerings to access the
Functional Setup Manager.

2. Select Setup: Public Sector <Offering> > Functional Area: Agency Profile > Task: Manage Agencies.

3. Onthe Agency page, click the row for your agency.

4. On the Agency Details page, select the Email Configuration tab.

For more information about agency-level settings, see Setting Up Agencies.

Adding a Default Email

If your agency uses the Business Rules Framework to send error notifications, you must configure and enable at least
one Agency Default email on the Email Configuration page, which will be used as the sender email address on error
notification emails. For more information about agency-level setup of Business Rules Framework, see Viewing Business
Rule Logs.

Here's how to add a default agency email:

1. On the Email Configuration page, click the + Add button.
2. Inthe New email configuration drawer, enter values for these fields:

Page Element Description

Email Enter the email address, for example, Agency@CityName.com.

Description Enter a description of the email address.

Enabled Turn on this switch to enable the email address.

Agency Default Turn on this switch to make this email address the default email for the agency.

If you enable this switch, these fields are disabled:

o Address Type
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Page Element

Address Type

Offering

Functional Category

3. Click Save.
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Description

o Offering
o Functional Category

They are used for web form response emails and other use cases. For more information, see the
section,"Setting Up Email Addresses for Web Form Responses," in this topic.

Select the email address type from the available values: Sender, Recipient, or Both.

Select to configure email addresses for web form responses. If it is not specific to web form
responses, then select Common.

This option is applicable for web form response-related email address configuration.

Setting Up Email Addresses for Web Form Responses

Agency staff can configure different email addresses to use in the Reply-To address for web forms.

For example, you could set up a Reply-To email address for each offering so that responses from public users are

directed to a specific department.

For web form response events, in the Communication Template Details page, include the ${Webform Reply-To} attribute
in the To-address. For more information, see Setting Up Communication Templates.

Here's how to set up an email address for web form responses and other use cases:

1. On the Email Configuration page, click the + Add button.
2. Inthe New email configuration drawer, enter values for these fields:

Page Element

Email

Description

Enabled

Agency Default

Address Type

ORACLE

Description

Enter the web form response email address, for example, ReplyToDept@CityName.com.

Enter a description of the web form response email address.

Turn on this switch to enable the email address.

Turn off this switch so that this email address isn't the default email for the agency.

You must turn off this switch to enter information in the next fields.

Select the email address type from the available values: Sender, Recipient, or Both.
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Page Element

Offering

Functional Category

3. Click Save.

Chapter 3
Setting Up Your Agency

Description

Select the offering, such as Permits, Business Licenses, Code Enforcement, or Planning and

Zoning, to configure email addresses for web form responses. If the email isn't specific to web

form responses, then select Common.

Select "Web form" if this email is applicable to web form response-related email address
configuration, otherwise you can indicate that it isn't applicable.

Setting Up Email Addresses for Senders

Agency staff can configure different email addresses to use in the From address for Communication Templates or Ad

hoc communications.

Here's how to set up an email address for the sender and other use cases:

1. On the Email Configuration page, click the + Add button.
2. Inthe New email configuration drawer, enter values for these fields:

Page Element

Email

Description

Enabled

Agency Default

Address Type

Offering

Functional Category

3. Click Save.

ORACLE

Description

Enter the sender email address, for example, Agency@CityName.com

Enter a description of the sender email address.

Turn on this switch to enable the email address.

Turn off this switch so that this email address isn't the default email for the agency.

Select the email address type from the available values: Sender, or Both.

Select the offering, such as Permits, Business Licenses, Code Enforcement, or Planning and
Zoning. If the email isn't specific to web form responses, then select Common.

Select "Not Applicable".
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Setting Up Safe Domains

Safe domains are used to maintain a list of website links and image links which are safe to be added in the rich text
editor. You add, enable, and delete domains on the Safe Domains page.

Agency users and registered public users use the rich text editors while entering comments. These may sometimes
contain text or image links to third-party websites. Safe domains allow agencies to maintain a list of domains which are
safe to be referenced in rich text editors. Only the domains added as safe along with

To set up a new safe domain:

1. From the Fusion Applications Permitting and Licensing homepage, click Agency Springboard > Setup and
Maintenance.

2. On the Functional Setup Manager, select your offering from the Setup drop-down list.

3. From the Functional Areas list in the left panel, select Agency Profile. The right panel shows the required tasks
for the selected functional area.

4. Select All Tasks from the Show drop-down list and then select Manage Safe Domains from the tasks list.

5. On the Safe Domains page, click the Add Safe Domain button.

6. On the New safe domain drawer, enter values for the following fields:

Page Element Description

Domain Name Enter the domain name to be added to the safe domains list.

Once a domain name is added, all subdomains sharing the same ending and extension will also
be included in the safe domains list.

For example, if the newly added domain name is https://www.agency, then the sub
domain names, such as https://www.sub.agency, https://www.agency/home, https://
www.xyzagency.com/home will also be included in the safe domains list.

Enabled Turn the switch on to add the new domain to the safe domains list.
Include image Turn the switch on to include the image resource type for the safe domain.
Include link Turn the switch on to include the link resource type for the safe domain.
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4 Setting Up Agency Schedules

Setting Up Holiday Calendars

Holiday calendars establish the days that agency offices are closed and no field service operations are offered.

These days appear as unavailable, non-working days in calendar views throughout the system such as for public user
and inspector calendars. Non-working days in holiday calendars apply to all employees and do not need to be defined
for employee profiles.

Each holiday calendar spans a date range that you define. Within that date range, you define individual events for each
non-working holiday.

Administrators add, modify, and delete holiday schedules and events on the Holiday Calendar page.

Adding a Holiday Calendar

1. Select Common Setup > Holiday Calendar.
2. On the Holiday Calendar page, click Add.
3. On the Holiday Calendar Details page, enter values for the following fields:

Page Element Description

Calendar ID and Description Enter a unique ID and description for the calendar. For example, you might enter an ID of 2079
and a description of Holiday Calendar 2019.

Valid from Date and Valid to Date Enter the date range for the holiday calendar. For example, you might enter a Valid from Date
of 20719-07-07 and a Valid to Date of 2079-12-37 to represent a calendar that spans the entire
2019 calendar year.

4. Add an event.
I Note: You must have values defined for all required holiday calendar fields before you can add an event.

5. Click Save.
I Note: When you click Save, the Holiday Calendar page closes.

Adding an Event

Select Common Setup > Holiday Calendar.

Click a row on the Holiday Calendar page.

On the Holiday Schedule Details page, click Add.

On the Event Details page, enter an Event ID, an Event Date, and a Description for the event. For example, you
might enter an ID of MD, a date of May 29, 2017, and a description of Memorial Day.

Click Save.

PUWNA
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Modifying a Holiday Calendar

1. Select Common Setup > Holiday Calendar.

2. C(lick a row on the Holiday Calendar page.

3. On the Holiday Calendar Details page you can:
o Update the holiday schedule field values.

Note: You cannot edit the Calendar ID.

o Delete the holiday calendar. You will be prompted to confirm the permanent deletion.
o Add, modify, or delete events.
4. C(lick Save.
I Note: When you click Save, the Holiday Calendar page closes.

Modifying an Event

1. Click a row on the Holiday Calendar Details page.
2. On the Event Details page you can:
o Update the event date or description.

o Delete the event. You will be prompted to confirm the permanent deletion.
3. Click Save.

Deleting Holiday Calendars

Select Common Setup > Holiday Calendar.

Click Edit.

Select the checkboxes next to all the holiday schedules you want to delete.
Click Delete. You will be prompted to confirm the permanent deletion.

PUWN

Deleting Events

1. Click Edit on the Holiday Calendar Details page.
2. Select the checkboxes next to all the events you want to delete.
3. Click Delete. You will be prompted to confirm the permanent deletion.

Setting Up Work Schedules

Work schedules establish the days of the week and daily hours of operation for agency employees.

Create schedules based on the type of employee and work location. Calendar views, such as inspector calendars,

reference work schedules to determine the time slots that are displayed on the calendar as available for scheduling.

Algorithms for assigning resources also use work schedules to determine availability. You assign work schedules to
employee profiles using the Agency Staff page. See Setting Up Agency Staff.

Administrators and business analysts add, modify, and delete work schedules on the Work Schedule page.

ORACLE
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Adding a Work Schedule

Chapter 4
Setting Up Agency Schedules

Select the Setup and Maintenance tile on the Agency Springboard to access Functional Setup Manager.

The right panel shows the required tasks for the selected functional area. Select All Tasks from the Show drop-

Enter a unique ID and description for the schedule. For example, you might enter an ID of
OFFICESAT and a description of Saturday Office Schedule.

Enter the last date of the schedule. You can leave this field blank to give the schedule an open

Enter the start and end time for the schedule. For example, you might enter a work start time of
09:00 AM and a work end time of 05:00 PM.

Enter the start and end time for a break within the schedule. For example, you might enter a
break start time of 72:00 PM and a break end time of 07:00 PM.

These fields are optional, but if you enter a break start time, you must also enter a break end

Select whether the schedule reoccurs weekly and how many weeks are between each
occurrence. For example, if you select a recurrence of Weekly with 7 week between occurrences,

Select the days of the weeks to which the schedule applies.

1.
2. From the Setup drop-down list, select your offering.
3. From the Functional Areas list in the left panel, select Agency Profile.
4.
down list and then select Manage Public Sector Work Schedulesfrom the tasks list.

5. On the Work Schedule page, click + button.
6. On the Work schedule details drawer, enter values for the following fields:

Page Element Description

Schedule ID and Description

Start Date Enter the first day of the schedule.

End Date

end date.
Work Start Time and Work End Time
Break Start Time and Break End Time
Note:
time.
Recurrence and Weeks Between
Occurrences
the schedule repeats every week.

Work Days

7. Click Save.

Note: For overnight work shifts that go past 12 am (midnight), you must create two schedules: one for the time period
up until midnight, and one for the time period after midnight. For example, to create a weekday overnight shift that
starts at 09:00 pm and ends at 06:00 am the following day, the first schedule would have a start time of 09:00 pm
and an end time of 12:00 am on Monday through Friday. The second schedule would have a start time of 12:00 am
and an end time of 06:00 am on Tuesday through Saturday.

ORACLE
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Modifying a Work Schedule
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7.

Select the Setup and Maintenance tile on the Agency Springboard to access Functional Setup Manager.
From the Setup drop-down list, select your offering.
From the Functional Areas list in the left panel, select Agency Profile.

The right panel shows the required tasks for the selected functional area. Select All Tasks from the Show drop-
down list and then select Manage Public Sector Work Schedules from the tasks list.

Click a row on the Work Schedule page.
On the Work schedule details drawer, you can:

o Update the work schedule field values.
Note: You cannot edit the Schedule ID field.

o Delete the schedule. You will be prompted to confirm the permanent deletion.
Click Save.

Deleting Work Schedules

PN
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Select the Setup and Maintenance tile on the Agency Springboard to access Functional Setup Manager.
From the Setup drop-down list, select your offering.
From the Functional Areas in the left panel, select Agency Profile.

The right panel shows the required tasks for the selected functional area. Select All Tasks from the Show drop-
down list and then select Manage Public Sector Work Schedules from the tasks list.

Click a row on the Work Schedule page.
On the Work schedule details drawer, click Delete. You will be prompted to confirm the permanent deletion.
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5 Setting Up Your Agency Staff

Setting Up a Fusion Business Unit and Legal Entity

This topic discusses the one-time setup for Oracle Permitting and Licensing administrators who are not using Fusion
Human Capital Management (HCM), Enterprise Resource Planning (ERP), and Sales Cloud.

If you have implemented both Fusion Financials and Oracle Permitting and Licensing offerings, then you must ensure
that you migrate Financials Business Unit related tasks before any Permitting and Licensing migrations. Migrate

any changes you have made to the business unit configurations in the Financials offering before the Permitting and
Licensing offering or the implementation projects are migrated from a nonproduction environment to your production
environment.

The following setup steps are prerequisites for creating an agency staff in the system.

Note: For Fusion HCM, ERP, and Sales Cloud customers, these steps are not required as the business unit and legal
entity are already set up.

Configure the following tasks in the order mentioned here:

Set up reference data sets (to create a Set ID).
Create a business unit.

Create a legal address.

Create a Legislative Data Group.

Create a Legal Entity.

Register a Legal Entity.

Create Legal Entity HCM Information.

NOURAWNA

Setting up Reference Data Sets

1. Select the Setup and Maintenance tile on the Agency Springboard. On the Setup page, select the offering:
Public Sector Permits, Public Sector Planning and Zoning, Public Sector Code Enforcement, or Public Sector
Business Licenses. Then select the Agency Staff functional area.

2. Onthe right panel locate the Manage Reference Data Sets task and click the row to open the Manage Reference
Data Sets page.

3. Onthe Manage Reference Data Sets page, click the New button and include values for the fields:

Page Element Description

Set Code Enter a code value that represents your agency.
Set Name Enter a name that represents your agency.
Description Enter a description about your agency.
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4. C(lick Save and Close to save the newly created SetID.

Creating a Business Unit

1. Select the Setup and Maintenance tile on the Agency Springboard. On the Setup page, select the offering:
Public Sector Permits, Public Sector Planning and Zoning, Public Sector Code Enforcement, or Public Sector
Business Licenses. Then select the Agency Staff functional area.

2. On the right panel locate the Manage Business Units task and click the row to open the Manage Business Units
page.

3. Onthe Manage Business Unit page, click the New button and include values for the fields:

Page Element Description
Name Enter a name for the business unit.
Default Set Select the SetID you created in the previous section.

4. Click Save and Close to save the newly created business unit.

Creating a Legal Address

1. Select the Setup and Maintenance tile on the Agency Springboard. On the Setup page, select the offering:
Public Sector Permits, Public Sector Planning and Zoning, Public Sector Code Enforcement, or Public Sector
Business Licenses. Then select the Agency Staff functional area.

2. On the right panel, locate the Manage Legal Addresses task and click the row to open the Manage Legal
Addresses page.

3. Onthe Manage Legal Addresses page, click the New button and enter the agency address in the Agency Line 1
field. The other fields are optional.

4. Click OK to return to the Manage Legal Addresses page and click Save and Close to save the newly created
address.

Creating a Legislative Data Group

1. Select the Setup and Maintenance tile on the Agency Springboard. On the Setup page, select the offering:
Public Sector Permits, Public Sector Planning and Zoning, Public Sector Code Enforcement, or Public Sector
Business Licenses. Then select the Agency Staff functional area.

2. On the right panel, select the task named Manage Legislative Data Group and click Select to open the Manage
Legislative Data Groups page.

3. Onthe Manage Legislative Data Groups page, click Create to enter the new legislative data group details.

4. Enter your legislative data group name in the Name field. Search and select your country from the Country

field.
5. Click Submit to save and return to the Manage Legislative Data Group page.
6. Click Done.

Creating a Legal Entity

1. Select the Setup and Maintenance tile on the Agency Springboard. On the Setup page, select the offering:
Public Sector Permits, Public Sector Planning and Zoning, Public Sector Code Enforcement, or Public Sector
Business Licenses. Then select the Agency Staff functional area.

2. On the right panel, locate the task named Manage Legal Entity and click to open the Select Scope page.
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3. Onthe Select Scope page select the Manage Legal Entity task radio button.

4. Click the Legal Entity drop-down and select Create New. Click Apply and Go to Task button to open the
manage Legal Entities page.

5. Onthe Manage Legal Entities page, click the New button to open the Create Legal Entity page and enter values

for the fields:

Page Element Description

Country Select the country (United States is the default selection).

Name Enter the name of your agency.

Legal Entity Identifier Enter a code for your agency.

Payroll Statutory Unit Select the checkbox.

Legal Employer Select the checkbox.

Legal Address Select the legal address (created in the previous section) using the Search and Select page.

EIN or TIN Enter your agency’s EIN or TIN value. You can enter a value of your choice if you do not have

EIN or TIN for your agency.

Note:
If you are using Fusion HCM or Fusion ERP, the value you enter here must be legitimate. It is
recommended that you refer to Fusion documentation to know about the required value for
entry in the field.

Legal Reporting Unit Registration Enter your agency’s legal reporting unit registration number. You can enter a value of your

Number choice if you do not have a registered number for your agency.

Note:

If you are using Fusion HCM or Fusion ERP, the value you enter here must be legitimate. It is
recommended that you refer to Fusion documentation to know about the required value for
entry in the field.

6. Click Save and Close to save the newly created legal entity.
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Registering a Legal Entity

1.

Select the Setup and Maintenance tile on the Agency Springboard. On the Setup page, select the offering:
Public Sector Permits, Public Sector Planning and Zoning, Public Sector Code Enforcement, or Public Sector
Business Licenses. Then select the Agency Staff functional area.

On the right panel, select the task named Manage Legal Entity Registration and click Select to open the Select
Scope page.

On the Select Scope page select the Manage Legal Entity Registrations task radio button.

Click the Legal Entity drop-down and choose Select and Add. Select Click Apply and Go to Task button to open
the Manage Legal Entities page.

On the Manage Legal Entities page expand the Search section and enter the legal entity name you created in
the previous section. Click Search.

Select the row from the search results and click Save and Close, to save the entity and open the Manage
Registrations page.

View your values on the new Manage Registrations page and click Done to confirm and complete the
registration process.

Creating Legal Entity HCM Information

1.

9.
10.

1.

Select the Setup and Maintenance tile on the Agency Springboard. On the Setup page, select the offering:
Public Sector Permits, Public Sector Planning and Zoning, Public Sector Code Enforcement, or Public Sector
Business Licenses. Then select the Agency Staff functional area.

On the right panel, select the task named Manage Legal Entity HCM Information and click Select to open the
Select Scope page.

On the Select Scope page select the Manage Legal Entity HCM Information task radio button.

Click the Legal Entity drop-down and choose Select and Add. Click Apply and Go to Task button to open the
Manage Legal Entities page.

On the Manage Legal Entities page expand the Search section and enter the legislative data group you created
in the previous section. Click Search.

Select the row from the search results and click Save and Close, to save the entity and open the Legal Entity
page.

On the Legal Entity page, click Edit and then click Update to open the Update Legal Entity page to enter an
action reason.

On the Update Legal Entity page, select Action Reason drop-down button and select the option Reorganization.
Click OK to save and return to the Legal Entity page.

On the Legal Entity page, select the Payroll Statutory tab to associate the data group to the HCM legal entity.
Under the Payroll Statutory Information section select the Associated Legislative Data Group drop-down.
Search and select the legislative data group you created using the previous section.

Click OK to return to the Edit Legal Entity page. Click Submit and then click Done to complete the creation of a
Legal Entity HCM Information.

For information on creating an employee record, refer to the documentation Managing Agency Staff Profiles.

Defining Job Titles

This topic discusses how to define job titles for agency staff. You can set up effective dates as well as bill rates for each
job title for use in fee calculations.
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Viewing Job Titles

View the various job titles that your agency has defined for their staff:

PUWUNA
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Select the Setup and Maintenance tile on the Agency Springboard to access Functional Setup Manager.

From the Setup drop-down list, select your offering.

From the Functional Areas list in the left panel, select Agency Profile.

The right panel shows the required tasks for the selected functional area. Select All Tasks from the Show drop-
down list and then select Manage Agency Job Titlesfrom the tasks list.

The Job Title page lists all the job titles defined.

Click a row to open the Job Title Detail drawer and view or edit the details of the job title.

Click Save if you have made any changes or click Cancel to return to the Job Title page.

Enter various details and click Save to save the new job title and return to the Job Title page.

Adding Job Titles

Administrators define new job titles for their staff using the Job Title page:

PUOUNA
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Select the Setup and Maintenance tile on the Agency Springboard to access Functional Setup Manager.

From the Setup drop-down list, select your offering.

From the Functional Areas list in the left panel, select Agency Profile.

The right panel shows the required tasks for the selected functional area. Select All Tasks from the Show drop-
down list and then select Manage Public Sector Work Schedulesfrom the tasks list.

On the Job Title page, click + button.

Enter details for the fields on the New job title details drawer:

Page Element Description

Job Title Enter a name for the job title.

Description Enter a description for the job title.

Valid From Select a start date when the job title is applicable.

Valid To Select a date until which the job title is applicable.

Rate Enter rate amount that the staff member charges for the recorded time.

This value will appear as the default rate on the time recording pages for permits, plan reviews,
inspections, and code enforcement cases.

For more information, see Adding Time Entries and Reporting Inspection Time.

Frequency Displays the frequency of the rate amount entered. The value is Hourly.

Currency Displays the currency of the billing amount entered. The value is USD.
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Page Element

7. Click Save.
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Description

Setting Up Agency Staff

This topic provides an overview of job functions along with a list of delivered job functions. It also discusses how to set
up Fusion business units and legal entities for Oracle Permitting and Licensing services.

Job Function Overview

Job functions are assignments made to staff members using the Agency Staff page. Job functions help you in assigning
job specific attributes to an agency staff member. For example, you can assign the job function of a building inspector
to an agency staff member and associate attributes such as Inspection District and Work Schedule.

For more information about setting up the various job attributes, such as permit, inspection, or issue types, see the
Implementing Permitting and Licensing guide.

Job Function and ID

Building Inspector

ORA_BUILDING_INSPECTOR

Business Analyst
ORA_BUSINESS_ANALYST

(Applicable in future releases)

Business License Inspector

ORA_BL_INSPECTOR

ORACLE

Attribute and Usage

Work Schedule — Inspections: Determine inspector availability for assignment to inspections. A
building inspector can have more than one work schedule.

Inspection Districts — Inspections: Determine the districts for which an inspector can be
assigned to inspections.

You can leave the value of the inspection district job attribute blank to enable a building inspector
to be assigned to inspections from all districts.

Inspection Types — Inspections: Determine if the inspector can be assigned to a given type of
inspection.

You can leave the value of the inspection type job attribute blank to enable a building inspector to
be assigned to all inspection types.

Permit Types — Inspections: Permit types are not used for inspector assignment.

Inspection Districts
Inspection Types

Permit Types

(Applicable in future releases)

Work Schedule — Inspections: Determine inspector availability for assignment to inspections. A
business license inspector can have more than one work schedule.

Inspection Districts — Inspections: Determine the districts for which an inspector can be
assigned to inspections.

You can leave the value of the inspection district job attribute blank to enable a business license
inspector to be assigned to inspections from all districts.
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Job Function and ID

Business License Inspector Supervisor

ORA_BL_INSPECTOR_SUPERVISOR

Business License Manager

ORA_BL_MANAGER

Business License Specialist

ORA_BL_SPECIALIST

Cashier

ORA_CASHIER

Chief Building Officer
ORA_CHIEF_BUILDING_OFFICER

(Applicable in future releases)

Code Enforcement Officer

ORA_CODE_ENFORCEMENT_OFFICER

ORACLE
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Attribute and Usage

Inspection Types — Inspections: Determine if the inspector can be assigned to a given type of
inspection.

You can leave the value of the inspection type job attribute blank to enable a business license
inspector to be assigned to all inspection types.

Work Schedule — Inspections: Work schedules are not used for business license inspector
supervisors.

Inspection Districts — Inspections: Determine the districts for which a supervisor can view or
schedule inspections.

You can leave the value of the inspection district job attribute blank to enable a business license
inspector supervisor to view or schedule inspections for all districts.

Inspection Types — Inspections: Determine the inspection types that can be viewed or
scheduled by this supervisor.

You can leave the value of the inspection type job attribute blank to enable a business license
inspector supervisor to view or schedule inspections for all inspection types.

Note:
No job attributes are currently required for this job function. Business license managers have access
to all consultations and licenses.

Business License Application Types — Determine the license and consultation types that this
specialist can be assigned to.

Consultation Meeting Schedule — Determine the availability of the specialist for scheduling
business consultation meetings.

Note:
You can assign only one schedule.

Permit Types (Applicable in future releases)

Cashier ID — Cashiering: Determine Cashier ID of the Cashier

Note:
You can assign only one schedule.

.

Inspection Districts
Inspection Types

Permit Types

(Applicable in future releases)

.

Code Enforcement Districts The possible values are districts from code enforcement district
types. Only users who are associated with a code enforcement district can be autoassigned to
issues in that district.

65



Oracle Public Sector Permitting and Licensing Chapter 5
Implementing Your Agency Setting Up Your Agency Staff

Job Function and ID Attribute and Usage

- Code Enforcement District Types — Used at the time of scheduling inspections.

Note:

To give a user responsibility for all district types, create a District Type attribute row, but leave
the attribute value blank. If you assign a district type attribute value to a user, it provides him with
access to all districts within that district type.

Warning: If you enable the agency-level option for autoassignment of incidents and cases, but do
not set up any district or district type attributes, the incidents and cases will never be routed to the
user.

- Code Enforcement Inspection Work Schedule

Note:
You can assign only one schedule.

Code Enforcement Supervisor - Issue Type — The possible values are the issue types that you create. A user who is associated
with an issue type is responsible for all related subtypes, so don’t assign users to both an issue

ORA_CODE_ENFORCEMENT_ type and a subtype that belongs to that issue type.

SUPERVISOR

- Issue Subtype — The possible values are the issue subtypes that you create. Only assign a user
to a subtype when the user is not responsible for all of the subtypes that belong to the related
issue type.

These attribute values establish which issue types and subtypes the person is responsible for. This
information is used when routing or assigning incidents and cases.

Note:

To give a user responsibility for all types of issues, create an Issue Type attribute row, but leave the
attribute value blank. If you assign an issue type attribute value to a user, it provides him with access
to all issue subtypes within that issue type.

Warning: If you don'’t set up any issue type or subtype attributes, and you activate the system-level
setting for automatically routing incidents, incidents will never be routed to the user.

Code Enforcement Technician - Issue Type — The possible values are the issue types that you create. A user who is associated
with an issue type is responsible for all related subtypes, so don’t assign users to both an issue
ORA_CODE_ENFORCEMENT_TECHNICIAN type and a subtype that belongs to that issue type.

- Issue Subtype — The possible values are the issue subtypes that you create. Only assign a user
to a subtype when the user is not responsible for all of the subtypes that belong to the related
issue type.

These attribute values establish which issue types and subtypes the person is responsible for. This
information is used when routing or assigning incidents and cases.

Note:

To give a user responsibility for all types of issues, create an Issue Type attribute row, but leave the
attribute value blank. If you assign an issue type attribute value to a user, it provides him with access
to all issue subtypes within that issue type.

Warning: If you don'’t set up any issue type or subtype attributes, and you activate the system-level
setting for automatically routing incidents, incidents will never be routed to the user.
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Job Function and ID Attribute and Usage
Economic Development Officer Permit Types
ORA_ECONOMIC_DEVELOPMENT_ (Applicable in future releases)
OFFICER

(Applicable in future releases)

Finance Administrator - Inspection Districts

ORA_FINANCE_ADMINISTRATOR * Inspection Types

. . - Permit Types
(Applicable in future releases) . .
(Applicable in future releases)

Inspector Supervisor - Work Schedule — Inspections: Work schedules are not used for inspector supervisors.

ORA INSPECTOR SUPERVISOR - Inspection Districts — Inspections: Determine the districts for which a supervisor can view or
- - schedule inspections.

You can leave the value of the inspection district job attribute blank to enable an inspector
supervisor to view or schedule inspections for all districts.

- Inspection Types — Inspections: Determine the inspection types that can be viewed or
scheduled by this inspector supervisor.

You can leave the value of the inspection type job attribute blank to enable an inspector
supervisor to view or schedule inspections for all inspection types.

- Permit Types — Inspections: Permit types are not used for inspector supervisor assignment.

Permit Technician - Inspection Districts

ORA_PERMIT_TECHNICIAN - Inspection Types

. . - Permit Types
(Applicable in future releases) . .
(Applicable in future releases)

Plan Coordinator - Permit Types — Determine the permit types of the plan reviews that this plan coordinator can
assign and update.
ORA_PLAN_COORDINATOR

Note:

You can leave the value of this job attribute blank to enable a plan coordinator to assign and update
plan reviews for all permit types.

- Plan Reviewer Department — Determine the plan reviewer departments of the permit and
planning and zoning plan reviews for which this plan coordinator can assign plan reviewers and
make plan review updates.

Note:
You can leave the value of this job attribute blank to enable a plan coordinator to assign and update
plan reviews for all departments.
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- Planning Application Types — Determine the planning application types including
preapplications for which this plan coordinator can assign plan reviewers and make plan review
updates.

Note:
You can leave the value of this job attribute blank to enable a plan coordinator to assign and update
plan reviews for all planning application types.

The values of the application type and department attributes also determine which plan reviews a plan
coordinator can see when they turn on the My Job switch on the Plan Reviews console pages.

Plan Reviewer - Permit Types — Determine the permit types that this plan reviewer can be assigned to.
ORA_PLAN_REVIEWER Note:
You can leave the value of this job attribute blank to enable a plan reviewer to be assigned to any
permit type.

- Plan Reviewer Department — Determine the plan reviewer department that this plan reviewer
belongs to. The Add Reviewers modal page displays a list of available reviewers by plan reviewer
department when assigning a plan reviewer to a plan review.

Note:
You can leave the value of this job attribute blank to enable a plan reviewer to be assigned to any
department.

- Planning Application Types — Determine the application types that this plan reviewer can be
assigned to.

Note:
You can leave the value of this attribute blank to enable a plan reviewer to be assigned to all
planning application types.

- Plan Review Districts — Determine the plan review districts for which a reviewer is available on
the Add Reviewers modal page when assigning reviewers to a plan review.

Note:
You can leave the value of this attribute blank to make a plan reviewer available for all plan review
districts.

The values of the application type and department attributes also determine which plan reviews a plan
reviewer can see when they turn on the My Job switch on the Plan Reviews console pages.

Planner - Planning Application Types — Determine the application types that this Planner can be
assigned to.

ORA_PLANNER .. . . I .
- Pre-application Meeting Schedule — Determine the availability of the planner for scheduling

preapplication and planning meetings.
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Note:
You can assign only one schedule.

Principal Planner - Permit Types — Determine the permit types of the plan reviews that this principal planner can
view in the Plan Review Console.
ORA_PRINCIPAL_PLANNER

Note:
You can leave the value of this job attribute blank to enable a principal planner to view plan reviews
for all permit types.

Plan Reviewer Department — Determine the plan reviewer departments of the plan reviews that
this principal planner can view in the Plan Review Console.

Planning Application Types — Determine the planning application types of the plan reviews that
this principal planner can view in the Plan Review Console.

Note:
You can leave the value of this job attribute blank to enable a principal planner to view plan reviews
for all planning application types.

Setting Up Fusion HCM Business Units and Legal Entities for Oracle
Permitting and Licensing Services

If you are an existing Fusion customer and if you have already set up business units and legal entity, then you can
assign the same for your Agency Staff. However, if you are a new Oracle Permitting and Licensing-only customer then
as a prerequisite for entering Agency Staff data, you need to create one business unit and one legal entity that can be
used for your agency staff.

See Setting Up a Fusion Business Unit and Legal Entity.

Configuring Agency Job Groups
This topic provides an overview of the Agency Staff Group Configuration and discuss the procedure to configure agency
job groups.

You can use the Agency Staff Groups for identifying a common set of Job attributes that can be applied to a group of
Employees.

Groups provide the flexibility to assign attributes at various levels. You can define a group for a given department,
division, or for specific districts based on the commonalities of the job attributes.

Examples of Groups are:

1. Inspectors working in District A
2. Permit Technicians responsible for Fence Permits
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You can configure a group with default Job Functions and their attribute values for your users.

Users entering their employee profile information can select a group job function, which results in loading default job
functions and their attribute values automatically populated.

Note: Users cannot edit the job function attribute values on the Agency Staff page when using the Job Group
function.

Configuring Agency Job Groups

Administrators set up and configure the agency staff group on the Job Group page. Agency users can select a group on
the Agency Staff Profile page, and a default set of job functions and attribute values are assigned to the employee. To
set up the job functions and attributes for a group:

Select Agency Staff > Job Group.

On the Job Group page, click Add to add a new group or Edit to change the group attributes. Click Add.
Enter the details of the job group on the Job Group Details page.

Verify that the Enabled switch is turned on if you want to enable this group when you save. This switch is
turned on by default for a new group.

Under the Job Function section, click Add to select job functions and include their attributes.

6. Click Save to return to the Job Group page.

PUWUN

ui

Note: Agency users select the group from a list on the Agency Staff page. The job functions and their corresponding
attributes cannot be changed by users.

Managing Agency Staff Profiles

Agency administrators create and manage profiles for their agency staff.

Managing Agency Staff Profile
Administrators set up the agency staff profile on the Agency Staff page.
If you have implemented Fusion Human Capital Management (HCM), you must search and select an existing staff

member using their worker ID. If the HCM implementation is disabled, you have the option of creating a new entry for
the staff member by entering the details, or by selecting the staff record from existing workers.

To create an agency staff profile:

1. Select Agency Staff.

2. Onthe Agency Staff page, click Add to add a new agency staff member — employee.

3. Onthe Agency Staff Profile page, you add values to the various fields. For the Business Unit and the Legal
Entity, see the documentation Setting Up a Fusion Business Unit and Legal Entity .

Page Element Description

Select Existing Worker Turn on the switch to allow the search and selection of an existing Fusion employee. The
following fields are display only, populating details from Fusion information:
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o PersonID

o Person Number

o Hire Date

o Business Unit

o Legal Entity

o Generated User Account
o Send Credential Email

o User Name

If you want to create a new staff profile, enter information in the fields provided.

Note:
If your agency has HCM implementation, this switch is turned on by default and is
unavailable for edit. You must select an existing staff member using the Worker ID field.

For the selected staff member, you can’t make changes to the name, person number, person
type, user name, email, hire date, and manager fields.

Worker ID Enter an ID or click the prompt to open the Look Up page and search for the Fusion employees.
You can sort the search results by any of these:

o Worker ID

o First Name

o LastName

o Email

o Hire Date

o Work Phone Number
o Business Unit Name
o Legal Entity

o Manager

o Person Number

o User Name

Select an employee row from the search result on the Look Up page and the details are
populated on the Agency Staff page.

Person Type Shows the type of person, such as Employee.

Enabled Set a status for the staff member from the options:

7
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Page Element Description
o Active
o Inactive
Note:

a Fusion HCM/ERP/Sales Cloud customer then the inactivation of Employees in HCM will
not automatically inactivate the Employee data in Public Sector Cloud. You must manually
update this field.

security console to inactivate the User ID. If Oracle Identity Cloud Service (IDCS) is your
identity provider (IdP), you must inactivate the user ID using your IDCS console.

Is a Supervisor Turn on the switch if the employee is a supervisor.

Job Group Select a group to assign a job group section with the relevant job functions. Accordingly, the
system populates the Job Group Assignments section.

Note:
You cannot make any changes to the values in the job group assignments on this page. To
update the values, navigate to the Job Group page.

Link User Account Select the switch to link the employee detail to the existing user account.

Link User name Search and select the name of the existing user to link to the new employee.

4. Click Save to save the agency staff profile and return to the Agency Staff page.

When the agency staff profile is saved, automatic role assignments are created based on the Manage Role
Provisioning Rules settings in the Functional Setup Manager (FSM). Subsequently, this Fusion employee information
must be processed to synchronize with the Oracle Identity Cloud Service (IDCS) system.

As an administrator, you must manually schedule and initiate a process to synchronize your agency staff profiles into
the IDCS system using the Synchronize Agency Staff Roles process.

Scheduling the Synchronize Agency Staff Roles Process

1. Access the Scheduled Processes page from the Fusion application Navigator > Tools > Scheduled Processes.

ORACLE

You set the status to Inactive when the employee is inactivated in your HR system. If you are

Also, turning off the switch on this page will not inactivate the user ID. You need to use your
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2. On the Scheduled Process Overview page, click the Schedule New Process button and enter values for the
fields on the Schedule New Process modal page:

Page Element Description

Type Select the Job option.

Name Select the Synchronize Agency Staff Roles option from the drop-down menu.
3. Click OK.

4. On the Process Details page, view options and click Submit. You'll see a confirmation message that the process
was submitted.

5. Once the process is successfully completed, the Overview page displays the process details with the status
Succeeded.

6. You can download the log file to view details of the updated role records.

Tip: To ensure that your employee records in IDCS are updated with the latest of automatically assigned roles, it is
recommended that you run this process whenever you create new employee records.

For more details on running processes, See the Oracle Applications Cloud documentation Submit Scheduled Processes
and Proess Sets.

Job Function Assignment without using Agency Job Groups

You can assign job functions to employees directly, without having to use Job Groups.

1. Onthe Agency Staff page search and select the employee that you want to add job functions to.
2. Under the Job Function section, click Add to select job functions and include their attributes.
3. Click Save and return to the Agency Staff page to view the job function assignments.

To include job functions using Agency Job Groups, see the documentation Configuring Agency Job Groups.

Assigning Agency Security Access

Administrators assign roles to various staff members. The security roles assigned to an employee determine the
navigations and data that the user can access.

1. Select Agency Staff and then select Agency Staff Access. The Agency Staff Access page lists all the agency staff
members.

2. You can click the chevron for a row to view the employee access details. This page lists all the security roles

assigned to the employee user. You can add new security roles to the employee on this page.

Click the Add New Role button to open the Role Detail page and assign a role for the user.

Click Save to save your changes and return to the Agency Staff Access page.

Click Save to save the changes you made to the Agency Role details of the staff member.

You can add or delete the security roles assigned to the user on this page.

ocuvhAw

Note: All Agency users must be assigned the PSC Agency Staff role. Additionally job specific roles can be assigned
to the user. For the complete list of security roles, you can refer to the Security Reference Manual. Also refer to Using
the Security Console.
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Note: For users requiring access to Permits, in addition to the PSC Agency Staff and job specific roles such
as PSC Permit Technician, PSC Plan Reviewer and others, you must assign the following roles to the users:
CUSTOM_MANAGE_PERMITS, CUSTOM_MANAGE_PERMITS, and CUSTOM_PSC_MANAGE_PERMITS_AGENCY.

Importing Agency Staff Data

This topic explains how to prepare and import agency staff resource data from an external data source into Public
Sector Agency Staff tables using the File-Based Data Import feature.

Agencies with Fusion HCM implementation: File-based data import can be used if your agency has implemented Fusion
HCM. You either enter employee details manually into the Public Sector Agency Staff tables using the Public Sector user
interface (Agency Staff page) or run the schedule import process to copy the employee data.

Agencies without Fusion HCM implementation: If your agency has not implemented Fusion HCM and you are using a
third-party application to maintain employee information, you can use the import process to copy data from the third
party tables into the Public Sector Agency Staff tables.

In addition to the removal or inclusion of employee records, data changes can include changes to the details of an
employee, such as the address, email, role, or designation.

Scheduling the Employee Data Import and Export Process

Administrators can set up a schedule to process a batch file that imports employee data from a .CSV file into the Public
Sector Agency Staff tables. The imported data file, which is usually generated from a third-party application, can be
used to set up and periodically update user details within Public Sector Agency Staff.

Using the Predefined Template to Import Data using File-Based Data
Import

Oracle Permitting and Licensing provides a template to help you import data using the File-Based Data Import tool.
The Import template is a spreadsheet that includes the commonly used fields, in addition to the required, along with
instructions to use them.

To download the Agency Staff Import Template, see this posting in My Oracle Support (Doc ID 3036254.1).

Importing Employee Data

1. Access the File Import and Export page from the Fusion application by clicking Navigator > File > Import and
Export.

2. Onthe File Import and Export page, in the Search Results section, click the Add button to upload the template
zip file to the Universal Content Management (UCM).

3. On the Upload File modal page, click Browse and select the file for upload. Use the Account field to select the
account for the file you are uploading.

4. Click Save and Close. You will see the file listing on the File Import and Export page with the details of the
upload.

Scheduling the Import Export process using File-Based Data Import

1. Access the Scheduled Processes page from the Fusion application Navigator > Tools > Scheduled Processes.
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2. On the Scheduled Process page, click the Schedule New Process button and enter values for the fields on the
Schedule New Process modal page:

Page Element Description

Type Ensure that the Job option is selected.

Name Search and select the Load Interface File for Import value from the list of names.
Description Displays a description about the selected process.

3. Click OK. The service now opens the Process Details page for you to select the import process for the process
name you entered in the above step:

Page Element Description

Import Process Click the drop-down menu, search and select the Import Agency Staff value using the lookup
list.

Data File Click the drop-down menu and select the generated ZIP file you uploaded earlier, as described

in the previous section.

4. Click Submit and accept the confirmation message to complete the submission.

Note: The submission only confirms that the files are sent for processing. To view the details of the completed

process, you must access the log file. The log file lists all the successfully processed records and the records that are in
error, with the details of the error.

Records in Error

Note: When you fix the errors in the spreadsheet and prepare to resubmit it for processing, you must delete the
records that were processed successfully in the previous run. All the records preceding the ones in error are created
in the Public Sector Agency Staff tables. Resubmitting the template having those records results in creating duplicate
entries of the staff records.

Scenarios for importing employee data from a third-party system to Public
Sector Agency Staff profile

Prerequisite

The scenarios listed here assume that the following prerequisite has already been set up: Each record in the template
should contain a unique identifier called the Interface ID. The interface ID is used as a key identifier while establishing
parent-child relationships across the pages of the template spreadsheet.
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Consider importing the employee details into the tables of Public Sector Agency Staff. You can perform the following
actions using the Import template:

- Add a new staff member

- Assign personal attributes

- Assign job functions and attributes

-« Assign roles

- Disable an agency profile

The following scenarios detail how you can create a new agency staff record and seamlessly update various parameters
of your existing agency staff.

Note: The InsertUpdateFlag field on the Import template is the determining factor as to whether the record is for a
new agency staff or for updating an existing agency staff. Enter the value “I” if you are inserting a new record, or “U”
if you are updating an existing record. Also note that the Person Number field is mandatory if you are updating a
record.

Scenario 1: Adding a new agency staff
Consider creating a new agency staff record staff in your Public Sector Agency Staff.

If your agency is not a Fusion HCM customer, you use the template to enter details in all the pages of the template
spreadsheet and then schedule the import process to import the newly added employee record. You must enter the
value “I” in the InsertUpdateFlag field to qualify the record as a new agency staff entry.

The following example shows the data on the spreadsheet detailed in the above scenario — Adding a new staff member.

Record Number *Interface ID *InsertUpdateFl: *First Name *Last Name *Email *Business Unit  *Legal Entity

1 467436 John Simmons john.s@example. Sample Sample
Corporation Corporation

2 467437 Robert James robert.j@exampli Sample Sample
Corporation Corporation

Note: The above example displays a limited number of fields. For a complete list of fields, refer to the Import template
spreadsheet.

If your agency has implemented Fusion HCM, you use the HCM loader or enter the necessary employee details
manually. In such cases, the following Public Sector specific attributes are required to be updated:

- Job Title

- Agency Department
- Agency ID

- Agency Location

- Job Group
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 |Is Supervisor
- Enabled

Scenario 2: Updating personal details of an agency staff

Consider updating changes to the personal details of an agency staff in your Public Sector Agency Staff. You can
perform the following actions:

- Change work phone number
- Change location

- Change department

- Change job title

- Assign job group

- Revoke job group

- Change supervisor status

The following example shows the data on the spreadsheet detailed in the above scenario.

Record Number *Interface ID *Person *Work Phone *Location *Department *Job Title *Is Supervisor
Number Number
1 467436 PERNUMS 16348773 3001001688796 1001 Agency Staff Y
2 467437 PERNUM®9 32178939 30010016887961 1001 Building N
Inspector

Note: The above example displays a limited number of fields. For a complete list of fields, refer to the Import template
spreadsheet.

Scenario 3: Updating job functions and their attributes

Consider updating changes to job functions and their attributes of an agency staff in your Public Sector Agency Staff.
You can perform the following actions:

- Assign job functions and attributes

- Assign additional job attributes to existing functions
- Remove job attributes

- Remove job functions

The following example shows the data on the spreadsheet detailed in the above scenario.
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Record Number *Interface ID *Assignment
Flag

1 467436

2 467437 D

Scenario 4: Updating roles

*Person
Number

PERNUMS8

PERNUM9

Agency ID

Job Function ID

ORA_
BUILDING_
INSPECTOR

ORA_CASHIER

Chapter 5
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Job Attribute Attribute Value

ORA_ Plumbing
INSPECTION_
TYPES

ORA_CASHIER_ 7574343
ID

Consider updating roles of an agency staff in your Public Sector Agency Staff. You can perform the following actions:

- Assign additional roles

- Revoke roles

The following example shows the data on the spreadsheet detailed in the above scenario.

Record Number *Interface ID
1 467436
2 467437

Scenario 5: Disabling agency staff profile

*Role Action

A

*Person Number

PERNUMS8

PERNUM9

*Role Name

Employee

Application Implementation
Consultant

Consider disabling an agency staff profile in your Public Sector Agency Staff. You can perform the update without
having to make any manual entry in your records. The user interface as well as the Import Agency Staff functionality

allow you to disable agency staff profiles.

The following example shows the Enabled field on the spreadsheet, as detailed in the above scenario.

Record Number *Interface ID *Person

Number
1 467436 PERNUMS8
2 467437 PERNUM9

ORACLE

*Work Phone
Number

16348773

32178939

*Location

3001001688796

30010016887961

*Department

1001

1001

*Job Title Enabled
Building Y
Inspector

Agency Staff N
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Note: The above example displays a limited number of fields. For a complete list of fields, refer to the Import template
spreadsheet.
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6 Setting Up Public Users

Setting Up Public Users

Public user setup includes configuration options related to public user registration and account management. Agencies
can also configure required address fields for applicants by country.

Here's how an agency sets up public users:

Select the Setup and Maintenance tile on the Agency Springboard to access Functional Setup Manager.
From the Setup drop-down list, select your offering.
From the Functional Areas list in the left panel, select Agency Profile.

The right panel shows the required tasks for the selected functional area. Select All Tasks from the Show drop-
down list.

Select Manage Public User Setup from the tasks list.
In the Terms of Use section of the Public User Setup page, configure these options:

P UWNA

o un

Page Element Description

Require the user to accept the terms ~ Use this switch if public users must accept your terms of use as part of the registration process.
of use before registering

Terms of Use ID If you require public users to accept your terms of use during registration, select the terms of
use definition for the registration process.

This field is visible only if the Require the user to accept the terms of use before registering
switch is enabled.

Note:

If you change the Terms of Use ID, account holders who have already registered are required
to accept the new terms the next time they sign in. In this scenario, a window with the

new terms opens as soon as the public user signs in. The user must select the agreement
checkbox to continue.

7. Inthe Attachments section of the page, configure these options:

Page Element Description

Allow agency staff and registered Turn on Use this switch to enable attachments in user accounts. When you enable attachments,
users to manage documents in both users and agency staff can add attachments to user accounts and modify information
account management about existing attachments.

81
ORACLE



Oracle Public Sector Permitting and Licensing
Implementing Your Agency

Page Element

Allow registered users to delete
documents in account management

Document Group ID

Chapter 6
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Description

Agency staff can also delete attachments, but public users can’t delete attachments unless you
also enable the “Allow registered users to delete documents in account management” switch on
this page.

Turn on this switch to allow public users to delete attachments that are associated with their
account. This setting does not affect agency staff, who can always delete account attachments.

This switch is visible only if you enable attachments by turning on the “Allow agency staff and
registered users to manage documents in account management” switch.

If you want to enable document categories and subcategories for public user account and
profile attachments, select the document group with the appropriate categories. A document
group consists of a set of related categories.

If you leave this field blank, the public user attachment pages won't have fields for identifying
attachment categories and subcategories.

This field is visible only if you enable attachments by turning on the “Allow agency staff and
registered users to manage documents in account management” switch.

8. In the Privacy Consideration section of the page, you can select only one option. The agency either hides
name and contact information for all registered users from public view or gives the registered user the option

of hiding their information.

Page Element

Hide contact information of all
registrants from public view

Provide option for registrants to hide
their contact information from public
view

ORACLE

Description

Turn on this switch to hide the name and contact information of all applicants and contacts
registered in the system from public view on applications. Only the applicant, their contacts
with application access, and agency staff can view the contact information on an application.

When you select this option, registered users won't see the option to hide their name and
contact information on the registration page or in account management.

Turn on this switch to give public users the option on the Register page to hide their name and
contact information when a member of the public views the user's applications.

This switch is turned on by default.
If this switch is turned on, the initial registration page gives users the opportunity to hide their
information. The public can still view the property address even if the user’s information is

hidden.

After a user registers, either the user or agency staff can update this preference using Account
Management functionality.
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9. Inthe IVR Access Code section of the page, configure this option.

This section is only available when IVR is enabled for permits or business license.

Page Element

Enable IVR Access Code (Enable
Interactive Voice Response Access
Code)

Description

Turn on this switch to:

o Display the IVR Access Code field during account registration on the Register page.

o Require applicants to provide their 4-digit PIN when accessing inspection records using
IVR.

o Enable registered public users to maintain their 4-digit PIN in account management.

When you turn off this switch, the IVR Access Code is hidden on the Register and Manage
Account pages.

When you turn off this switch, the IVR Access Code field is hidden on the Register page and
applicants can use the IVR system without a PIN.

For more information, see The Public User Registration Process and Managing Public User
Accounts.

Oracle recommends requiring an IVR access code for applicants calling into an IVR system. For more
information about configuring IVR for agencies, see Setting Up Agency-Level Options for Permits and Setting
Up a Proxy Role and User for Interactive Voice Response.

10. Inthe User Category section of the page, configure this option:

Page Element

Description

Enter a user category for appropriate Enter the user category to be assigned to registered public users. Typically you should use the

notification content and URL
redirection parameters for system
access

11. Click Save.

delivered category DEFAULT.

The user category that you specify will be associated with user accounts that are created by the
public user registration process.

The category controls the templates for account-related notifications such as emails for first-
time registration and for resetting the account password. The category also controls URL
redirection so that when users set or reset their password in the Oracle Applications Cloud, they
are immediately transferred to the permitting and licensing system.

For more information about user categories, see Managing Users in Oracle Permitting and
Licensing and Setting the Next URL for the Default User Category.

Setting Up Address Style Format By Country

For agencies in the United States, the validation on the applicant's address requires the first address line, city, state,
postal code, and United States for the country regardless of whether the address fields are required in this setup. The
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validation of address style format by country occurs in the permit application intake form displayed using the Redwood
Experience and on the Manage Account page. For more information, see Address Styles. See also Completing an
Application and Managing Public User Accounts.

1. Select the Setup and Maintenance tile on the Agency Springboard to access Functional Setup Manager.

2. From the Setup drop-down list, select Permits.

3. From the Functional Areas list in the left panel, select Agency Profile.

4. The right panel shows the required tasks for the selected functional area. Select All Tasks from the Show drop-
down list.

5. Select Manage Address Formats from the tasks list.

6. Search for the country's postal address format.

7. Inthe Format Variation Layout section of the Postal Address Format page, mark which address elements to

require.
8. C(lick Save and Close.

Setting Up Public User Roles

To ensure that registered public users have appropriate system access, you must define which role is assigned to the
user IDs that are created during the registration process.

When a public user registers, the Oracle system assigns a single role to the new user. Because the user is assigned just
one role, access to different areas of the system is established through a role hierarchy. In this hierarchy, the various
roles that provide access to different areas of the system are all children of a single parent role that you create.

During implementation, you created all custom roles required for system access, including those for the public user. Use
the Public User Roles page to identify the role to be assigned during user registration.

Identifying the Single Role to Be Assigned During Public User Registration

To identify the single role to be assigned during public user registration:

Select the Setup and Maintenance tile on the Agency Springboard to access Functional Setup Manager.
From the Setup drop-down list, select your offering.
From the Functional Areas list in the left panel, select Public Users.
The right panel shows the required tasks for the selected functional area. Select All Tasks from the Show drop-
down list and then select Manage Public Sector User Roles from the tasks list.
5. If the Public User Roles page already lists a role, delete it before you add the new role.
The button for adding a role is hidden if a row already exists. You can't modify the existing row, so you must
instead delete it and then add a new one.
To delete the existing row:
a. Click the row to access the Role details drawer.
b. Click the Delete button.
On the Public User Roles page, click the Add button.
7. On the New role drawer, use the Role ID field to select the single role to be assigned during the public user
registration process: PSC Custom Registered Public User (CUSTOM_PSC_REGISTERED_PUBLIC_USER).
The Role ID is the only enterable field on the drawer. To select a role based on the descriptive role name rather
than the numerical role ID, start typing in the Role ID field to search by role name.
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Note: If you can't find the PSC Custom Registered Public User role, you may not have created all of the
necessary custom roles. For more information on setting up custom roles, see Creating Custom Roles for
Oracle Permitting and Licensing.

8. C(lick Save.

Overview of Application Access for Contacts

All application contacts must have a contact type that describes the role of the person relative to the specific
application, such as business manager, contractor, or organization. Different contact types have different levels of
application access, as set up by your agency, but applicants, the primary contact, and business owners on business
license applications always have the highest level of access and can manage other contacts.

When an applicant submits an application, they are automatically assigned the Applicant contact type, which is
delivered with full application access that can't be modified.

You can change the applicant to another active registered contact on the application and assign a different level of
access to the Previous Applicant. The new applicant receives full application access. For more information, see Changing
the Applicant on an Application.

Business owners on business license applications are automatically assigned the Business Owner contact type that
gives them access to business license applications as contacts. This contact type is only valid for business license
applications.

When you add a contact to an application, you select a contact type. The application access level defined by the agency
is used unless you select a higher level of access. For a given business license, permit, or planning application, if a
contact’s type allows access or the contact has been granted access, and the contact email matches the account email
for a registered user, then the contact can access the application after the application is submitted.

The contact types and levels of access that a contact can have are different for business licenses and permit and
planning applications:

- Business license application contacts can have three levels of access: None, Full, or View, pay, and print to
view the application, pay fees, and print the business license certificate. In addition to the business license
application, business license contacts can view the business license and business entity information.

- Contacts for permit and planning applications can have two levels of access: None or Full.

Contacts with application access can see both their own applications and the applications they're a contact for. To
access the application, the contact can search for it using the search field in the global banner or click the Applications
tile on the landing page once they're logged in.

Note: Before contacts can manage attachments, comments, and contacts, your agency must add the PSC
Contact User duty role (ORA_PSC_CONTACT_USER_DUTY) to the PSC Custom Registered Public User role
(CUSTOM_PSC_REGISTERED_PUBLIC_USER) and enable application access for the contact type.
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Application Access Details

Contacts with full application access can do the following. For more information about the primary contact's application
access, see the next section.

- View complete applicant information, including information that is hidden from the general public.

- View permit and planning application plan review data and comments.

- Add and update contractors, including activating or inactivating a contractor on a permit or planning
application.

- View comments, including workflow comments.
- View contacts and attachments.

- Manage contacts.

Contacts with full access can manage contacts except for the applicant, primary contact, or business owners.
- Add and update comments, and attachments until the application is closed.
- Delete comments and attachments that the contact added.
- View inspections, inspection comments, and inspection checklists.
- Schedule inspections.
- View fee information.

- Print the permit, and print payment receipts.

Business license contacts with Full or View, pay, and print access can print the business license certificate.

- Make payments related to a permit or planning application.

Business license contacts with Full or View, pay, and print access can make payments related to the business
license.

- View communications that are visible to the applicant. However, only applicants can access web forms and web
form attachments.

Contacts can also add or delete links to related transactions on the applications they manage, but you must grant
registered public user access for managing links to related transactions in the agency setup. For more information, see
Setting Up Agencies.

Note: The setup for owner access or contact access control is not universal across all functions. For example, if the
agency sets the ability to link or relate transactions to agency only, the applicant, business owner, or contact with
application access will still not be able to do so.

Primary Contact

The applicant is the primary contact unless the applicant selects a different primary contact on the application form or
after the application is submitted. A contact with any contact type can be a primary contact. Primary contacts always
have the same access to an application as the applicant, including the ability to manage other contacts. Applicants and
primary contacts can upgrade another contact's access or make a different contact the primary contact.

Business owners with full access as well as applicants and primary contacts can manage other contacts, including
changing the primary contact and upgrading a contact's level of access to an application.
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Setting Up Contact Types

A contact type describes the role or position of a contact person for an application. The contact type that you assign to
a contact determines whether the contact has access to the application. You set up contact types on the Contact Type

page.
Contact types are used only for application contacts, not for profile contacts.

Delivered contact types include Applicant, Previous Applicant, and Business Owner, which is only used for business
licenses.

For information about application access for contact types, see Overview of Application Access for Contacts.

Adding a Contact Type

Select the Setup and Maintenance tile on the Agency Springboard to access the Functional Setup Manager.
From the Setup drop-down list, select your offering.

From the Functional Areas list in the left panel, select Agency Profile.

The right panel shows the required tasks for the selected functional area. Select All Tasks from the Show drop-
down list and then select Manage Contact Types from the tasks list.

On the Contact Type page, click Add to add a new contact type.

On the New contact type drawer, enter values for the contact type fields.

PUWUN
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Page Element Description

Contact Type Code Enter the contact type code.

Contact Type Enter the type of contact, such as Business Owner, Individual, or Emergency Contact.

Description Enter a description of the contact type.

In the Application access section, you can set up the level of access the contacts can have for various
application types:

Page Element Description

Permit Access Select whether contacts with this contact type are granted full or no access to the permit
application.

Planning Access Select whether contacts with this contact type are granted full or no access to the planning
application.

Business and License Access Select the level of application access you want to grant to the contacts with this contact type:
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Page Element Description
o Full
o None

o View, pay, and print: The contact user can only view the business license application, pay
fees, and print the license certificate.

Note:
Business license contacts with access will also get view access to business entity and all
business license activities, including Origination, Amendment, and Renewal.

To access an application, the contact must be a registered user, and the contact email must
match the account email.

7. Verify that the Enabled switch is turned on.
The switch is on by default for a new contact type.
8. C(lick Save.

Modifying a Contact Type

1. Navigate to the Contact Type page and select the row of the contact that you want to modify.
2. Onthe Contact type details drawer, you can:
o Edit the Contact Type.

o Edit the Description.
o Edit the Application Access.

I Note: You can't change the Applicant or Previous Applicant type.

3. Click Save.

Deleting Contact Types

You can delete a contact type only if it is not applied to a contact associated with an application. Note that you can't
delete the delivered contact types, including Applicant, Previous Applicant, and Business Owner or Corporate Officer.

1. Navigate to the Contact Type page and select the checkbox for the contact type that you want to delete. If you
want to delete multiple contact types, select the checkboxes for the contact type rows to delete.

2. Click the Delete button.

Note: You can also use the Delete button available on the Contact type details drawer for each contact type
category.

Setting Up Terms of Use

The Terms of Use page stores rules and guidelines to which user must agree as a condition of using a service. The terms
act as a legal contract. They are also known as Terms and Conditions or Terms of Service. When you set up a terms of
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use definition, you also specify the contexts where the definition is available. For example, you can specify that certain
terms can be used for public user registration but not for permit, planning and zoning, or business license applications.

You add, modify, and delete terms of use definitions on the Terms of Use page. After setting up terms of use for a
specific offering, you associate the terms of use ID with the application type.

Adding Terms of Use

1. Select Common Setup > Terms of Use.
2. On the Terms of Use page, click Add.
3. On the Terms of Use Details page, enter values for the following fields.

Page Element

Terms of Use ID

Effective Start Date

Effective End Date

Show All Dates

Description

Usage

ORACLE

Description

Enter an identifier for the terms of use definition.

If a definition changes over time, create multiple definitions with the same ID and new effective
dates. The effective dates of the different versions must not have gaps or overlap.

Enter the first day that the definition is valid.

Enter the date, if any, when the definition will no longer be valid. To keep the definition valid
indefinitely, do not enter a date. If no date is specified, the field displays the text Open end date.

After a definition is saved, the end date becomes read-only. Although you can’t make manual
changes, the system can still update the end date to accommodate new effective-dated entries.
For example, if the currently effective definition has an open end date, and you create a new
definition with a later start date, the original definition’s end date changes to the day before the
new definition goes into effect.

Click this button to access the effective-dated history of the definition. This button is not
available during the creation of a new definition.

On the page that displays this history, use the Add button to add a new effective-dated entry
for the definition. The new entry inherits the same Terms of Use ID. You provide the new
effective start date and other details for the definition.

The system provides logic to prevent gaps or overlaps in the effective-dated history.

Enter a description of the terms of use. This is not part of the Terms of Use text that public
users see.

Select the Business License checkbox to make this terms of use definition available for
business license applications. This option makes the definition available to the Terms of Use ID
field on the Business License Type page. Note that it is also necessary to add the Terms of Use
element to the business license application form.
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Page Element Description

Select the Permits checkbox to make this terms of use definition available for permits
applications. This option makes the definition available to the Terms of Use ID field on the
Permit Type page. Note that it is also necessary to add the Terms of Use element to the permit
form.

Select the Planning and Zoning checkbox to make this terms of use definition available for
planning applications. This option makes the definition available to the Terms of Use ID field
on the Planning Application Type page. Note that it is also necessary to add the Terms of Use
element to the planning application form.

Select the Registration check box to make this terms of use available for registration
functionality. This option makes the definition available to the Terms of Use ID field on the
Public User Setup page. See Setting Up Public Users.

You must select at least one check box.

Content Enter and format the detailed content of the terms to which a user must agree. This is the text
that users see when they are asked to agree to the terms.

4. Click Save.

Modifying Terms of Use

Select Common Setup > Terms of Use.

Click a row on the Terms of Use page.

On the Terms of Use Details page, you can update the description, usage, and content.
Click Save.

PUOUNA

Managing Effective-Dated Terms of Use Definitions

Select Common Setup > Terms of Use.

Click a row on the Terms of Use page to open the Terms of Use Details page.

Click the Show All Dates button to view the effective-dated history of the definition you opened.
Expand the Common Data section to see the Terms of Use ID.

PUOUNA
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5. Expand the History section to see a list of all effective-dated versions of this terms of use definition.

This example illustrates the Terms of Use Details page that displays the effective-dated history of a terms of
use definition.

Terms of Use Details X

» Common Data

4 History Data
+ ©

Correction Mode (_
Effective Start Date Effective End Date Description Delete
111723 Open end date Terms of Use City of Innovation as of 2023 0] >

171722 12/31/22 Terms of Use City of Innovation updated Jan 2022 T >

Page 1 of1 (1-2of2items) m

6. Click in the Search date range to open a calendar and search for an effective-dated row.

7. System administrators can turn on the Correction Mode switch to change start and end dates or delete a
historical row. When the switch is turned off, you can only delete the current effective-dated row and dates are
display only.

8. C(lick the Add button in the History section to create a new version of the definition or click an effective-dated
row to open the Terms of Use Details page for the specific dates.

In the new definition, you can enter any of the data except for the Terms of Use ID.

Deleting Terms of Use

1. Select Common Setup > Terms of Use.
2. Click a row on the Terms of Use page.
3. Onthe Terms of Use Details page, click Delete.

You are prompted to confirm the permanent deletion.
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7 Setting Up Property Information

Security Details for Setting Up Property Information

This topic describes important security roles, requirements, or considerations specific to setting up property

information.

Primary Role

PSC Property Setup Inquiry

PSC Property Setup Administration

PSC Property Setup Conditions Management

PSC Property Setup Attachments Management

ORACLE

Access Description

View property setup.

Administer property setup.

Manage property setup conditions.

Add, update, and delete property setup
attachments.

Associated Job Roles and Abstract Roles

PSC Agency Staff - All agency users
PSC Geographical Information System
Administrator

PSC System Administrator

PSC Business Analyst

PSC Geographical Information System
Administrator

PSC System Administrator

PSC Business Analyst

PSC Zoning Administrator

PSC Planning Assistant

PSC Associate Planner

PSC Economic Development Officer
PSC Business Analyst

PSC Building Inspector

PSC Principal Planner

PSC Plan Reviewer

PSC Permits Supervisor

PSC Permit Technician

PSC Geographical Information System
Administrator

PSC System Administrator

PSC Business Analyst
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Primary Role Access Description Associated Job Roles and Abstract Roles
PSC Add Property Setup Attachments Add property setup attachments. PSC Geographical Information System

Administrator

PSC System Administrator

PSC Business Analyst
PSC Update Property Setup Attachments Update property setup attachments added by PSC Geographical Information System
Added by Self themselves. Administrator

PSC System Administrator

PSC Business Analyst
PSC Delete Property Setup Attachments Added = Delete property setup attachments added by PSC Geographical Information System
by Self themselves. Administrator

PSC System Administrator

PSC Business Analyst
PSC Delete Property Setup Attachments Added Delete property setup attachments added by PSC Geographical Information System
by Others and Self others and themselves. Administrator

PSC System Administrator

PSC Business Analyst

For more information on creating roles for Oracle Permitting and Licensing, see Creating Custom Roles for Oracle
Permitting and Licensing.

For more information on all the predefined security data such as abstract roles, job roles, privileges and so on, see the
Security Reference for Oracle Permitting and Licensing.

Importing Property Information Using Functional Setup
Manager

You can import property information as CSV file packages using Oracle Functional Setup Manager.

When you enter or update a large volume of property data, using the setup task Ul to manage them individually may
not be the most efficient method. To create or update property data in bulk, use Oracle Functional Setup Manager to
import the data in the form of CSV file packages.

Oracle Permitting and Licensing enables you to import data for the following property-related tasks.

Task Key Attributes Manual Setup Instructions

Manage Parcels ParcelldEntered Setting Up Parcels
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Task Key Attributes Manual Setup Instructions
Manage Parcel Owners OwnerName Setting Up Property Owners
Address1
PostalCode

OwnerCode (represents the ParcelldEntered
which is typically the Assessor’s Parcel Number)

Manage Parcel Addresses Address1 Setting Up Property Addresses
Address2

AddressCode (represents the ParcelldEntered,
which is typically the Assessor’s Parcel Number)

PostalCode

Manage Parcel Values ParcelldEntered Setting Up Parcel Values

EffectiveStartDate

EffectiveEndDate

Manage Districts ParcelldEntered Setting Up Districts
Districtld

Manage Parcel Districts Districtld Assigning Districts to Parcels

Assigning Districts to Addresses

The import process uses key attributes to determine whether a row of data is new or updated. For example, when
importing parcel address data, the process checks the combination of the Address1, Address2, PostalCode and
AddressCode attributes for each row. If the combination of these attribute values in a row already exists in the
PSC_COM_PARCEL_ADDRESS table, the system updates the values for that row in the table. If the combination of these
attribute values does not exist in the table, the import process inserts a new row in the table.

To import an address with a parcel through FSM, there must be a ParcelNumber value in the AddressCode attribute of
the address import file. To import a parcel owner through FSM, there must be a ParcelNumber value in the OwnerCode
attribute of the address import file.

To import an address with no parcel through FSM, you must enter a value of O in the Parcelld and ParcelNumber
attributes of the address import file.

CAUTION: While preparing the import file for Parcel Address and Parcel Owner, you must populate the Address Code
and Owner Code columns with the values from the ParcelldEntered column.
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Tip: If you want to make any manual modifications to a downloaded CSV file before importing it, it is recommended
that you use a CSV editor. Opening the CSV file using spreadsheet software such as Microsoft Excel can change the
formatting of the fields, which could lead to errors during the import process.

See the Oracle Applications Cloud documentation: Export and Import CSV File Packages in Using Functional Setup
Manager.

Setting Up District Types

You add, modify, and delete district types on the District Type page.

Adding a District Type

Select the Setup and Maintenance tile on the Agency Springboard to access Functional Setup Manager.
From the Setup drop-down list, select your offering.
From the Functional Areas list in the left panel, select Agency Profile.

The right panel shows the required tasks for the selected functional area. Select All Tasks from the Show drop-
down list and then select Manage District Types from the tasks list.

On the District Type page, click + Add.
On the New district type drawer, enter values for the following fields:

PUWUNA
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Page Element Description

District Type Enter a unique identifier for the district type.

Description Enter a description of the district type.

District Type Category Select a category for the district type from the system-defined values:

o Code Enforcement

o Council

o Economic Development
o Zoning

o Inspection

o Plan review: District types with this value can be used to filter plan reviewers for
assignment to plan reviews. See Managing Plan Reviewers and Using the Plan Review
Console.

o General

Allow Updates by Parcel Import Turn on this switch to allow Parcel Districts and Address Districts to be automatically removed
by the Post Parcel Import Processing.
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Page Element Description

Note: Parcel Districts and Address Districts which have parcels with inspection in the
Pending, Scheduled or Requested statuses will not be removed.

7. If the district type category is Code Enforcement, or Inspection, configure these settings:

Page Element Description

GIS Layer Enabled Indicates whether to use GIS to identify the district of an incident, case, or inspection based on
the issue location.

The issue subtype for an incident or case is associated with a specific district type. If you enable
the GIS layer for the district type, the system can look up the issue location on the map to
determine the district that the incident, or case, or inspection falls in .
For Inspections, you can find the respective parcel district if your agency is using GIS.

District Layer Service URL Enter the URL of the GIS map service that contains district information for the specified district

type.

This field becomes visible when the GIS Layer Enabled switch is active.

District in GIS Select the map service attribute that provides a district identifier.

This field becomes visible when the GIS Layer Enabled switch is active.

Allow Updates by Parcel Import Turn on this switch to use the import.

For more information, see Setting Up GIS to Property Import Mapping.

8. Turn the Enabled switch on to make the row available as a lookup value on other pages.
9. Click Save.

Modifying a District Type

1. Navigate to the District Type page and select the row for the district that you want to modify.
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2. On the District type details drawer, you can:
o Edit the Description.

o Edit the District Type Category.
Note: You cannot edit the District Type field.

o Enable or disable the district type using the Enabled switch. Only enabled district types are available to
select as values on other pages.
o Delete the district type. You will be prompted to confirm the permanent deletion.

Note: You cannot delete a district type that is already associated with a district or an inspection type.

3. Click Save.

Setting Up Districts

You add, modify, and delete districts on the District page.

Adding a District

1. Select the Setup and Maintenance tile on the Agency Springboard to access Functional Setup Manager.
2. From the Setup drop-down list, select your offering.
3. From the Functional Areas list in the left panel, select Agency Profile.
4. The right panel shows the required tasks for the selected functional area. Select All Tasks from the Show drop-
down list and then select Manage Districts from the tasks list.
5. On the District page, click + Add.
6. On the New district drawer, enter values for the following fields:
Page Element Description
District Enter a unique identifier for the district.
Description Enter a description of the district.
District Type Select a district type from the agency-defined values.
If you have associated a District Type to a GIS layer, choose District in GIS.
See Setting Up District Types.
7. Click Save.

Modifying a District

1. Navigate to the District page and select the district that you want to modify.
2. On the District details drawer, you can:
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o Edit the district description.
o Edit the district type.
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Note: You cannot edit the District field.

o Delete the district. You will be prompted to confirm the permanent deletion.

3. Click Save.

Setting Up Parcels

A parcel of real estate is a tract or plot of land.

A parcel that is held by an owner is a property. A parcel location can be found on a map and is associated with a physical
address. An owner or a contracted business can apply for a permit to develop or modify a structure on a parcel, or
create a planning application for planning and zoning requests.

You add, modify, and delete parcels on the Parcel page.

Adding a Parcel

1. Select Parcel on the Agency Springboard.

2. Onthe Parcel page, click Add.

3. Inthe Basic Information section of the New parcel drawer, enter information in the following fields:

Page Element

(Hold)

(Lock)

@

(Notice)

Parcel Number

Parcel Type

Status

ORACLE

Description

Indicates that a condition has been placed on the parcel. If multiple conditions are applied,
then the icon displays the most severe condition. Click the icon to see a list of all applicable
conditions, including the condition name, severity, description, and when the condition was
applied. Click a condition row to open the Parcel Conditions page in a new window.

Enter the assessor’s parcel number (APN) for the parcel.
The APN is a number assigned to parcels of real property by the tax assessor of a particular
jurisdiction for identification and record-keeping purposes. The APN is unique within the

jurisdiction, and may conform to certain formatting standards that convey basic identifying
information such as the property type or the location on a map.

Enter a parcel type such as Condo or Single Family Home.

Select the current status of the parcel. Values are:
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4.

Page Element

Enabled

Property Description

o Zoning Code

o Zoning Code 2

o Zoning Description
o General Plan

o General Plan 2

o Tax Rate Area

o Parcel Size 1

o Parcel Size 2

o Boundary Description
o Jurisdiction

o Census Tract

o Census Block

o Subdivision

o Climate Zone

o Flood Zone

o Flood Insurance Rate Map

o Liquefaction Risk
o Fire Risk

o Landslide Risk

o Soil Type

ORACLE

Description

o Active
o Retired

o Provisional
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Turn the Enabled switch on to make the parcel available as a lookup value on other pages.

Enter a description of the parcel.

In the Land Use section of the New parcel drawer, enter details about the land associated with the parcel using
the following fields:
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5. Inthe Building section of the New parcel drawer, enter details about the building associated with the parcel
using the following fields:
o Year Built
o Structure Size 1
o Structure Size 2
o Number of Dwelling Units
o Bedrooms
o Bathrooms
o Pool
o Patio
o Additional Structure
6. Inthe Location and Map Information section of the New parcel drawer, enter mapping and location details for
the parcel using the following fields:
o Map Name
o Book Number
o Map Book Page
o Block Number
o Lot Number
o Section Number
o Latitude
o Longitude
o X Coordinate
o Y Coordinate
7. Click Save.

Modifying a Parcel

1. Select Parcel on the Agency Springboard.
2. Select a parcel on the Parcel page.

Note: The search interface for this page uses the typical filter by functionality, or the enhanced search if
Search Cloud Service is enabled. For more information on Search Cloud Service, see Setting Up Oracle Search
Cloud Service.

3. On the Parcel Details page click Edit to:

o Update the parcel field values.
o Change the status of the parcel.

o Enable or disable the parcel using the Enabled switch. Only enabled parcels are available as lookup values
on other pages.

4. C(lick Save.
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Deleting Parcels

Select Parcel on the Agency Springboard.

On the Parcel page, click Select Multiple.

Select the checkboxes next to the parcels that you want to delete.
Click Delete. You will be prompted to confirm the permanent deletion.

PUWN

Note: Agency staff and applicants cannot delete parcels. Only system administrators can delete parcels. Additionally,
only parcels that have not yet been associated with a permit can be deleted.

Migrating APO Data

Agencies can migrate address, parcel, and owner (APO) data to Oracle Permitting and Licensing using Import
Management, and an end-to-end process with OCI — Data Integration for data transformation.

APO Import Process

Most agencies receive the APO-related data from different sources like the geospatial applications, county, city, tax
departments, and so on. This source data needs to be curated to specific formats as prescribed by the Oracle Permitting
and Licensing APO Import Process before it can be loaded into the Oracle Permitting and Licensing application. The
conversion of the raw APO data into this specific format involves a series of transformation and mapping activities
which may get complex depending upon the nature of the source data.

If you already have your APO data in the specific format, then you can use the Import Management tool to import the
data onto the Oracle Permitting and Licensing application.

Reference architecture for APO import process

External to Public Sector Licensing and Permitting Public Sector Licensing and Permitting
Geo spatial Data\
Upload to UCM
: R
County Data /Transformed Data

Others

)

APO Import Process  Public Sector Licensing and Permitting Appiication

If you don’t have your APO data in the prescribed format, you can use an end-to-end data import porcess using the
Oracle Integration Cloud - Data Integration (OCI - Data Integration). See the section in this topic called "End-to-End APO
Import Using OCI — Data Integration, OIC and Import Management."

With OCI - Data Integration you can easily transform your raw APO data. This transformed data can now be imported
using the Import Management tool onto the Oracle Permitting and Licensing application.
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Reference architecture for Oracle Permitting and Licensing end-to-end APO import process

External to
Public Sector Licensing and Permitting

RN

Oracle Cloud Infrastructure Public Sector Licensing and Permitting

Geo spatial Data

—)

County Data

S

Object Storage Transformed Data APO Import Process Public Sector Licensing and Permiting
i

pppppppp

Object Storage
Transformation & Mapping

Others

Trigger UCM File Copy """ "

Trigger File Copy
Trigger Data Flow Task
Trigger APO Import Process
Trigger APO P ostImpo
rocess

I Oracle Integration Cloud

Note: You must have the appropriate subscriptions/licenses for Oracle Cloud Infrastructure (OCI) services like Oracle
Data Integration Cloud, Oracle Object Storage Cloud, and Oracle Integration Cloud (OIC) services to complete this
process.

APO Import Process Using the Import Management

Use Import Management from the Tools work area, to import all your external APO data from CSV files. The Import
Management job performs the APO data import after validation of the data with a pre-defined set of rules and Import
Options configurations. You can create or update the APO records through import. The import options and other details
differ by the type of data that you are importing.

Here are some notes:

- Before importing, understand how the data in your file maps to the attributes in Oracle Permitting and
Licensing APO objects and what values are expected in the import file.

- The data records in the CSV source file may not be processed in the listed order.

In Import Management, each of the six types of APO data are in separate source files. If the existing data file
combines either two or more objects data (for e.g. parcel, address and owner data), then you must separate
these into different files before starting the import process. You can either perform a manual transformation/
translations or use any suitable tool to prepare a separate source file for each object in an object's template
format. Or you can use the end-to-end APO import process detailed in this document to help you with data
transformation.

- You can schedule an APO Import Process using the Oracle Permitting and Licensing application, if you already
have your APO data in the prescribed format (that is, transformed data ready for import) and the appropriate
subscription/license for Oracle Integration Cloud (OIC). For more details, see the section on Scheduling an APO
Import Process Using the Import Property Information Process.

Manage APO Import Objects

Import APO Objects correlate with the APO master tables in Oracle Applications. Understand APO import objects and
their attributes to manage the data that you want to import.
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Import APO Object Details

Click Tools > Import Management > Import Objects.
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To see the details of APO import objects, select a specific APO object on the Import Object Details page. The table
shows the details about each importable object on the Import Object Details page.

Display Name

Parcel

Parcel Address

Parcel Owner

Parcel Value

Parcel District

Address District

Display Name

Parcel

Parcel Address

ORACLE

Language Independent Code

PublicSectorParcel

PublicSectorParcelAddress

PublicSectorParcelOwner

PublicSectorParcelValue

PublicSectorParcelDistrict

PublicSectorAddressDistrict

Required

- ParcelldEntered
- EnabledFlag

- ParcelStatus

- ParcelldEntered
- EnabledFlag

- InputSource

- Country

- Postal Code

User Key

ParcelldEntered

ParcelldEntered

ParcelldEntered

ParcelldEntered

ParcelldEntered

Districtld

Validation

- ParcelStatus should be in ('ORA_FIN',
'ORA_RET','ORA_PROV')

- ParcelSizeOneUnit/ParcelSizeTwoUnit/
StructureSizeOneUnit/
StructureSizeTwoUnit value should be
from configured UOM in the system.

- EnabledFlag (Y/N) (Value will be updated
as 'N'if no value in the file)

- Cannot modify the status of reconciled
parcels.

« ParcelldEntered (should be valid if not
null)

- Mark the row for update as error if it
returns more than one row in the Parcel
Address table for that key combination
(setup in the parcel import option).

- PrimaryFlag (Y/N) (Value will be updated
as 'N'if no value in the file)

- Country should be two character code
setup in the system. Eg. US

- EnabledFlag (Y/N) (Value will be updated
as 'N'if no value in the file)
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Display Name

Parcel Owner

Parcel Value

Parcel District

ORACLE

Required

ParcelldEntered
EnabledFlag
Country
Address1

Postal Code

ParcelldEntered
EffectiveStartDate
EffectiveEndDate

ParcelldEntered
Districtld

Chapter 7
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Validation

- InputSource (U/S) (Value will be updated
as 'U'if no value in the file)

- Address1 (Will be derived based on
concatenation of individual street
columns: Street Number, Street Direction,
Street Name, Street Type, Street Suffix and
Unit Number. Ensure that you do not leave
these fields blank in the input file. Street
Name will always be entered by the user.)

- Mark the row for update as error, if it
returns more than one row in the Parcel
Owner table for that key combination
(setup in the parcel import option).

- ParcelldEntered should be valid that exists
in the system.

- EnabledFlag (Y/N) (Value will be updated
as 'N'if no value in the file)

- PrimaryFlag (Y/N) (Value will be updated
as 'N'if no value in the file)

- Country should be two character code
setup in the system. Example: US

- ParcelldEntered should be valid that exists
in the system.

- EffectiveEndDate should be greater than
EffectiveStartDate.

Note:

If EffectiveStartDate is not in the input
import file, then the import job will flag that
row as error.

- ParcelSizeOneUnit/ParcelSizeTwoUnit
value should be from configured UOM in
the system.

- Currency Code should be from configured
Currency in the system.

Note:

If the system has the same combination

of EffectiveStartDate, EffectiveEndDate

and ParcelldEntered values in the import
file, then update is performed. If the
EffectiveStartDate is different, then that row
will be constituted as a new row and the
import job will perform the insert.

- ParcelldEntered should be valid that exists
in the system.
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Display Name Required Validation
Districtld should be valid that exists in the
system.
Address District - Address Combination as configured in the - Address combination should be valid and
import options for functional key. not mapped to a parcel.
Districtld - Districtld should be valid that exists in the
system.
Note:

The input import file for Address District will
have all address columns in it for the user

to populate. The Address District import job
checks for matching combination of address
field values in the system. If present, the
address district row is created. If not, the row
is marked as error and address row is not
created.

If you enter values for surrogate keys like Parcelld, Addressld and Ownerld in the input file, these will not be considered.
Rather the program generates the surrogate key value for new records.

For creating Address without parcel, you should leave the Parcel number blank in the input import file.

Bulk Insert/Update has been implemented with the APO high volume import jobs. So you would need to complete the
insert first before trying to update the records. For example, within the same input file you cannot have two rows for the
same parcel, first one for insert and the second one for update. As that new parcel is not yet created in the system, the
second row will always be considered as insert and not update.

Import Data Using Templates

Templates make it easy for you to use the auto mapping feature. For auto mapping to work, the column headers in the
source file must match the names of the columns (attributes) of the objects imported. The column headers shown in
the first row of the downloadable templates are the same as the column names of the corresponding objects. Therefore,
building source files from the templates allows the auto mapping process.

For example, if your source file has a column "ParcelldEntered" then it's mapped to the Parcel ID Entered column.
However, if your source file's column header is APN, then automapping fails and you should map manually.

Download Import Object Templates

1. Click Tools > Import Management > Import Objects.

2. On the Manage Import Objects page, click the Download icon for the object, such as Parcel, for which you want
to download the template.

Populate Import Templates

Extract the contents of the ZIP file to a folder. The extracted folder contains the template text files for each of the parent
and child objects. The read me text file within the folder contains instructions on how to use the template files to create
source file for importing data.
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Here are the steps to import data using the downloaded template:

1.

2.

3.

Open the CSV template file for the object you want to import.

The file for each object contains two rows. The first row contains all the column names in a format that's
compatible with the automatic mapping functionality. The second row contains the display names as shown on
the import mapping user interface.

Before populating the CSV template file with the data to be imported, delete the display name values in the
second row, and populate the columns with the data to import.

Use the updated file as the source when you're creating an import activity on the import user interface.

The automatic mapping functionality maps all the columns automatically. You can see both the mapped column names
and the corresponding column names in your language on the Map Fields page.

Manage APO Import Mappings

An import mapping lets you quickly map your source object attributes to the object attributes in Oracle Permitting and
Licensing. You must be an administrator or setup user to create import mappings.

You can create an import mapping in two ways:

1.
2.

Create an import mapping manually.
Generate import maps from the sample source file.

Create Import Mapping Manually

PUN

w

Click Tools > Import Management > Import Objects.

Click the Parcel link under the Display Name column to create a mapping for the Parcel object.

On the Manage Mapping page, click the Create Import Mapping button.

On the Edit Import Mapping page, enter the name of the mapping, and provide a description for the mapping.
The Target Attributes section displays the attributes of the Parcel object that should map to the source file
columns.

Check the Required column to see if the attribute is required or is a user key.

In the Source File section, click the Add Column button to insert a column to the mapping file.

Click the Save and Close button to save the mapping.

To edit or download the mapping file, click the mapping number link for your mapping on the Manage Mapping
page.
On the Edit Import Mapping page, click Download Map from the Actions menu.

Generate Import Maps from Source File

PUN

Click Tools > Import Management > Import Objects.

Click the Parcel link under the Display Name column to create a mapping for the Parcel object.

On the Manage Mapping page, click the Create Import Mapping button.

On the Edit Import Mapping page, enter name of the mapping, select the object such as Parcel, and provide a
description for the mapping.

The Target Attributes section displays the attributes of the Parcel object that should map to the source file
columns. Also, check the Required column to see if the attribute is required or is a user key.

From the Actions menu under Source File section, click Select Source File.
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6. Inthe Source File dialog box, choose the CSV file that should be the source for your mapping file. This creates
the mapping file based on the column header and example values in the source file.

7. Click the Save and Close button.

Import Data

To import data:

1. Click Tools > Import Management.
2. Onthe Manage Imports page, click the Create Import Activity button.
3. Onthe Enter Import Options page, provide values for each field as shown in the following table:

Page Element Description
Name Name of the import.
Object Object that you are importing.

Oracle Permitting and Licensing APO objects:

Parcel
Parcel Address
Parcel Owner
Parcel Value
Parcel District
f. Address District
If you can't find your object, then search for it by clicking the Search link. In the Search and
Select dialog box, enter the object name in the Object text box and click the Search button.
Select your object from the result list and click OK.

P an gy

You can also use the Advanced Search option by clicking the Advanced button. Here, you can
search based on various filter criteria such as object name, attachment supported, creation
date, and so on.

If the object you're importing isn't listed, then verify if you have the roles and privileges
required to import the object.

File Name Browse and select a text file in CSV format. The first row of the source file is treated as the
header row. Provide a file name within 40 characters.

4. Optionally, to set additional import configurations, click the Advanced Options section.

Here you can configure settings under Source File, Import Options, or Create Schedule sections.
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5. Inthe Source File and Import Options regions, some of the options in the following table might not be available
depending on the object that you are importing:

Page Elements

Import Mode

Enable High-Volume Import

Notification email

Delimiter

Decimal Separator

ORACLE

Description

The mode of import, that is, whether it should be an update or create, is determined by the data
in the import file.

o Update and create — A new record is created if a matching record is not found.

o Create — All records in the file are new records which have to be created. If there are any
existing matching records, then they are marked as errors.

The high-volume import mode is designed to import millions of records at once. All the APO
objects are delivered for high volume import. By default, this mode is enabled for the six
objects.

The email of the individual who receives import processing notifications. The user submitting
the import receives an email notification automatically. To have more than one email recipient,
separate the email addresses with a semicolon.

If your file doesn't use a comma to separate values, then select the correct delimiter in the
Delimiter drop-down list. Possible values are:

o Caret Symbol

o Closing Curly Bracket

o Closing Parenthesis

o Closing Square Bracket
o Colon

o Comma

o Exclamatory Mark

o Minus

o Opening Curly Bracket
o Opening Parenthesis

o Opening Square Bracket
o Pipe Symbol

o Plus

o Question Mark

o Semi-Colon

o Star Symbol

o Tilde Symbol

The decimal separator used in your import file.
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Page Elements Description
Date Format The format of the date fields in your file.
Time Stamp Format The format of the time fields in your file.
File Encoding The format in which your source file is encoded.
6. Inthe Create Schedule region, schedule the import to run immediately or at a future date. If you select a future

10.

n.

APO

date, then provide the date and time to start the import. This is a one-off schedule and cannot be used for
recurring scheduling.

Click Next.

The Map Fields page shows the first row of the data from your source file. By default, the application tries

to automatically map each of the source file columns to the appropriate target object attribute. The target

attribute cannot be dragged to attribute display name in the import activity.

Note: The data in the unmapped columns are not imported.

You select a predefined mapping from the list of available mappings under the Import Mapping drop-down list.
If you are reusing an import mapping, then both the source and target columns are already populated.

Leave the Attribute Display Name field blank for any column that you don't want to import.

In the case of hierarchical import, you can see the mapping information for child objects in the subsequent
tabs. Note that data validation isn't done for these objects.

Click Next.

On the Review and Submit page, review the import activity configuration. If you had not run the pre-validation
on the Map Fields page, then you get a notification message to run the validation process. You can view any
unmapped columns of parent or child objects on this page.

Validation errors, if any, are displayed on the Mapping Validation screen. If you get warnings about unmapped
columns, then you can ignore these columns, and proceed to submit the import job.

Click Submit to queue the import.

Import Options

1. Select the Setup and Maintenance tile on the Agency Springboard to access the Functional Setup Manager.
2. From the Setup drop-down list, select your offering.
3. From the Functional Areas list in the left panel, select Agency Profile.
4. The right panel shows the required tasks for the selected functional area. Select All Tasks from the Show drop-
down list and then select Manage Parcel Import Options from the tasks list.
5. Click a row on the Parcel Import Options page to configure the following for the APO high-volume import jobs.
Page Elements Description
Import files Toggles are provided for all 8 jobs.

The import process can be initiated for a particular object through orchestration or Import
Management Ul, only if the toggle is ON.
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Page Elements

Parcel options

Address options

Owner options

Select fields to identify new addresses

District options

Parcel condition options

Address condition options

Processing options

ORACLE
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Description

The user can preselect import mapping for all objects. The Default import mapping is the automatic
mapping based on the input file template.

The Retire Parcels Not Found in Import File setting can be used to retire those parcels not included in
the input parcel file. This option should only be used when the parcel input file contains a complete set
of active parcels, including parcels with no changes.

The Disable Addresses Not Found in Import File setting can be used to disable those parcel
addresses not included in the input parcel address file. This option should only be used when the
address input file contains a complete set of addresses for each parcel, including addresses with no
changes.

The Select Fields to Identify New Addresses setting can be used to decide the functional key that will
determine Insert vs Update. If the combination of selected address field values in the address import
file also exists in the database for the same parcel, the existing address will be updated. If not, a new
address will be created. An existing address will be updated only if all the field values match.

The Disable Owners Not Found in Import File setting can be used to disable those parcel owners not
included in the input parcel address file. This option should only be used when the owner input file
contains a complete set of owners for each parcel, including owners with no changes.

The Select Fields to Identify New Owners can be used to decide the functional key that will
determine Insert versus Update. If the combination of selected owner field values in the owner import
file also exists in the database for the same parcel, the existing owner will be updated. If not, a new
owner will be created. An existing owner will be updated only if all the field values match.

The user can select fields to identify new addresses. Toggles are provided to Unit, Address Line 2, Floor,
City, State, and Postal Code fields.

The Delete District Assignments Not Found in Import File setting can be used to delete those Parcel
Districts or Address Districts not included in the input Parcel District or Address District file. This option
should be used only when the district import file contains a complete set of districts for each parcel or
address without parcel.

The Resolve Parcel Conditions Options Not Found in Import File setting can be used to resolve the
parcel conditions in your database that are not in the parcel condition import file. This option should
only be used when the parcel condition import file contains a complete set of active parcel conditions.
The import process resolves only those parcel conditions which has the Allow Updates by Parcel
Import option turned on in the Condition Details page.

For more information, see Setting Up Conditions.

The Resolve Address Conditions Options Not Found in Import File setting can be used to resolve
those address conditions in your database that are not in the address condition import file. This option
should only be used when the address condition import file contains a complete set of active address
conditions. The import process resolves only those address conditions which has the Allow Updates
by Parcel Import option turned on in the Condition Details page.

For more information, see Setting Up Conditions.

Use the Preview Mode switch to check how many rows will be successfully processed by the import
process. When the import process is run on the preview mode, actual upsert will not be performed on
the base tables.
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Page Elements Description

Additional post processes can be added in the Optional Processes.

APO Import Error Review

The Import Wizard captures the following errors:

Errors that occur during data load into interface table. Common errors like data type mismatch and data length
mismatch errors are trapped here.

Errors that occur due to validation business logic coded in the pl sql. The data loaded in the interface table from
the input file are validated for all errors.

Rows that fail the validation are flagged with appropriate error codes in the interface table. Import wizard will create a
rejected csv file with the errored rows for the user to correct. The errors would be sorted by the record number from the
input file.

For example, Parcel District input file has three rows, out of which errors are reported on two rows.

End-to-End APO Import Using OCI — Data Integration, OIC and Import
Management

In the end-to-end APO import process, the OCI — Data Integration helps you transform your raw APO data as received
from different sources and then import the transformed data onto the Oracle Permitting and Licensing application
using Import Management.

Listed here are the various products and services from Oracle that will help you to seamlessly perform this end-to-end
APO import process:

Oracle Integration Cloud is used to perform orchestration across various components in the import process.

OCI - Data Integration is used to perform transformation and mapping of raw data into formatted data that can
be loaded into Oracle Permitting and Licensing APO Import Process.

Object Storage is used to store copy of external data files for processing and to store formatted data after
transformation and mapping.

- APO Import Process is the Import Management job which is designed to perform Oracle Permitting and
Licensing APO data import after validation of the data with pre-defined set of rules and Import Options
configurations.

Note: You must procure appropriate subscriptions/licenses to OCl services like Oracle Data Integration Cloud, Oracle
Object Storage Cloud and Oracle Integration Cloud services to complete this process.

For detailed steps on how to perform an end-to-end APO import process, refer Migrating APO Data to Oracle Permitting
and Licensing.
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Scheduling an APO Import
You can schedule a recurring import process for address, parcel, and owner (APQO) data and provide default options for

ad hoc executions of the APO Import process.

You can set a schedule for an APO Import Process after an Oracle Integration Cloud (OIC) orchestration has run to
completion. You can schedule this process in the Oracle Permitting and Licensing application even if you have not used
the Oracle Cloud Infrastructure - Data Integration (OCI-Data Integration) for your data transformation.

Note: If you have not used the OCI-Data Integration for data transformation, ensure that the CSV files are available
and ready in the Oracle Permitting and Licensing application before the import starts.

To schedule an APO import process:

1. Navigate to Property Information > Import Parcel Information.
2. Onthe Import Property Information page, use the Schedule option to schedule a run.

Field Description

Schedule Displays the schedule option as set in the Schedule tab below. The available options are As
soon as possible and Using a schedule.

Notify Me When This Process Ends Enable the switch to receive notification when the process is completed.

Parameters Agency ID Enter your agency ID.

Schedule Select the schedule for the run. The available options are As soon as possible and Using a
schedule.

Notification Use the + (add) button to add recipients and conditions for receiving the notification.

Setting Up Property Addresses

An address is the physical address associated with a property.
Oracle Permitting and Licensing enables you to define property addresses by:

1. Adding addresses to existing parcels. You can add multiple addresses to one parcel.

2. Defining addresses that are independent of an existing parcel. After defining these addresses, you can
associate them with one or more parcels.
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Adding an Address to an Existing Parcel

You add addresses to parcels on the Parcel Address page.

1. Select Parcel on the Agency Springboard.
Select a parcel on the Parcel page.

Click Parcel Address in the navigation bar.
2. Onthe Parcel Address page, click Add.
3. Inthe New address drawer, you can:

o Turn the Enabled switch on to make the row available as a lookup value on other pages.

o Turn the Primary switch on to indicate that this is the primary address associated with the parcel. A
parcel may have only one primary address.

4. Inthe Address Information section of the Parcel Address Details page, enter the following information:

Page Element Description

Hold - Hold Indicates that a condition has been placed on the parcel. If multiple conditions are applied,
then the icon displays the most severe condition. Click the icon to see a list of all applicable

Lock - conditions, including the condition name, severity, description, and when the condition was

applied. Click a condition row to open the Parcel Conditions page in a new window.

[~

Notice -

Address Fields The property address. The Country field displays US.
As you enter a Postal Code, the type-ahead list shows values that include appropriate city and
state combinations. After you select a value, the city and state appear as read-only fields, and
two address fields appear so that you can enter the rest of the address.
If you don’t know the postal code, click the Don’t know link to display a full set of address
fields.

Address Line 1 and Address Line 2 Enter the street number or post office box number, along with any additional address
information such as apartment or suite number.

City and State Enter the city and state for the address.

Postal Code Enter the postal code for the address. The available values for this field are filtered based on the

city and state that you select.
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5. Inthe Building and Location Information section of the Parcel Address Details page, enter the building and
location details for the parcel address using the following fields:
o Building Type
o Floor
o Unit Number
o Street Number
o Street Name
o Street Direction
o Street Type
o Longitude
o Latitude
o X Coordinate
o Y Coordinate
o Street Suffix
o Crossroad 1
o Crossroad 2
o Landmark

6. In the Contact Information section of the Parcel Address Details page, enter the contact information details for
the parcel address using the following fields:
o Name 1and Name 2

o Email Address
o Home Phone Number
o Work Phone Number
o Cell Phone Number
o Fax Number

7. Click Save.

Adding an Address

You define addresses that are independent of existing parcels on the Address page.

1. Select Property Address on the Agency Springboard.
2. On the Address page, click Add.
3. Inthe New address drawer, turn the Enabled switch on to make the row available as a lookup value on other
pages.
4. Inthe Building and location information section of the New address drawer, enter the following information:
5. Inthe Building and Location Information section of the New address drawer, enter the building and location
details for the parcel address using the following fields:
o Building Type
o Floor
o Unit Number
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o

o

Street Number
Street Name
Street Direction
Street Type
Longitude
Latitude

X Coordinate
Y Coordinate
Street Suffix
Crossroad 1
Crossroad 2

Landmark

6. Inthe Contact Information section of the New address drawer, enter the contact information details for the
parcel address using the following fields:

o

o

o

o

o

o

Name 1and Name 2
Email Address

Home Phone Number
Work Phone Number
Cell Phone Number
Fax Number

7. Click Save.

Modifying a Property Address

1. You modify parcel addresses on the Address Details page. You can access this page two ways.

o

Select Property Address on the Agency Springboard.

Select the address you want to modify and click Edit.
Select Parcel on the Agency Springboard.

Select a parcel on the Parcel page.
Click Parcel Address in the navigation bar.

Select an address associated with the parcel.

2. C(lick Edit. On the Address Details page you can:

o

o

o

Update the address field values.

Enable or disable the address using the Enabled switch. Only enabled parcel addresses are available as
lookup values on other pages.

Indicate whether this is the primary address associated with a parcel using the Primary switch.

3. Click Save.
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Associating Parcels with an Address

1. You associate parcels with addresses on the Parcel page. You can access this page two ways.
o Select Property Address on the Agency Springboard.
On the Address page, select the address for which you want to associate parcels.

Select Parcel in the navigation bar.
o Select Parcel on the Agency Springboard.
Select a parcel on the Parcel page.
Click Parcel Address in the navigation bar.
Select an address associated with the parcel.
Select Parcel in the navigation bar.
On the Parcel page, click Add.
On the New address drawer, select the parcel that you want to associate with the address in the Parcel ID field.

(Optional) If you want this address to be the primary address for the parcel, turn on the Primary switch.
Click Save.

A WwN

Deleting Property Addresses

1. You can delete property addresses from the Addresses and Parcel Addresses pages.
o Access the Addresses page by selecting Property Address on the Agency Springboard.
o Access the Parcel Addresses page by selecting Parcel on the Agency Springboard.
Select a parcel on the Parcel page.

Click Parcel Address in the navigation bar.
2. Click Select Multiple.
3. Select the checkboxes next to the parcel addresses that you want to delete.
4. C(lick Delete. You will be prompted to confirm the permanent deletion.

Setting Up Property Owners

You add, modify, and delete property owners on the Owner page.

Adding a Property Owner

1. Select Parcel on the Agency Springboard.
Select a parcel on the Parcel page.

Click Parcel Owner in the navigation bar.
2. Onthe Parcel Owner page, click Add.
3. Inthe Basic Information section of the Parcel Owner Details page, enter information in the following fields:
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Page Element

(Hold)

(Lock)

@

(Notice)

Enabled

Primary

Owner and Secondary Owner

Owner Type
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Description

Indicates that a condition has been placed on the parcel. If multiple conditions are applied,
then the icon displays the most severe condition. Click the icon to see a list of all applicable
conditions, including the condition name, severity, description, and when the condition was
applied.

Turn the Enabled switch on to make the row available as a lookup value on other pages.

Turn the Primary switch on to indicate that this is the primary owner associated with the parcel.
A parcel may have only one primary owner.

Enter the names of the owner and secondary owner of the parcel.

Enter the type of owner for the parcel such as Personal or Town.

4. Inthe Location Information section of the Parcel Owner Details page, enter details about the location
associated with the parcel owner using the following fields:

Page Element

Address Fields

Street Number, Street Direction,
Street Name, and Street Type

Building Type

Floor

Unit Number

ORACLE

Description

The property owner address. The Country field displays US.

As you enter a Postal Code, the type-ahead list shows values that include appropriate city and
state combinations. After you select a value, the city and state appear as read-only fields, and
two address fields appear so that you can enter the rest of the address.

If you don’t know the postal code, click the Don’t know link to display a full set of address
fields.

Enter the street information for the parcel owner.

Enter the type of building associated with the parcel owner.

Enter the floor of the building for the parcel owner.

Enter the unit number for the parcel owner.
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Page Element Description

5. Inthe Contact Information section of the Parcel Owner Details page, enter the contact information details for
the parcel owner using the following fields:
o Email Address
o Home Phone Country Code
o Home Phone Number
o Work Phone Country Code
o Work Phone Number
o Cell Phone Country Code
o Cell Phone Number
o Fax Country Code
o Fax Number
6. Inthe Transfer Information section of the Parcel Owner Details page, enter transfer details for the parcel owner
using the following fields:
o Last Transfer Type
o Document Number
7. Click Save.

Modifying a Property Owner
1. Select Parcel on the Agency Springboard.
Select a parcel on the Parcel page.
Click Parcel Owner in the navigation bar.

Select an owner associated with the parcel.

Note: Select Property Owneron the Agency Springboard to select a parcel owner to modify from a list of all
parcel owners.

2. On the Parcel Owner Details page you can:

o Update the parcel owner field values.

o Enable or disable the parcel owner using the Enabled switch. Only enabled parcel owners are available as
lookup values on other pages.

o Indicate whether this is the primary owner associated with the parcel using the Primary switch.
3. Click Save.
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Deleting Property Owners

1. Select Parcel on the Agency Springboard.
Select a parcel on the Parcel page.

Click Parcel Owner in the navigation bar.
2. On the Parcel Owner page, click Select Multiple.
3. Select the checkboxes next to the parcel owners that you want to delete.
4. Click Delete. You will be prompted to confirm the permanent deletion.

Assigning Districts to Parcels

You add, modify, and delete parcel district assignments on the Parcel District page.

Assigning districts to parcels is required setup for inspection scheduling. For more information, see Setting Up
Inspection Scheduling.

Also, inspection assignments are based on inspection type and inspection district job attributes that are associated with
job functions, such as Building Inspector. For more information, see Setting Up Agency Staff.

Assigning a District to a Parcel
1. Select Parcel on the Agency Springboard.

Select a parcel on the Parcel page.

Click Parcel District in the navigation bar.
2. Onthe Parcel District page, click Add.
3. On the Parcel District Details page, enter the district you want to associate with the parcel in the District field.
4. Click Save.

Modifying a Parcel District Assignment

1. Select Parcel on the Agency Springboard.
Select a parcel on the Parcel page.

Click Parcel District in the navigation bar.
2. Select a district on the Parcel District page.
3. On the Parcel District Details page you can:

o Select a different district to assign to the parcel.
o Delete the assigned district. You will be prompted to confirm the permanent deletion.
4. C(lick Save.

Deleting Parcel District Assignments
1. Select Parcel on the Agency Springboard.
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Select a parcel on the Parcel page.

Click Parcel District in the navigation bar.
2. Click Select Multiple.
Select the checkboxes next to the parcel district relationships you want to delete.
4. Click Delete. You will be prompted to confirm the permanent deletion.

w

Assigning Districts to Addresses

You assign districts to addresses on the Address District page.

Inspections are scheduled and assigned based on the district associated with a property. For properties associated with
a parcel, you assign districts to the parcel on the Parcel District page. See Assigning Districts to Parcels. For properties
with an address, but no parcel, use the Address District page to assign districts to a property.

For more information on inspection scheduling and assignment, see Setting Up Inspection Scheduling.

Assigning a District to an Address
1. Select Property Address on the Agency Springboard.
Select an address on the Address page.

Click Address District in the navigation bar.

Note: The Address District page is available only for addresses with no parcel.

2. Onthe Address District page, click Add.

3. Onthe Address District Details page, enter the district you want to associate with the address in the District
field.

4. C(lick Save.
Deleting an Address District Assignment
1. Select Property Address on the Agency Springboard.
Select an address on the Address page.

Click Address District in the navigation bar.

Note: The Address District page is available only for addresses with no parcel.

2. Select a district on the Address District page.
3. On the Address District Details page, click Delete. You will be prompted to confirm the permanent deletion.

Note: If you associate an address that has a district assigned to it to a parcel, the system automatically removes the
district assignment. This is because the district assignment is now defined through the parcel associated with the
address rather than through the address itself.
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Setting Up Parcel Values

You add, modify, and delete parcel values on the Parcel Value setup pages. You can have multiple effective-dated rows
for parcel values.

To switch to viewing other effective-dated entries, click the Date Range drop-down list and select the effective-dated
row you want to view.

When starting from Home with Ask Oracle, select Setup and Maintenance of Offerings to access the Functional Setup
Manager. Select Setup: Public Sector Permits/Public Sector Business Licenses > Functional Area: Agency Profile >
Task: Manage Parcel Values.

Adding a Parcel Value

Here's how to add a parcel value:

On the Parcel page, click the parcel number you are working with.

In the parcel record, click the Parcel Value link in the left-hand navigation panel.
Click the Add Parcel Value button.

On the Parcel Value Details page, enter information in the following fields:

P UWN

Page Element Description

Parcel Number Displays the parcel number associated with the Parcel ID that you selected.

Effective Start Date and Effective End Enter the start date when the fee schedule is effective. The default value for the effective end
Date date is open-ended and can't be changed.

For more information, see "Working with Effective Dates in Parcel Values" in this topic.

Parcel Size 1 and Parcel Size 1 UOM Enter a numeric value and a unit of measure to define the size of the parcel.
(parcel size 1 unit of measure)

Parcel Size 2 and Parcel Size 2 UOM Enter a numeric value and a unit of measure to define an additional size for the parcel.
(parcel size 2 unit of measure)

Land Value Enter the monetary value of the land associated with the parcel.
Improvement Value Enter the monetary value of any improvements made to the parcel.

Personal Property Value Enter the monetary value of any personal property associated with the parcel.
Fixtures Enter the monetary value of any fixtures associated with the parcel.
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Page Element Description
Owner Exemption, Fixture Enter the monetary value of any exemptions associated with the parcel.

Exemption, and Other Exemption

Net Assessed Value Enter the assessed monetary value of the parcel.

Currency Code Enter the currency that applies to the parcel value.

Property Use Code Enter the property use code associated with the parcel.
5. Click Save.

Working with Effective Dates in Parcel Values

You can have multiple effective dates for a parcel value. Parcel values with multiple effective-dated entries appear only
once in the list on the Parcel Value page, showing the current or only effective-dated row.

To switch to viewing other effective-dated entries when they exist, click the Date Range drop-down list and select the
effective-dated row you want to view.

Here’s how to add an effective-dated parcel value:

1. On the Parcel Value page, select the row.
2. On the Parcel Value Details page, click the Add New Effective Date button.
3. Enter the effective start date.

Here are considerations for managing effective-dated entries:

« Only users with assigned permissions through the PSC System Administrator role can delete current or
historical rows, as well as edit effective start dates.

The system recalculates date ranges when updates are made and prevents duplicate start dates.

- All agency staff can delete future-dated rows.

Only agency staff with the system administrator role for managing effective dates can click Delete to remove an entire
parcel value definition, along with all of its effective-dated entries.

Modifying or Deleting a Parcel Value

All agency staff can delete future-dated rows, but you must have permission to delete current or historical rows, as well
as edit effective start dates.

1. On the Parcel page, click the row for the parcel number you are working with.
2. Inthe parcel record, click the Parcel Value link in the left-hand navigation panel.
3. Click the row for the value you want to modify or delete.
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4. On the Parcel Value Details page, you can:

o Click the Date Range drop-down list to select the effective-dated row you want to view if there are
multiple effective-dated rows.
o Update the parcel value information. You must have permissions to edit effective start dates.

Click Save to save your updates.
o Click the Delete Effective Date button to delete future-dated rows. You must have permissions to delete
current or historical rows.

5. Click the Delete button in the Parcel Value Details page header to remove an entire parcel value definition,
along with all of its effective-dated entries. You must have permissions to delete the parcel value definition.

Setting Up Ownership Types

Ownership type indicates how a business was established; for example, a corporation or a nonprofit. You set up
ownership types for your agency on the Ownership Type page.

Adding an Ownership Type

Select the Setup and Maintenance tile on the Agency Springboard to access Functional Setup Manager.

From the Setup drop-down list, select your offering.

From the Functional Areas list in the left panel, select Agency Profile.

The right panel shows the required tasks for the selected functional area. Select All Tasks from the Show drop-
down list and then select Manage Ownership Types from the tasks list.

On the Ownership Type page, click the Add (+) button.

On the New ownership type drawer, enter a name for the ownership type.
Enter a description.

Verify that the Enabled switch is turned on.

Click Save.
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Modifying an Ownership Type

1. Onthe Ownership Type page, click the row for the ownership type that you want to modify.
2. On the Ownership type details drawer, you can:

o Modify the ownership type description. You can't change the type name.
o Turn on or off the Enabled switch to enable or disable the ownership type, respectively.
3. Click Save.

Deleting an Ownership Type

1. Onthe Ownership Type page, click the row for the ownership type that you want to delete.
2. Onthe Ownership type details drawer, click the Delete button.

You will be prompted to confirm the permanent deletion.
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Setting Up Property Conditions
A property condition identifies the general condition of the property. This value is used to indicate the general age of a
property, a property’s physical condition, or other condition.

You add, modify, and delete property conditions on the Property Condition page.

Adding a Property Condition

1. Select Common Setup > Property Condition.
2. On the Property Condition page, click Add.
3. On the Property Condition Detail page, enter values for the following fields:

Page Element Description
Property Condition Enter the property condition, such as Poor or Good.
Description Enter a description of the property condition.

4. Verify that the Enabled switch is turned on.
The switch is on by default for a new property condition.
5. Click Save.

Modifying a Property Condition

1. Select Common Setup > Property Condition.
2. Click a row on the Property Condition page.
3. On the Property Condition Detail page you can:
o Update the property condition description.

o Turn off the Enabled switch to deactivate the property type.
4. Click Save.

Deleting Property Conditions

1. Select Common Setup > Property Condition.
2. To view a definition before deleting it, click the row to be deleted, then click the Delete button on the Property
Condition Details page.

3. To delete one or more definitions without viewing details:

a. Click Edit.

b. Select the checkboxes next to the definitions that you want to delete.

c. Click Delete.

You will be prompted to confirm the permanent deletion.
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8 Setting Up Contractor Licenses

Setting Up Contractor License Options

Contractor license options are system-wide settings that control contractor license processing and data. You can
maintain multiple sets of options, each with its own identifying code. But only one code at a time can be active.

Use contractor options to control:

- Whether you integrate with an external licensing body to validate license information during application intake.
- Whether to allow users to manually choose classifications for licenses.

- Whether to decline an application based on the status of the license.

- Which sections for supplemental license information are visible to users.

- Which ownership and insurance types the applicant can select in the intake form.

You can also establish an integration with an external licensing body to load license information into your contract
records.

Configuring Contractor License Options

Here's how staff with an agency administrator or business analyst role can set up contractor options:

Select Contractor Setup > Contractor License Options.

Click Add to create a new set of options, or click an existing row to modify it.
If you're creating a new set of options, enter a unique Code as an identifier.
Enter a Description for this set of configuration options.

PUWUNA

The description should be suitable for end-users because both public users and agency staff see the
description when entering contractor information.
5. Use the Active switch to indicate whether this is your active contractor configuration.

Only one set of configuration options can be active. If another configuration is already active, then an error
message explains that you must turn off this switch for the active configuration first.
6. Use these switches to enable additional configuration options:

Page Element Description

Integrated with External Source When this option is enabled, users can retrieve license information from an external licensing
body in the intake form. Click the Integrations link to identify the Oracle Integration Cloud (OIC)
integration that retrieves the information.

When integration is inactive, the Limit to Contractor List option is automatically enabled and
the License Types link appears.

Whether the Integrated with External Source switch is on or off, you can set up an integration
to load license data using batch processing in the Integrations section.
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Limit to Contractor List

Limit License Usage to Authorized
Contacts

Document Group

Working with Integrations
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Description

When this option is enabled:

o Users can only select licenses from the agency’s contractor records in the intake form,
whether or not there’s an active integration.
o The agency can still add licenses to the contractor records from an external source using
an integration.
When this option is off, licenses entered in the intake form are retrieved first from the
contractor records if they exist there, then from the external licensing body.

Turn on this switch to allow only authorized contacts access to the agency-maintained list of
approved contractors when selecting a contractor license.

For business license applications, this option only applies when the application type uses the
Select from List display option for collecting contractor information. For information, see Using
the Intake Form Designer for Business Licenses.

Select a document group.

When you specify a document group, document attachments can be classified into categories
and subcategories when you upload files. Then you can see the category for a document on the

Attachments page in the contractor license details.

For more information, see Setting Up Document Groups.

To enable integration with an external contractor license source:

1. Click the Integrations link to configure integration settings in the Integrations grid.
2. Click the Add action to add an integration. You can only add one of each type of integration.
3. Enter the following for each integration:

Page Element

Type

Integration Name and Integration
Parameter

ORACLE

Description

Identifies the process that uses integration:

o Verify license online retrieves information for a specific license that a user enters in the
main contractor page or in the intake form for a permit or planning application. These
pages have a button that the user clicks to initiate information retrieval.

o Batch load license data establishes the integration used to load information for multiple
licenses into your contractor records when batch processing runs.
You can create only one row for each integration type.

Enter the name of the OIC integration that retrieves contractor license and contact information
and the query parameters for the OIC integration end point. Oracle Public Sector calls the PSCR
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Page Element Description

CONTRACTOR BATCH LOAD integration by using the parameter DataSource,MergeOption,
LastUpdated,DataToLoad.

Integration Version Enter the version number of the OIC integration.
Key Leave this field blank. The source key is maintained in the OIC integration definition.
Integration Enabled Indicate whether the integration type is enabled.

Adding License Types

You can add license types whether or not your system is integrated with an external source. Applicants select a
contractor license type when entering contractor information in the intake form.

Oracle recommends adding a license type with the value LICENSE to the License Types grid. That way, if your system is
integrated with an external source and the integration doesn't return license types, then LICENSE appears as the default
value on the contractor license.

To select license types for this set of license options:
1. Click the License Types link to maintain license types.

2. Click the Add action to add a license type.
3. Enter the following information for each license type:

Page Element Description

License Type Enter the unique identifier for the license type.
Description Enter the descriptive name of the license type.
Enabled Indicate whether the license type is enabled.

Working with License Classifications

To set up license classifications for this set of license options:

1. Click the Classifications link to maintain the license classifications in the Classifications grid.
2. C(lick the Add action to add a classification.

129
ORACLE



Oracle Public Sector Permitting and Licensing Chapter 8
Implementing Your Agency Setting Up Contractor Licenses

3. Enter the following information for each license classification:

Page Element Description

Code Enter the unique identifier for the license classification. The contractor licensing body sets
these codes.

Description Enter the descriptive name of the license classification.

Enabled Indicate whether the license classification is enabled.

Working with License Statuses

The statuses that the licensing body assigns are called source statuses. When integration is turned on, you map a
source status to an agency’s internal status.

CAUTION: The license status defaults to Other for unmapped source statuses. Applications that include licenses with
an Other status are automatically declined.

To set up license status mapping rules:

1. Click the Status Rules link to maintain a mapping in the Status Rules grid.
2. C(lick the Add action to add a mapping.
3. Enter the following information for each status rule:

Page Element Description

Status Select the agency status for this rule. When a license has this status in the contractor records,
and the Decline Application switch is on, the application can’t be submitted.

If using an integration, select the agency status to assign to licenses that have the specified
source status. If multiple source statuses map to a single agency status, there will be multiple
rows for the agency status.

Source Status Enter a license status that’s assigned by the licensing body. This field is only available when
you're integrating with a licensing body. When integration is turned on, you map a source status
to an agency’s internal status.

Decline Application Enable this switch to prevent applications from being submitted when a contractor license has
this agency status, or this source-to-agency status mapping when integrated with an external
licensing body. This option also prevents you from adding contractor licenses with the source
status to the permit details.

Enabled Indicate whether the status rule is enabled.
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Page Element Description

Displaying Category Sections

Sections are specific categories of supplemental information about licenses. License classifications appear in a section
on the intake form and contractor record. Other sections include information about bonds and insurance such as
Workers' Compensation. The sections you enable at the agency level appear on the Select Display Options page in the
application designer.

You can change section titles by updating the section description on Contractor License Sections setup page. For more
information, see Setting Up Contractor License Sections.

To enable the sections you want to display:

1. Click the Sections link to maintain sections in the Sections grid.

2. C(lick the Add action to add a section.

3. Inthelist of available sections, use the Enabled switch to control section visibility. Turning off the switch hides
the section on the intake form and contractor record from both agency staff and public users.

For information about displaying contractor license sections with instructional text on business license applications and
contractor registration intake forms, see Using the Intake Form Designer for Business Licenses.

Selecting Ownership Types

Applicants select an ownership type from the list when providing license information on the intake form. You define
which ownership types are available to choose from.

To select the ownership types you want to display:

1. Click the Ownership Types link to maintain the types of business ownership that can be associated with the
contractor’s license in the application.

2. Click the Add action in the Ownership Types grid.

Using the lookup prompt, you can select from the ownership types that you set up on the Ownership Types
page, for example, Corporation, Partnership, or Sole Proprietorship. For information about setting up ownership
types, see Setting Up Ownership Types. If an ownership type is retrieved from an integration but isn’'t in the
contractor license options, the ownership type is added to the contractor license option details.

3. Turn on the Enabled switch to indicate the ownership type is active.

Setting Up Insurance Types

To set up the insurance types you want to display:

Click the Insurance Types link to display the Insurance Types grid.

Click the Add action to add the types of insurance information that can be associated with a license.
Enter values in the Insurance Type and Description fields.

Turn on the Enabled switch to indicate the insurance type is active.

P AN
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Setting Up Contractor License Sections

Contractor license information can include sections with different types of data such as license classification
information, workers’ compensation information, and contractors’ bonds. To ensure that users see meaningful labels for
these sections, use the Contractor License Sections page to maintain section descriptions.

Note: This page is only for updating descriptions. You enable contractor license sections at the agency level on the
Contractor License Option Details page. See Setting Up Contractor License Options.

To maintain the descriptions of contractor license sections:

Select the Setup and Maintenance tile on the Agency Springboard to access Functional Setup Manager.
From the Setup drop-down list, select your offering.
From the Functional Areas list in the left panel, select Agency Profile.

The right panel shows the required tasks for the selected functional area. Select All Tasks from the Show drop-
down list and then select Manage Contractor License Sections from the tasks list.

5. Review the Description for each delivered section, and update the descriptions as needed.

PUWNa

These are the delivered sections:

Section Code Delivered Description
ORA_HEADING Profile Heading
ORA_LICENSE License
ORA_CONDITIONS Condition
ORA_BUSINESS Business
ORA_CLASS Classification
ORA_CB Contractor Bond
ORA_BQI Other Bonds
ORA_WC Workers' Compensation
ORA_CONTACTS Contact Person

6. Click Save.

Setting Up Contractor Integration

This topic describes how to import and activate integration settings that enable you to validate contractor information
against data from the contractor licensing body.
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Oracle provides pre-built integrations with specific contractor licensing bodies. To set up this integration, download
the integration files from My Oracle Support and then import them into Oracle Integration Cloud (OIC). To use

an integration after you set it up, use the Contractor License Options page. For more information, see Setting Up
Contractor License Options.

To set up contractor integration:

1.
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10.
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Go to My Oracle Support (MOS) and access Doc ID 2672514.1, Public Sector Compliance and Regulation Setting
Up Contractor Integration.

Follow the instructions on the MOS page, and save the IAR integration file for your contractor licensing body.
Access the main console in OIC.

Click Integrations in the left frame.

Click the Import button at the top of the Integrations page.

Select the integration file for your licensing body, then click the Import button.

Click Connections in the left frame.

Test the Generic REST Trigger connection:

a. Access the detail page for the Generic REST Trigger connection.
b. Click the Test button.
c. When the test is 100% complete, click Save and then Close.

Test the integration for the imported licensing body:

a. Access the detail page for the licensing body connection.

b. Click the Test button.

c. When the test is 100% complete, click Save and then Close.
Click Integrations in the left frame to return to the Integrations page.
Turn on the activation switch for the new licensing body integration.
In the Activate Integration window that appears, click the Activate button.

Preparing to Load Contractor Licenses

Oracle provides a prebuilt Oracle Integration Cloud (OIC) integration to load licenses and license contacts from a
manually provided file, or you can get licenses from a contractor licensing body. Import a package and activate
integration settings in OIC before you load contractor licenses.

Your OIC configuration depends on which batch load method you're using. You can retrieve licenses from:

- A contractor licensing body.

This option is only available with integration to an external service and integration is enabled on the Contractor
License Option Details page. This option applies when you want to update the licenses in your contractor list.

A file.

You can manually load a file with contractor licenses regardless of whether an integration with a licensing body
is enabled or not. Contractor contact information associated with a license can be manually loaded using a file
only. When an online integration is not available and integration is disabled on the Contractor License Option
Details page, licenses can only be loaded using a file. This option can help you migrate contractor data from a
legacy system.

For information about integration settings, see Setting Up Contractor License Options.
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Here's how agencies configure OIC to load contractor licenses:

1. Go to My Oracle Support (MOS) and access Doc ID 2759502.1, Configuring Oracle Integration Cloud (OIC) for
Loading Contractor Licenses in Oracle Permitting and Licensing.
Follow the instructions on the MOS page, and save the PAR package file for loading licenses from a contractor
licensing body or a license file.
Access the main console in OIC.
Click Packages in the left frame.
Click the Import button at the top of the Packages page.
Select the package file for loading licenses from an external licensing body or license file, then click the Import
button.
Click Connections in the left frame.
Configure, test, and save these connections in the package:
a. FTP Read Contractor File
b. PSC Rest Connector
c. CSLB Rest Trigger
d. CSLBREST CONNECTOR
9. C(lick Integrations in the left frame.
10. Configure and activate these integrations in the package:
a. CSLBBATCH LOAD - REST
b. CSLBPOST LICENSE - REST

N

ounpw

® N

Loading Contractor Licenses and Contacts

You can use batch processing to load contractor license records manually from a file or through an integration with a
licensing body. Merge options enable you to load a full file or update licenses matching those in the agency-maintained
contractor list. You also have the option to load license contacts from a file.

Processing can be executed as needed, such as when you want to migrate contractor data from a legacy system, or on a
scheduled basis to refresh license records in the contractor list. Staff with agency administrator or business analyst roles
can configure the system for batch processing. Here's how batch load processing works:

Contractor licenses - The batch load process for contractor licenses replaces licenses, classifications, bonds,
other bonds, and insurances already in the system if a match with this information is found. If an exact match
isn't found, the process creates a new license. Any records not matching the rows are agency-managed rows
and the agency must manually evaluate and remove records.

Contacts - The batch load process for contacts replaces license contacts already in the license details with the
contact information from the file if there's a matching email, first name, middle name, and last name. If an
exact match of email and name isn't found, the process creates a new license contact.

For more information, see Contractor License Overview.

Before You Begin

Oracle provides a prebuilt Oracle Integration Cloud (OIC) integration to load licenses. You import a package and activate
integration settings in OIC before you run batch processing.

For information about OIC configuration for an integration with a licensing body and connections for loading a file with
license records, see Setting Up Contractor Integration and Preparing to Load Contractor Licenses.
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Entering Parameters

1. Select Contractors > Load Contractors.
2. Click the Parameters tab on the Load Contractors page.
3. Inthe Data to Load field, select the type of data that you want to load:

o Licenses
o Contacts
o Licenses and contacts

Note: You can add contact information to the batch load layout from a file only. A license must exist to load
the contacts.

4. Enter these parameters for your batch process if your data type is Licenses.

For loading Contacts and Licenses and contacts, the data source is File and the other options are not available.

Page Element Description

Data Source Select an option to indicate the source of the license records that you want to load:

o File—Processing picks up license information from a file to merge with license records.

o Integration service — Processing connects with a licensing body through an integration
service to get the license file and merge license records.

Merge Option Select how you want to merge the data from the source with your system:
The Entire file option works in two ways:

o Loads any new licenses from the file that do not exist in the contractor list.
o Updates existing licenses in the contractor list from the file.

Use the Contractor list option to update licenses that already exist in the contractor list. The
process skips licenses that don't exist in the contractor list.

Period in Which Licenses Were Last Identify which records you want to merge by when they were last updated. For example, if you
Updated want to merge the records from the source that were updated in the last two weeks, select the
number 2 and the unit of time, Weeks.

o Select a number 1or greater.

o Select a unit of time, including None, Days, Weeks, or Months. If you don't want to load
records based on a given period, select None.

Note:
To identify licenses that were updated in the specified period only, the license data must
have a last updated date. If a licensing body doesn't use a last updated date, select None.
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1. Access the Schedule tab.
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To immediately add the process to the queue, select the As soon as possible option.
3. To create a schedule for the process, select the Using a schedule option, and enter values using the following

fields:

Page Element

Frequency

Start Date

End Date

Hours and Minutes

Days

Weeks

ORACLE

Description

Select how frequently you want to run the process. Values are:

o Once: Select to run the process one time only.

o Hourly or minute: Select to run the process at regular time intervals.
o Daily: Select to run the process at regular intervals in days.

o Weekly: Select to run the process at regular intervals in weeks.

o Monthly: Select to run the process on specific days of the month.

o Yearly: Select to run the process during specific months.

Enter the date on which you want to begin your scheduled processing.

Enter the date on which you want to end your scheduling processing.

Enter the time interval between scheduled processes. For example, if you enter 2 in the Hours
field and 30 in the Minutes field, the process will run every 2 hours and 30 minutes beginning
on the specified start date.

Note:

These fields are available only if you select a process frequency of Hours or Minutes.

Enter the number of days between scheduled processes. For example, if you enter 3, the

process will run every 3 days beginning on the specified start date.

Note:

This field is available only if you select a process frequency of Daily.

Enter the number of weeks between scheduled processes. For example, if you enter 6, the

process will run every 6 weeks beginning on the specified start date.

Note:
This field is available only if you select a process frequency of Weekly.
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Repeat - By day

Repeat - By date

Month
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Description

Select this option to run the process on specific days of the month irrespective of the date. For
example, if you select the Secondand Wednesday options, the process will run on the second
Wednesday of every month.

You can select more than one week of the month and day of the week option. For example, you
could schedule the process to run on the first and third Monday of every month.

Note:
This option and its associated fields are available only if you select a process frequency of
Monthly or Yearly.

Select this option to run the process on specific dates of the month. You can select more than
one date.

Note:
This option and its associated fields are available only if you select a process frequency of
Monthly or Yearly.

Select the months in which you want your process to run.

Note:
This option and its associated fields are available only if you select a process frequency of
Yearly.

Setting Up Process Notifications

You can set up the process to send notifications to you and others when it runs.

1. Turn on the Notify Me When This Process Ends switch to send yourself a notification when the process

finishes.
2. Access Notification tab.
3. Click Add.

ORACLE
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4. On the Create Notification page, enter the email address of the person you want to receive notifications.
By default, the recipient receives a notification when the process ends with the following conditions:

o Onsuccess
o Onerror

o Onwarning

You can remove any of these process notification conditions.
5. Click OK to save the notification recipient.
6. (Optional) To delete a notification recipient, select the recipient in the Notification tab and click Delete.

Submitting the Process

Once you've entered your process parameters, scheduling information, and notification recipients, you're ready to
submit the process. Enter any additional information in the Submission Notes field and click Submit. Click Process
Monitor to check the status of your process.

Setting Up Contractor License History

To preserve the historical accuracy of contractor license information for an application, snapshots of the contractor
license details are taken during the permit lifecycle and stored with the permit when its status becomes terminal. An API
is also provided for agencies to customize the timing of any additional historical snapshots, in addition to those taken at
delivered workflow statuses.

Agency staff and registered users applying for permits and viewing permit details in the Redwood Experience see
the latest contractor license information without manually refreshing each license, but only agency staff can view the
contractor license history saved with the permit.

Here's more information about how contractor license history works:

- The agency must have the Redwood Experience for Application Intake, Make a Payment, and Transactions List
enabled.

- The contractor licenses must exist in the contractor list or come from an external source because information is
automatically retrieved from these sources.

- Contractor license history is captured at some of the delivered application workflow statuses such as
Submitted, Permit Issued, Inspection, Completed, Certificate of Occupancy, Denied, Withdrawn, and Expired.

A history snapshot can be captured without workflow when an application status is Submitted or Completed,
depending on agency setup.

- The agency can set up the publicSectorRecordContractorHistories REST API to take additional history
snapshots when called from the workflow. The duty role with access to add application contractor history is PSC
Transaction Contractor History Administration.

Related Topics
- Working with Contractors and Agents in Applications
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Working with Contractor Expiration

Agencies can manage contractor license and contractor license insurance expiration using scheduled rules set up in the
Business Rules Framework. The rules can be configured to automate communications and the resolution of contractor
conditions associated with expiring or expired contractor licenses and license insurance.

Your agency can also set up the system to automatically apply contractor license conditions when the contractor license
or insurance expires. For more information, see Applying Conditions to Contractor Licenses.

Here's how administrators can configure the communication and condition resolution actions for the contractor
expiration:

1. Navigate to the Business Rules Framework.
2. Select Scheduled Rules.

For more information about working with scheduled rules, see Setting Up Scheduled Rules.
3. Use the Search function to find these events:

o Contractor License Expiration
o Contractor License Insurance Expiration

4. Inthe Criteria section, add the criteria for contractor licenses, including License Status and Expire Date.
5. Add the actions for the rule like this:

Action Description

Send communication Select this action to send notification emails to the business and the license holder when a
license or insurance is about to expire or has expired.

If you select the action to send communication, you also need to set up templates for these
communication events: Contractor License Expiration and Contractor License Insurance
Expiration. Set up a template for each event. Attributes from the Contractor Licenses resource
are available for personalization of the message body of outgoing communications.

Templates need to be set up on the Communication Events page. The License Holder Email
and Business Email attributes are available when setting up the communication recipients. For
more information, see Setting Up Send Communication Actions and Setting Up Communication
Templates.

Resolve conditions Select this action to automatically resolve specified contractor conditions related to contractor
license or insurance expiration. For more information, see Applying Conditions to Contractor
Licenses and Setting Up Resolve Condition Actions.
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9 Setting Up Comments

Managing Comments

This topic provides an overview about Standard Comments and discusses how to manage comments.

Standard Comments Overview

Standard comments are predefined comments that users can easily and quickly use, instead of manually entering the
text. Standard comments are generic and complete, which make them reusable.

Users can use standard comments across all Oracle Permitting and Licensing offerings. You can use standard
comments while updating your applications.

System administrators set up application categories and subcategories using the Application Category page, based on
the type of comments you wish to have. Standard comments are set up using the Standard Comments page.

Managing Comments

You manage the comments by setting up how you want the comments to be available for the agency staff members.

1. Select Comments > Manage Comments.
2. On the Manage Comments page, you add values to all these fields:

Page Element

Number of days comment is recent

Rich Text Editor

Comment Summary Length

Default Visibility of Comments

ORACLE

Description

Enter a numeric value or use the increment/decrement buttons. The number of days a
comment is listed as Recent is based on the value in this field.

Use the switch to enable or disable Rich Text Editor formatting for comments.

Enter a numeric value or use the increment/decrement buttons. This value determines the
maximum number of characters that can be displayed in the Comment Summary field.

Note:
The system allows a maximum length of two hundred (200) characters in the comment
summary.

Turn on the Private switch next to a comment application group to set its comments as private
and locked.

All new comments for the groups are set as public by default. Comments set as private will only
be visible to the agency staff.
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Page Element Description

3. Click Save to save the changes.

Setting Up Standard Comment Categories and
Subcategories

This topic discusses how to set up Standard Comment Categories and Subcategories.

Setting Up Standard Comment Categories and Subcategories

You set up the comments categories and subcategories on the Application Category page.

1. Select Comments Setup > Comment Categories.

On the Application Category page, click Add to add a new category.
2. On the Application Category Details page, you add values to all these fields:

Field Name Description
Application Category Enter a category.
Description Enter a description for the category. This description displays detailed information about the

category when searching for categories.

3. Turn on the Enabled switch if you want to enable this category when you save it. The switch is turned off by
default for a new category.

In the Application Groups section, you can include application groups that you want this category to be
available for. Click Add to open the Application Group Details page, select the application group.

Turn on the Enabled switch if you want to enable the selected group when you save the page.

Click Save to save the newly added application group and return to the Application Category Details page.
To add an application subcategory, select the Application Subcategories section and click Add.

On the Application Subcategory Details page, you add values to all these fields:

P

©No o,

Field Name Description

Application Subcategory Enter a subcategory

Description Enter a description for the subcategory. This description displays detailed information about
the subcategory when searching for subcategories.
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9. Turn on the Enabled switch if you want to enable this subcategory when you save it. The switch is turned off by
default for a new subcategory.
10. Click Save to save the newly added application subcategory and return to the Application Category Details
page.
11. Click Save to save the record and return to the Application Category page.

Modifying Standard Comment Categories and Subcategories

You modify the comments categories and subcategories on the Application Category Details page.

Select Comments Setup > Comment Categories.

On the Application Category page, click the chevron on a category line to select and modify the category.

On the Application Category Details page, enter new values in the Application Category and Description fields.
Verify that the Enabled switch is turned on if you want to enable this category when you save it.

Use the Application Groups section to select the application group that you want this category to be available
for.

In the Application Subcategories section, you can edit the application subcategories.
Click Save to save the changes. You can use the Delete button to delete the category.

A OWN

N o

Viewing, Adding, Modifying, and Deleting Standard
Comments

This topic discusses how to view, add, modify, and delete Standard comments.

Viewing Standard Comments

You search and view Standard Comments on the Standard Comments page.

1. Select Comments Setup > Standard Comments.
2. Use the application category or application subcategory fields to filter comments on the Standard Comments
page.

Adding Standard Comments

You add comments using the Add button on the Standard Comment page.

1. Select Comments Setup > Standard Comment

2. On the Standard Comments page, click Add to open the Standard Comment Details page and add a new
comment.

3. Onthe Standard Comment Details page, enter values for these fields:

Page Element Description
Comment Code Enter a comment code.
Application Category Enter an application category
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Application Subcategory Enter an application subcategory
Description Enter a comment.

4. Verify that the Enabled switch is turned on if you want to enable this comment when you save.
5. Click the Save button to save the new comment and return to the Standard Comment page.

Modifying Standard Comments

You modify comments on the Standard Comment Details page.

1. On the Standard Comments page, click the chevron on a comment line to select and modify the comment.

2. To modify the comment, you can change the values entered in the Application Category and Application
Subcategory fields, and edit the description.

3. Verify that the Enabled switch is turned on if you want to enable this modified comment when you save.

4. C(lick Save.

Deleting Standard Comments

You delete comments on the Standard Comment Details page.

1. On the Standard Comments page, click the chevron on the comment line which you want to delete.
2. Onthe Standard Comment Details page, click the Delete button to delete the comment.
3. Click Yes on the confirmation page to delete the comment and return to the Standard Comments page.
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10 Setting Up Documents

Setting Up Document Categories and Subcategories

You set up document categories and subcategories on the Document Category pages to organize the various types of
attachment files. Applicants select the document's category or category and subcategory when attaching documents.

After defining the document category, you add the document categories to the document group and then enter the
document group ID on the transaction type for permits, planning applications, and business licenses.

System administrators can configure the categories and subcategories to identify required documents and the stage
in the application process where the documents are required. If you add a document group to the application type and
the document group includes document categories that are configured to identify required documents, the Required
Documents section appears on the application intake form and the Attachments page in the application details. The
system checks for the presence of attachments with the required category or category and subcategory pair at the
different steps in the application and displays an error if the required documents haven't been added.

For license applications, categories and subcategories define the required document and the application step where
it's required. Then the document group assigned to the license activity determines whether that category or category/
subcategory requirement applies to origination, renewal, or amendment activities.

Note: If the same category or category and subcategory combination is included in multiple document groups, the
same required document application step applies wherever that category or combination is used.

Use the Required Document Application Step options in the document category and subcategory definitions to
configure when a document or file is required. Let's take a look at the available steps:

Step Description

Submittal (application submittal) Applicants can't submit the application without adding the specified document first. Only documents
required at the Submittal step are required before the applicant can submit the application.

Issuance (application issuance) The permit or business license can't be issued without this document. This step doesn't apply to
planning applications.

Validating documents at this step requires workflow setup. See Using Custom Properties.

Acceptance (application acceptance) Agency staff can't accept this document into the system if this document is missing.

Validating documents at this step requires workflow setup. See Using Custom Properties.

Final inspection Inspectors can't create a final inspection without this document. This switch is only available if your
agency uses Permits or Licenses. This step doesn't apply to planning applications.

Complete (application complete) The application process won't be complete until this document has been attached.

Validating documents at this step requires workflow setup. See Using Custom Properties.
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Adding Document Categories

1.

6.

In the Functional Setup Manager, select Setup: Public Sector <Offering> > Functional Area: Agency Profile >
Task: Manage Document Category and Subcategories.

On the Document Category page, click Add to add a new document category.
Enter values on the Document Category Details page:

Page Element Description

Category ID Enter an identifier for the category.

Category Enter a name for the category.

Description Enter a description of the category.

Enabled Turn the switch on to make the category available for use. The category is disabled by default.

Turn on one or more of the switches in the Required Document Application Step section to indicate when
documents with this category are required: Submittal, Issuance, Acceptance, Final Inspection, and Complete.

If you select an application step for a category, you can't select the same required step for the subcategory.

For example, if a document with the Blueprints category is required at the application Complete step, you can't
require a document with a Blueprints category and Final Plans subcategory combination at the application
Complete step. Only a document with the Blueprints category (and no subcategory) will satisfy the requirement
at the Complete step.

Click the Configure User Assistance link to enter rich text to provide information about the requirements

for the specified document. The help (question mark) icon appears in the list of required documents on the
Attachments grid in the application intake form. Click OK to save the information.

Click Save.

Adding Document Subcategories

1.
2.
3.

On the Document Category Details page, go to the Document Subcategory section.
Click Add to add a new document subcategory.
Enter values on the Document Subcategory Details page.

Page Element Description

Subcategory ID Enter an identifier for the subcategory.
Subcategory Enter a name for the subcategory.
Description Enter a description of the subcategory.
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Page Element Description
Enabled Turn the switch on to make the subcategory available for use. The subcategory is disabled by
default.

4. Turn on one or more of the switches in the Required Document Application Step section to indicate when
documents with this subcategory are required: Submittal, Issuance, Acceptance, Final Inspection, and
Complete.

If you select an application step for a category, you can't select the same required step for the subcategory.
For example, you can't require both a document with a Blueprints category and a document with a Blueprints
category and Final Plans subcategory combination, at the same step.

If you don't select any of the application steps for the subcategory, the application steps for the category apply
to the category and subcategory pair.

5. Click the Configure User Assistance link to enter rich text to provide information about the requirements for
the specified document. This link only appears for the subcategory if the document category is required at the
Submittal step.

The system displays the user assistance configured for the subcategory if provided, but if not, displays the text
for the category, if present. The help (question mark) icon appears in the list of required documents on the
Attachments grid in the application intake form. Click OK to save the information.

6. Click Save.

Modifying or Deleting Document Categories and Subcategories

On the Document Category Details page, you can modify the category name and description, and turn the Enabled
switch on or off.

To modify a document subcategory:

1. Select the associated category to open the Document Category Details page.

2. Select the subcategory that you want to modify.

3. Onthe Document Subcategory Details page, you can change the subcategory name and description, and turn
the Enabled switch on or off.

4. C(lick Save.
You can't delete categories and subcategories if they are already referenced on an uploaded attachment.

1. On the Document Category page, select the row for the category that you want to delete.
2. If you want to delete the document category, click Delete on the Document Category Details page.

Note: When you delete a document category, all associated subcategories are also deleted.

3. If you want to delete multiple document categories, you can delete them on the Document Category page:

a. Click Edit.
b. Select the checkboxes for the document category rows to delete.
c. Click Delete.
4. To delete the document subcategory, click Delete on the Document Subcategory Details page.
5. If you want to delete multiple subcategories, you can delete them from the Document Category Details page
using the Edit and Delete buttons.
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Setting Up Document Groups

You set up document groups using the Document Group pages to organize the various categories of attachment files
into a grouping.

When you assign a document group to an application or transaction type, the categories and subcategories associated
with that document group can be selected for document attachments associated with those transactions. After you set
up the document categories, add them to a group then add the group ID to the application type definition.

For license application types, you can create separate document groups for origination, renewal, and amendment
when each activity requires different attachments. For example, an agency might create one document group for
original license applications and another document group for renewals that require updated insurance or compliance
documentation. You can also reuse the same document group for multiple activities when the document requirements
are the same.

When you add a document group to an application type and the document group includes document categories
and subcategories that are configured to identify required documents, the Required Documents section appears
on the application intake form and the Attachments page in the application details. The system checks for uploaded
attachments with the required category or category and subcategory pair at different steps in the application and
displays an error if the required documents haven't been added. For more information, see Setting Up Document
Categories and Subcategories and Setting Up Required Documents.

Adding Document Groups

1. In the Functional Setup Manager, select Setup: Public Sector <Offering> > Functional Area: Agency Profile >
Task: Manage Document Groups.

2. On the Document Group page, click Add to add a new document group.
3. Enter values on the Document Group Details page:

Page Element Description

Group ID Enter an identifier for the group.

Group Enter a name for the group.

Description Enter a description of the group.

Enabled Turn the switch on to make the group available for use. The group is disabled by default.
4. C(lick Save.

5. Add document categories that make up the grouping by clicking Add in the Document Category section.
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6. Enter a document category ID or use the lookup prompt to find a category ID.
If desired, you can click the Document Category link to research which category to choose.

The Required Document Application Step displays the step in the application process at which a document
with that category is required.
7. Click Save.

Modifying or Deleting Document Groups

1. On the Document Group page, select the row for the group that you want to modify.
2. On the Document Group Details page, you can modify the group name and description, and turn the Enabled
switch on or off.

Disabled document groups can’t be selected in the prompt list for an application or transaction type.

Note: Disabling a document group does not affect attachments for existing or new transactions associated
with permit types to which that document group is assigned. The categories and subcategories associated
with a disabled group continue to display for existing attachments and are still available to select for new
attachments.

3. Click Save to save any changes.
4. You add, remove, disable, and enable document categories for the group in the Document Category section.

When you disable a single category associated with a document group, that category and its subcategories
continue to display for existing attachments but are unavailable for new attachments.

To modify a document category, you must go to the Document Category definition pages. See Setting Up
Document Categories and Subcategories.

Note: If you disable a category on the Document Category Details page, but it’s still included in the list of
enabled categories for a document group, it will continue to be available in the prompt list for attachments.

You can't delete categories and subcategories if they are already referenced on an uploaded attachment.

1. Onthe Document Group page, select the row for the group that you want to delete.
2. Click Delete on the Document Group Details page.
3. If you want to delete multiple document groups, you can delete them on the Document Group page:

a. Click Edit.
b. Select the checkboxes for the document group rows to delete.
c. Click Delete.
4. To delete a document category from the group, click the Delete icon for the document category row in the
Document Category section.

Setting Up Required Documents

Required documents help agencies to control when information is needed throughout the application process. The
system checks for the presence of attachments with the required category or category and subcategory pair and
displays an error if the required documents haven't been added at the specified step.
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The list of required documents appears on the application intake form and on the Attachments page in the application
details after submittal. Once the application form has been saved, agency staff with permissions can manage the
document requirements on the application, such as adding or deleting which documents are required. Agency staff with
permissions can also view override history.

The documents with a specified category or category and subcategory pair can be required at these application steps,
depending on agency setup: Application Submittal, Application Issuance, Application Acceptance, Final Inspection, and
Application Complete. Only documents required at the Submittal step are required before the applicant can submit the
application. The Required Documents list displays the category and application step requirements and whether the
attachment has been uploaded.

Agency staff with permissions can override document requirements and remove files. Public users can't delete required
documents once they have been uploaded for previous application steps.

Here's how to set up required documents:

1. Create the document category and subsequent subcategories that you need. Here you can select the Required
Document Application Step for each document category or category and subcategory pair.

See Setting Up Document Categories and Subcategories.
2. Add the document categories and subcategories to the document group.

See Setting Up Document Groups.

3. Associate the document group with the permit, planning, or business license types that require the specified
documents.

See Setting Up Business License Types, Setting Up Permit Types, and Setting Up Planning Application Types.

4. Update your workflow tasks that prompt for required documents, including the application acceptance,
application issuance, and application completion workflow events.

You must set up the custom properties PSC_ACTIVITY_TYPE and PSC_FINAL_ACTIVITY for each workflow
event. For details, see Using Custom Properties.

5. If you're using workflow communications, set up communication templates for these Business Rules
Framework events:

o Business License Missing Document
o Permit Missing Document

o Planning Missing Document

See Business Rules Framework Event Details and Setting Up Send Communication Actions.
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11 Setting Up Communications

Setting Up the Twilio Security Endpoint

This topic discusses how to enable and set up the Twilio security endpoint for text message communications.

Text communications through Twilio is an optional feature provided in Oracle Functional Setup Manager (FSM). Before
configuring this feature, you must first enable it.

Enabling the Twilio Integration

1. Access FSM by selecting Setup and Maintenance in the navigator.

2. Select a Oracle Permitting and Licensing offering such as Public Sector Permits or Public Sector Planning and
Zoning.

Click the Change Feature Opt In link.

Click the Features icon for the System Administration functional area.

Click the Enable check box for the Text Communications through Twilio feature.

vihw

I Note: You can deselect the Enable check box to disable the Text Communications through Twilio feature.

Configuring the Twilio Security Endpoint

Once the Twilio integration is enabled, you can configure the Twilio security endpoint on the Manage Twilio Security
Endpoint page.

1. Access FSM by selecting Setup and Maintenance in the navigator.

Select a Oracle Permitting and Licensing offering such as Public Sector Permits or Public Sector Planning and
Zoning.

Select the System Administration functional area.

In the Show field, select All Tasks.

Select the Manage Twilio Security Endpoint task.

On the Manage Twilio Security Endpoint page, enter information for the following fields:

N

ocoupwWw

Page Element Description

URL Enter the URL to access Twilio’s token endpoint. This should include the host and the context
root information. Use the sandbox endpoint for testing and then use the live URL when you go
live.

Security Policy Select the applicable token from the drop-down list.
Username Enter the API client_id value for your Twilio endpoint account.
Password Enter the Twilio endpoint API secret code for your Twilio endpoint account.
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Page Element Description

7. Click Save and Close to save the configuration and return to the Setup page.

Delivered Communication Events

Oracle Permitting and Licensing delivers a robust registry of communication events that are triggered by transactions
and processes within the application. You can view a partial list of communication events and descriptions in this topic.

The delivered communication events are found on the Communication Events page in the classic interface. Access the
Communication Event page through the Functional Setup Manager by selecting the System Administration functional
area for an offering, then the Manage Communication Events task. Click a communication event row to open the event
details and create a template. For more information, see Setting Up Communication Templates.

Ad Hoc Communications

Event Description

Ad Hoc Application Event General application event.

Code Enforcement Document Attachments

Communication Event Name Communication Description
Code Enforcement Case Document Applicant attaches a code enforcement case document.
Attached

Contacts Communications

Communication Event Name Communication Description

Permit Contact Added to Application Generates a notification that is sent to contacts when a permit application is submitted.
Permit Additional Contact Added Generates a notification to contacts added to a permit application after it has been submitted.
Planning and Zoning Contact Added to Generates a notification that is sent to contacts when a planning application is submitted.
Application

Planning and Zoning Additional Contact Generates a notification to contacts added to a planning application after it has been submitted.
Added
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These notifications require the Send Communication action for the delivered Business Rules Framework events and the
email template for the Communication Events in this table. For more information, see Setting Up Send Communication

Actions.

In the templates, use the Contact and Contact Type attributes to address the email. For more information, see Using
Attributes in Communication Templates.

Deposit Account Communications

Communication Event Name

User Access Changed

Account Established

Additional Funds

User Invite

Deposit Received

Communication Description

Enables the agency to trigger a notification when deposit account access is modified.

Enables the agency to trigger a notification after establishing a deposit account.

Enables the agency to trigger a notification when funds have to be deposited into deposit account.

Enables the agency to trigger a notification when a user is invited to manage a deposit account.

Enables the agency to trigger a notification after receiving a first deposit.

Expiration Communication Resources

Communication Event Name

About to Expire Permit

Expired Permit

Permit About to Expire Based on
Inspection Commencement

Permit Expired Based on Inspection
Commencement

About to Expire Planning and Zoning
Application

Expired Planning and Zoning Application
About to Expire Pre-Application

Expired Pre-Application

About to Expire Business License

ORACLE

Communication Description

Generates a notification when a permit is about to expire or expired.

For example, when the permit is about to expire or expired, the agency staff and the contact listed on
the application receive a notification.

Generates a notification when a permit is about to expire or expired due to inactivity, because the first
inspection hasn’t been scheduled or passed.

For example, when a permit is about to expire or expired due to inactivity because the first inspection
hasn’t commenced, the agency staff and the contact on the application receive a notification.
Generates a notification when the planning application is about to expire or expired.

For example, when the planning application is about to expire or expired, the agency staff and the
contact listed on the application receive a notification.

Generates a notification when the preapplication is about to expire or expired.

For example, when the preapplication is about to expire or expired, the agency staff and the contact

listed on the application receive a notification.

Generates a notification when the business license is about to expire or expired.
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Expired Business License

Contractor License Expiration

Contractor License Insurance Expiration
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Communication Description

For example, when the business license is about to expire or expired, the agency staff and the contact
listed on the application receive a notification.

Generates a notification when the scheduled rules for Contractor License Expiration and Contractor
License Insurance Expiration events are set up to send communications in the Business Rules
Framework.

All attributes from the Contractor Licenses or Contractor License Insurances resource, respectively, are
available for personalization in the message body of outgoing communications.

Agencies can select the License Holder Email and Business Email attributes as communication
recipients.

For more information about permit and planning application expiration, see Expiration Overview and Working with

Application Expiration.

Communication Event Name

About to Expire Business License

Expired Business License

About to Expire Business License
Consultation

Expired Business License Consultation

Communication Description

Generates a notification when a business license is about to expire or expired.

For example, when the business license is about to expire or expired, the agency staff and the contact
listed on the application receive a notification.

Generates a notification when a business license consultation is about to expire or expired.

For example, when the business license consultation is about to expire or expired, the agency staff and
the contact listed on the application receive a notification.

For more information about business license and business license consultation expiration, see Viewing Business License

Expiration.
Fee Communications

Communication Event Name
New Fees Due
Scheduled Event: Updated Business

License Application Fees Due

Scheduled Rule: Updated Permit Fees Due

Scheduled Rule: Updated Planning
Application Fees Due

ORACLE

Communication Description

When agency staff manually adds a new fee, the applicant receives a notification that new fees have
been assessed and are due.

Scheduled rule event based on assessed or updated business license activity fees with a due status.

Generates a communication when the fees for a permit in a Due status are added or changed, the fee
status is changed to Due, or a fee amount that is due is recalculated or changed.

Use this event with scheduled rules to send communications that consolidate the fees for a permit.

Generates a communication when the fees for a planning application in a Due status are added or
changed, the fee status is changed to Due, or a fee amount that is due is recalculated or changed.
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Communication Event Name Communication Description

Use this event with scheduled rules to send communications that consolidate the fees for a planning
application.

For more information on manually adding a fee item, see Working with Fees and Payments.

For more information on sending communications with consolidated fees, see Setting Up Scheduled Rules in the
Business Rules Framework and Setting Up Fee Notices.

Permits Communications

Communication Event Name Communication Description

After Permit Application Submitted After a permit application is submitted.

Before Permit Issuance Before a permit certificate is issued.

Before Permit Application Submitted Before a permit application is submitted.

Permit Canceled Applicant receives an email or alert notification when a permit is canceled.

Permit Application Updated Initiates actions when a permit application is updated. Must be used within a Workflow model.
Permit Withdrawn Applicant receives an email or alert notification when a permit is withdrawn.

Permit Missing Document Permit application step is missing a required document.

Planning and Zoning Communications

Communication Event Name Communication Description

After Planning and Zoning Application After a planning and zoning application is submitted.
Submitted

Planner Assigned A planner is assigned for an application

Before Planning and Zoning Application Before a planning and zoning application is submitted.
Submitted

Planning Application Canceled Notifies that the planning application is canceled
Planning Pre-Application Canceled Notifies that the planning preapplication is canceled.
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Communication Description

Notifies that the planning preapplication is withdrawn.

A planner is reassigned for the application.

Notifies that the planning application is withdrawn.

Hearing Communications

Communication Event Name

Hearing Appealed

Hearing Decision Changed

Hearing Canceled

Hearing Schedule Finalized

Hearing Rescheduled

Hearing Scheduled Tentatively

Communication Description

Notifies that an appeal is submitted for the public hearing.

Notifies that the public hearing decision is updated.

Notifies that the public hearing is canceled.

Notifies that the public hearing is scheduled on a finalized date.

Notifies that there is a change in the date of the public hearing.

Notifies that the public hearing is scheduled on a tentative date.

Planning Meeting Communications

Communication Event Name

Planning Application Meeting Canceled

Planning Application Meeting Remove
Invitees

Planning Application Meeting
Rescheduled

Planning Application Meeting Scheduled

Planning Application Meeting Invitee
Added

Planning Application Meeting Updated

ORACLE

Communication Description

Notifies that the planning application meeting is canceled.

Notifies that the invitee has been removed from the meeting.

Notifies that the planning application meeting is rescheduled on a tentative date.

Notifies that the planning application meeting is scheduled on a tentative date.

Notifies that the invitee has been added to the planning meeting.

Notifies that there is a change in the planning application meeting date.
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Communication Event Name Communication Description
Pre-Application Meeting Canceled Notifies that the preapplication meeting is canceled.

Pre-Application Meeting Remove Invitees = Notifies that the invitee has been removed from the meeting.

Pre-Application Meeting Rescheduled Notifies that the preapplication meeting is rescheduled on a tentative date.
Pre-Application Meeting Scheduled Notifies that the preapplication meeting is scheduled on a tentative date.
Pre-Application Meeting Invitee Added Notifies that the invitee has been added to the preapplication meeting.
Pre-Application Meeting Updated Notifies that there is a change in the preapplication meeting date.

Permit Inspections

The following communication events are provided for permit inspections.

Note: This resource and events are registered with the Business Rules Framework. For more information, see
Business Rules Framework Overview and Setting Up Business Rules for Inspections.

Note: For information about inspection communications that are suppressed when an inspection type is designated
as Unannounced, see Setting Up Inspection Types.

Communication Event Name Communication Description

Before Permit Inspection Saved Before a permit inspection is saved.

Final Permit Inspection Passed Generates a notification when an inspector submits the final inspection for a permit with a passing
result.

For example, when an inspector submits the final inspection for a permit with a passing result, the
permit technician or applicant receives a notification.

For more information about resulting inspections, see Submitting Inspection Results.

Permit Inspection Canceled Generates a notification when the applicant or agency staff cancel an inspection.

For example, when the applicant or agency staff cancel an inspection, the applicant, inspection
contact, inspector, and inspection supervisor can receive a notification.

For more information, see Rescheduling, Postponing, and Canceling Inspections and Managing
Inspections for an Agency.
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Communication Event Name

Permit Inspection Complete

Permit Inspection ETA Updated

Permit Inspection Requested

Permit Inspection Rescheduled

Permit Inspection Postponed

Permit Inspection Scheduled

ORACLE
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Communication Description

Note:
This event is also triggered when the permit associated with an inspection is withdrawn or expires.

Generates a notification when the inspector completes an inspection and submits the inspection
results or when inspections are updated from Scheduled to Completed status.

For example, when the inspector completes any inspection and submits the inspection results, the
applicant or agency staff receive a notification that the inspection is complete, regardless of the
inspection result.

For more information about performing inspections, see Submitting Inspection Results.

Generates a notification when the inspector updates the estimated time of arrival at an inspection site.

For example, when the inspector updates the estimated time of arrival at an inspection site for a
scheduled inspection, the contact at the inspection location receives a notification.

For more information about performing inspections, see Working with Inspection Details.

Generates a notification when an inspection has been requested.

For example, when an inspection request has been created, the permit technician can receive an email
notification.

For more information about requesting inspections, see Requesting and Scheduling Inspections.

Generates a notification when the applicant or agency staff reschedule an inspection.

For example, when the applicant or agency staff reschedule an inspection, the applicant, inspection
contact, inspector, and inspection supervisor can receive a notification.

For more information about rescheduling an inspection, see Managing Inspections for an Agency and

Rescheduling, Postponing, and Canceling Inspections.

Generates a notification when the applicant or agency staff postpone an inspection indefinitely.
Registered public users can only postpone inspections if allowed in the agency-level permit and
business license options.

For example, when the applicant or agency staff postpone an inspection, the applicant, inspection
contact, inspector, and inspection supervisor can receive a notification.

For more information about postponing an inspection, see Rescheduling, Postponing, and Canceling
Inspections.
Generates a notification when an inspection has been scheduled and assigned to an inspector.

For example, when the inspection has been scheduled and assigned to the inspector, the inspector and
inspection contact can receive an email notification.

For more information about assigning an inspection, see Managing Inspections for an Agency and
Requesting and Scheduling Inspections.
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These Reference Entity attributes can be used in the permit inspection events for communications, with the exception
of the Before Permit Inspection Saved event: Reference Entity Name, Reference Entity ID, Reference Entity Location, and
Reference Entity Inspection attributes (Name, ID, and Description).

Payment History Resource

Communication Event Name Communication Description
Payment Received A successful payment triggers a notification configured using an email template.
Refund Notice Enables the agency to trigger a template that generates a successful refund notification.

Permit Document Attachments

Communication Event Name Communication Description

Permit Document Attached Notifies agency staff when a document was uploaded by a contact with permit access for a permit
when plan review or inspection information is not relevant.

Permit Document Attached for Inspector Notifies inspectors that a document was uploaded for a permit inspection.

Permit Document Attached for Plan Notifies plan coordinators that a document was uploaded for a permit plan review cycle.
Coordinator

Permit Document Attached for Plan Notifies plan reviewers that a document was uploaded for a permit plan review cycle.
Reviewers

Permit Document Attached for Inspection = Notifies inspection supervisors that a document was uploaded for a permit inspection.
Supervisor

Planning Application Document Attachments

Note: The Planning Application Document and Planning Application Plan Review Document resources and events
are registered with the Business Rules Framework. For more information, see Business Rules Framework Overview and
Setting Up Business Rules.

Communication Event Name Communication Description

Planning Application Document Attached = Notifies agency staff when the applicant uploads a planning application document.

The Planning Application Document resource contains planning application header data for
communication template setup including these attributes: Assigned Planner and Created By in
the Email, User Name, and User ID attribute groupings. There are no plan review attributes in the
communication template or in the Business Rules Framework criteria.

159
ORACLE


https://www.oracle.com/pls/topic/lookup?ctx=fa26c&id=u30206044
https://www.oracle.com/pls/topic/lookup?ctx=fa26c&id=u30206045

Oracle Public Sector Permitting and Licensing
Implementing Your Agency

Communication Event Name

Planning Application Document Attached
for Plan Reviewers

Planning Missing Document
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Communication Description

Notifies plan coordinators and plan reviewers when the applicant uploads a planning application
document for plan review.

The Planning Application Plan Review Document resource contains planning application plan review
cycle and reviewer data for communication template setup including these attributes: Assigned
Planner and Plan Check Coordinator in the Email, User Name, and User ID attribute groupings; and
Plan Reviewer List in the Email and User ID attribute groupings. The communication template and
Business Rules Framework criteria include plan review cycle attributes.

Planning application step is missing a required document.

Business License Workflow Communications

Communication Event Name

Business License 001

Business License 002

Business License 003

Business License 004

Business License 005

Communication Description

These delivered events are not associated with specific actions in the Public Sector system. Instead,
they are generic events that are delivered for use with workflow. For example, you can use these events
when configuring workflow to send notifications related to permit status changes.

When you set up workflow in the Oracle Integration Cloud, you implement notifications by creating
a workflow event that sends a communication event name, template name, and permit ID to the
Communication Center. The Communication Center then takes care of sending the notification.

See Setting Up Process Definitions for Workflow.

Permits Workflow Communications

Communication Event Name

Workflow 001

Workflow 002

Workflow 003

Workflow 004

Workflow 005

Communication Description

These delivered events are not associated with specific actions in the Public Sector system. Instead,
they are generic events that are delivered for use with workflow. For example, you can use these events
when configuring workflow to send notifications related to permit status changes.

When you set up workflow in the Oracle Integration Cloud, you implement notifications by creating
a workflow event that sends a communication event name, template name, and permit ID to the
Communication Center. The Communication Center then takes care of sending the notification.

See Setting Up Process Definitions for Workflow.

Planning and Zoning Workflow Communications

Communication Event Name

PNZ Workflow 001

PNZ Workflow 002

ORACLE

Communication Description

These delivered events are not associated with specific actions in the Public Sector system. Instead,
they are generic events that are delivered for use with workflow. For example, you can use these events
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Plan Review
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Communication Description

when configuring workflow to send notifications related to planning application status changes to
applicants and owners.

When you set up workflow in the Oracle Integration Cloud, you implement notifications by creating a
workflow event that sends an communication event name, template name, and planning application ID
to the Communication Center. The Communication Center then takes care of sending the notification.

See Setting Up Process Definitions for Workflow.

The following communication events are provided for plan reviews.

Note: This resource and events are registered with the Business Rules Framework. For more information, see
Business Rules Framework Overview and Setting Up Business Rules.

Communication Event Name

Permit Plan Review Finalized

Permit Plan Review Ready To Finalize

Permit Plan Review Completed or
Canceled

Planning Plan Review Finalized

Planning Plan Review Ready to Finalize

Planning Plan Review Completed or
Canceled

Permit Plan Review Cycle Due Date
Scheduled Event

Permit Plan Review Department Due Date
Scheduled Event

ORACLE

Communication Description

Generates a communication when a permit plan review is finalized.

Generates a communication when a permit plan review is ready to be finalized.

Generates a communication when a permit plan review is completed or canceled.

Note:
This event is also triggered when the permit associated with a plan review is withdrawn.

Generates a communication when a planning application plan review is finalized.

Generates a communication when a planning application plan review is ready to be finalized.

Generates a communication when a planning application plan review is completed or canceled.

Note:
This event is also triggered when the planning application associated with a plan review is
withdrawn.

Generates a communication when the plan review cycle due date approaches for a permit.
This communication can be sent to all of the plan reviewers, the person who created the plan review, or

to a manually entered email value.

Generates a communication when the plan reviewer due date approaches for a permit.
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Planning Plan Review Cycle Due Date
Scheduled Event

Planning Plan Review Department Due
Date Scheduled Event

Planning Activity Updated
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Communication Description

Generates a communication when the plan review cycle due date approaches for a planning
preapplication or planning application.

This communication can be sent to all of the plan reviewers, the person who created the plan review, or
to a manually entered email value.

Generates a communication when the plan reviewer due date approaches for a planning preapplication
or planning application.

Indicates that an activity is updated. Must be used within a workflow model.

For more information about plan review communications, see Managing Plan Review Cycles.

Business License

Business license communication events enable agencies to automatically send communication when the business
license status changes. You need to set up Workflow tasks and the communication template to trigger communication
events. The following communication events are provided for business licenses.

Note: This resource and events are registered with the Business Rules Framework. For more information, see
Business Rules Framework Overview and Setting Up Business Rules.

Communication Event Name

After Business License Application
Submitted

Before Business License Issuance

Before Business License Application
Submitted

Business Consultation Meeting Canceled

Business Consultation Meeting Scheduled

Business Consultation Meeting Updated

Business Consultation Meeting Remove
Invitees

Business Consultation Meeting
Rescheduled

ORACLE

Communication Description

After a business license application is submitted.

Before a business license certificate is issued.

Before a business license application is submitted.

Notifies that the consultation meeting is canceled.

Notifies that the consultation meeting is scheduled on a tentative date.

Notifies when there is a change in the meeting subject, agenda, duration, or location.

Notifies that the invitee has been removed from the meeting.

Notifies that the consultation meeting is rescheduled on a tentative date.
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Communication Event Name

Business Consultation Meeting Invitee
Added

Business License Application Canceled

Business License Consultation Application
Withdrawn

Business License Application Canceled

Business License Application Withdrawn

Business License Inactivated

Business License Reactivated

Business License Missing Document

Business License Application and
Consultation Updated

A specialist is assigned for the application

A specialist is reassigned for the
application

Business License Credential Expiration

Expiring Business License by Location

Complete Pending Renewal Application

License Reporting Due

License Reporting Notice
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Communication Description

Notifies that the invitee has been added to the consultation meeting.

Notifies that the Business License application is canceled.

Notifies that the Business License Consultation application is withdrawn.

Applicant receives email or alert notification when a business license is canceled.

Applicant receives email or alert notification when a business license is withdrawn.

Notifies that the business license is inactivated.

Notifies that the Business License is reactivated.

Business License application step is missing a required document.

Initiates actions when a business license or consultation application is updated.

Notifies that the specialist has been assigned to the application.

Notifies that the specialist has been reassigned to the application.

Applicant and application contacts receive a notification that a credential associated with the
business license has expired. This event is associated with a scheduled rule. See Setting Up Credential
Conditions.

Notifies that one or more Business Licenses are about to expire or expire at the location.

Notifies that the pending renewal application should be completed and then submitted.

Indicates that license reporting is due.

Indicates that license reporting is about to be due.

Business License Document Attachments

The following communication events are provided for business license inspections.

Note: This resource and events are registered with the Business Rules Framework. For more information, see
Business Rules Framework Overview and Setting Up Business Rules.

ORACLE
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Communication Event Name

Business License Document Attached

Business License Document Attached for
Inspector

Business License Document Attached for
Inspection Supervisor
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Communication Description

Notifies agency staff when a document was uploaded by a contact with business license access for a
business license activity when inspection information is not relevant.

Notifies business license inspectors that a document was uploaded for a business license inspection.

Notifies business license inspection supervisors that a document was uploaded for a business license
inspection.

Business License Inspections
The following communication events are provided for business license inspections.

Communication Event Name

Business License Final Inspection Passed

Business License Inspection Canceled

Business License Inspection Complete

ORACLE

Note: This resource and events are registered with the Business Rules Framework. For more information, see
Business Rules Framework Overview and Setting Up Business Rules.

Note: For information about inspection communications that are suppressed when an inspection type is designated
as Unannounced, see Setting Up Inspection Types.

Communication Description

Generates a notification when an inspector submits the final inspection for a business license with a
passing result.

For example, when an inspector submits the final inspection for a business license with a passing
result, the agency staff or applicant receives a notification.

For more information, see Performing Inspections on the Inspector Application.

Generates a notification when the applicant or agency staff cancel an inspection.

For example, when the applicant or agency staff cancel an inspection, the applicant, inspection
contact, inspector, and inspection supervisor can receive a notification.

For more information, see Managing Inspections for an Agency and Managing Inspections for a
Business License Application.

Note:
This event is also triggered when the permit associated with an inspection is withdrawn or expires.

Generates a notification when the inspector completes an inspection and submits the inspection
results or when inspections are updated from Scheduled to Completed status.

For example, when the inspector completes any inspection and submits the inspection results, the

applicant or agency staff receive a notification that the inspection is complete, regardless of the
inspection result.
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Communication Event Name

Business License Inspection ETA Updated

Business License Inspection Requested

Business License Inspection Rescheduled

Business License Inspection Postponed

Business License Inspection Scheduled

Before Business License Inspection Saved

Code Enforcement
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Communication Description
For more information, see Submitting Inspection Results.

Generates a notification when the inspector updates the estimated time of arrival at an inspection site.

For example, when the inspector updates the estimated time of arrival at an inspection site for a
scheduled inspection, the contact at the inspection location receives a notification.

For more information, see Performing Inspections on the Inspector Application.

Generates a notification when an inspection has been requested.

For example, when an inspection request has been created, the agency staff can receive an email
notification.

For more information about requesting inspections, see Requesting and Scheduling Inspections.

Generates a notification when the applicant or agency staff reschedule an inspection.

For example, when the applicant or agency staff reschedule an inspection, the applicant, inspection
contact, inspector, and inspection supervisor can receive a notification.

For more information about rescheduling an inspection, see Managing Inspections for an Agency and

Requesting and Scheduling Inspections.

Generates a notification when the applicant or agency staff postpone an inspection indefinitely.
Registered public users can only postpone inspections if allowed in the agency-level permit and
business license options.

For example, when the applicant or agency staff postpone an inspection, the applicant, inspection
contact, inspector, and inspection supervisor can receive a notification.

For more information about postponing an inspection, see Modifying Inspection Requests.

Generates a notification when an inspection has been scheduled and assigned to an inspector.

For example, when the inspection has been scheduled and assigned to the inspector, the inspector and
inspection contact can receive an email notification.

For more information about assigning an inspection, see Managing Inspections for an Agency and
Assigning Inspections.

Before a business license inspection is saved.

The following communication events are provided for code enforcement.

Note: This resource and events are registered with the Business Rules Framework. For more information, see
Business Rules Framework Overview and Setting Up Business Rules.

ORACLE
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Communication Event Name Communication Description
Incident Location Updated The location of the incident is updated.
Incident Assigned to Officer The incident is assigned to an officer.
Incident Priority Updated The priority of the incident is updated.
Incident Status Updated The status of the incident is updated.
Incident Assigned to Technician The incident is assigned to a technician.
Case Created The case is created.
Case Location Updated The location of the case is updated.
Case Status Updated The status of the case is updated.
Code Enforcement Case Document Applicant attached a code enforcement case document.
Attached
Code Enforcement Case Fee Due Date Schedule rule event based on a code enforcement case fee due date.

Scheduled Event
Code Enforcement Violation Scheduled rule event based on code enforcement violation.

Responsible Party's Case Access Updated = Responsible party's access to case is approved or denied.

User Profile Notifications

The User Profile Notifications resource provides the following communication events.

Communication Event Name Communication Description

Welcome Business Profile Sends a welcome notification and instructions to a permit application who creates a new business
profile.

Welcome Personal Profile Sends a welcome notification and instructions to a permit applicant who creates a new personal profile.

User Account Information Changed Notifies a public user when the user's account is updated by agency personnel.

User Profile Information Changed Notifies a public user when the user's account profile is updated by agency personnel.
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Setting Up Communication Templates

Communication events trigger delivery of different communication types to various users. The agency defines the
content, format, and recipients using communication templates.

Agency users add, modify, and delete communication templates on the Communication Event Details page.

The communication events themselves are delivered with Oracle Permitting and Licensing. For a partial list of the
available communication events, see Delivered Communication Events.

Adding Communication Templates

PUWNA

Select Communication Setup > Communication Events in the navigator.

Click the event on the Communication Event page for which you want to add a template.

On the Communication Event Details page, click Add in the Communication Template section.

On the Communication Template Details page, enter a unique identifier code and name for the communication
template.

To make the code unique, Oracle recommends that you create it using a portion of the communication event
name. For example, you might use SUBOT for the email template of the Application Submit communication
event. This is because communication template codes must be unique across all communication events. If you
create a communication template for one event that has the same code as a template for another event, you
will receive an error when you try to save it.

Enter values or click Insert (+) and choose from the list to set up the template:

Page Element Description

Channel Type Specify the type of communication that this template generates. Values are:

o Alert: Generates text that is displayed to users when they log in to the application.

Note:
You only use this channel type when setting up the General Alert (PSC_GENERIC_ALERT)
communication event.

o Email: Generates an email that is sent to users.

o Emails and Notifications: Generates both an email and a notification with the same
message.

o Notification: Generates a notification that appears when users click the notification icon in
the application.

o Text: Generates a short message service (SMS) text message that is sent to users.
Currently, the text channel type is available only for ad hoc communications. Text for
events will be supported in the future.

Note:
The fields that are available to define on this page vary depending on the channel type and
display format that you select.
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Page Element

Visibility

Enabled

Start Date Time and End Date Time

Display Format

Add Attribute

Add Grid

Attachments
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Description

Select which users can see this communication listed on the application's Communication
Details page. All communications can be accessed by agency staff. Values are:

o Applicant and contacts: Includes agency staff, the applicant, and contacts added to the
transaction.

o Agency staff only: Includes only agency staff.

o Applicant: Includes agency staff and the applicant on the transaction.

Turn this switch on to activate the communication template. When this switch is turned off, the
application does not generate the communication when the associated event is triggered.

Enter the time period for which the alert is displayed. These fields appear only for the Alert
channel type.

Select the format of the email or notification that this communication template generates.
Values are:

o HTML: Displays rich text, links, and images
o Text: Displays plain, unformatted text.

This field appears only for the email or notification channel types.

These fields enable you to insert variables for attributes into your communications. You select
the field and the attribute that you want to insert in that field, and click Insert to enter a variable
for that attribute.

For more information about inserting variables for attributes, including resource and contact
attributes, see Using Attributes in Communication Templates.

Add a grid with attributes from a related resource in the message body.

This button appears only for the email and notification channel types, and the display format
must be HTML.

For more information, see Using Attributes in Communication Templates.

Click + to add an attachment from your local device. After adding an attachment, you can click
the Actions icon to view attachment details, download attachments, or delete attachments.

Note:

o The maximum number of attachments in a single email is 5.

o The maximum total size of an email, including all attachments, can't be more than 10 MB.
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Page Element

To

Cc and Bcc

From

Subject
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Description

o If the total attachment size exceeds this value, the email will not be sent to the recipients
even though it is saved in OPAL communications.

If the communication has a report attached that has been generated dynamically by a
business rule in the Business Rules Framework, when adding the attachment, select the output
repository where the generated report resides. For more information, see Setting Up Generate
Report Actions.

Click the Insert button to view a drop-down menu from which you can search for and select
recipients. The display shows the options and the count of values available, which are
determined by the transaction you are working with and the channel type you selected in the
Template Attributes section.

For example, when you select a value here for the email channel type, the email ID is inserted
into the field. You can delete the ID using the X icon, but you cannot edit it.

Enter or click + and select the email addresses, user IDs, or phone numbers of the people or
organizations that you want to send the communication to.

Enter email addresses for the Email and Emails and Notifications channel types; user IDs for
the Alert, Emails and Notifications, and Notification channel types; and phone numbers for the
Text channel type.

For web form response events, include the ${Webform Reply-To} attribute in the To address. For
more information about configuring web form responses, see Setting Up Agency-Level Email.

Enter or click + and select the email addresses of the people or organizations that you want to
receive a copy or blind copy of the communication.

These fields appear only for the Email and Emails and Notifications channel types.

Enter or click + and select the sender address of the person or organization who is sending the
generated message.

The Agency sender address used here is configured in the Agency setup. For more information,
see Setting Up Agency-Level Email.

For texts, select the phone number of the person or organization who is sending the generated
text message from the drop-down list. The numbers are retrieved from Twilio, a third-party
messaging service.

Note: During setup data migration, the sender email address used in Communication
Templates is checked against the agency’s configured email settings. If the email address is
not valid or does not match the configuration, the system displays an error.

Enter a brief description of the purpose and content of the communication, or click + and select
from the list of transaction attributes.
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Page Element Description

This field appears only for email or notification channel types.

Note: When configuring a business license communication, agency users can select the
Business URL attribute that provides a link to open the associated business entity Overview
page. The Business URL option is available under Transaction attributes of the Subject.

Message Body Enter the main body text of the communication.

® For the Alerts and Text channel types and emails and notifications using the Text display
format, you can enter only plain, unformatted text.

For emails and notifications using the HTML display format, you can enter rich text, links, and
images, or click + and select from the list of transaction attributes.

Note:

o When you enter a website address as a text or an image link, the system verifies if it
is present in the safe domains list. If not, add it as a safe domain. Only links of safe
domains can be included in the rich text editor. See Setting Up Safe Domains.

o When configuring a business license communication, agency users can select the
Business URL attribute that provides a link to open the associated business entity
Overview page. The Business URL option is available under Transaction attributes of the
Message Body.

Remarks Enter any additional information about the communication template. These remarks are not
included in the generated communication.

6. Click Save.

Considering Contact Attribute Source for Multi-Form Intake Applications

When setting up communications to contacts added to a single intake form containing multiple application types,
such as business license types, it is recommended to consider the source of the contact information and configure you
communication templates accordingly.

Note: Configuring single intake forms to contain multiple application types is supported only for Business Licenses
currently.

When selecting the To attribute in the Email Attributes section of a communication template, you can select the
Contact email or Transaction attributes as sources for contact information to which notifications can be sent. In the
case of a single intake form containing multiple business license types, the information from the General Information
Contacts field group doesn't get stored in the system until the intake form is successfully submitted. So, for a pending
application, the attributes selected under the Contact email option can't be sent notifications. However, the contact
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attributes selected from the Transaction attributes option will exist in the case of a pending application. For example,
if your agency wants to send a notification of a pending application about to expire to the applicant, select Transaction
attributes, Applicant 1email.

Modifying Communication Templates

Select Communication Setup > Communication Events.

Click the row on the Communication Event page for which you want to modify a template.
Click the row in the Communication Template grid that you want to modify.

On the Communication Template Details page you can:

P UWNa

o Click Clone to create a copy of the communication template.

o Update the communication template field values.

I Note: You cannot edit the Code or Channel Type fields.

5. C(lick Save.

Deleting Communication Templates

Select Communication Setup > Communication Events.

Click the row on the Communication Event page for which you want to delete templates.
Click Edit in the Communication Template grid.

Select the checkboxes next to all the communication templates that you want to delete.
Click Delete. You will be prompted to confirm the permanent deletion.

A UWN

Using Attributes in Communication Templates

You can add attributes to your communication templates when defining the recipients and content.

You insert attributes into your communication templates on the Communication Event Details page, which you access
by selecting an event from the list on the Communication Event page. You can select from attributes in the resource for
the event you're working with, contact type attributes, and additional attributes available from other resources.

Note: Contact type attributes are not available for ad hoc emails, notifications, and texts in the Communication
Center because the communication must be associated with a transaction to populate contacts. Parent resource
attributes from an event are also not available in the ad hoc communications template in the Communication Center.

The endpoint attributes of communication service REST APIs correspond to the variables you use to set up a
communication template.

Adding Predefined Variables for Attributes

When you create a template, you can insert variables for attributes into the message fields. Predefined variables for
attributes are available to use for communications associated with any event. For example, using the contact types in
the communication template, you can send communication to the contacts listed on the application.
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You insert attributes listed under Resource attributes to retrieve values you find in fields on applications that are
referenced in the parent resource. Contact type attributes are especially designed to gather contact information from
applications referenced in the resource of the selected event.

1. On the Communications Event Details page, go to the Add Attributes fields.
2. Select the field and the attribute that you want to add to the field.
3. Click Insert.

For example, if you select Body and the Permit ID attribute, and click Insert, the ${Permit ID} variable is inserted into
the Message Body field of the communication template. When the application generates a communication using the
template with the variable attribute, the permit ID that is associated with the triggered communication event is inserted
into the body text.

Here’s an example of a letter template and the output:

Example Expressions with Variable Output
Attributes

Dear ${Payer First Name} ${Payer Last Dear John Smith,
Name},

Thank you for your payment of $835.00 for permit REM-2017-000035, which was received on 15-
Thank you for your payment of AUG-2017.
${CommunicationUtils.format('amount’,
${Payment Amount},'9,999,999.99")} for
permit ${Permit Id}, which was received If you have any questions please contact the office between 9:00 a.m. and 4:30 p.m., Monday through
on ${CommunicationUtils.format('date’, Friday.
${Payment Date})}.

If you have any questions please contact
the office between 9:00 a.m. and 4:30
p.m., Monday through Friday.

The communication engine supports the following predefined functions for variable attributes in your templates.

Function Description Variable Attribute Output

Current Date Returns the system date in the ${Current Date} For example, 2016-04-25.
agency time zone without the time.
There is no need to use the format
utility.

Note:

The Current Date is internally
formatted using the
formatDate() function based on
the agency time zone. Using an
additional formatDate() function
causes an error.

Current Date Time Returns the system date in the ${Current Date Time} For example, 2016-04-25
agency time zone with the time. 23:44:52.0.
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Function Description
There is no need to use the format
utility.

Note:

The Current Date Time is
internally formatted using the
formatDate() function based on
the agency time zone. Using an
additional formatDate() function
causes an error.

Format Number Formats the number to the given
format. The formats supported are

Java Number Formats.

Formats the date and time in the
agency time zone with the given
format. The supported formats use
Java Simple Date Format.

Format Date and Time

Formats the amount into the
default local currency format.

Format Amount

ORACLE

Variable Attribute

${CommunicationUtils.format('num
${Fees Total Amount},'### ###,
###')}

To support backward compatibility,
the following format is currently
available:

${CommunicationUtils.formatNumt
'9,999,999"}

Example 1:
${CommunicationUtils.format('datet
${Creation Date},'yyyy-MM-dd
HH:mm:ss')}

Example 2:
${CommunicationUtils.format('datet
${Creation Date})}

Example 3:
${CommunicationUtils.format('date'
${Creation Date},'yyyy-MM-dd")}

To support backward compatibility,
the following formats are currently
available:

Example 4:

${CommunicationUtils.formatDate($
Date},'yyyy-MM-dd HH:mm:ss')}

Example 5:

${CommunicationUtils.formatDate($
Date})}

Example 1:
${CommunicationUtils.format('amol
${Fees Total Amount})}

Example
2: ${CommunicationUtils.format(‘arr
${Fees Total Amount},'en_US")}

Chapter 11
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Output

For example, 46,064.

Example 1 output: 2019-11-22
20:04:00.

Example 2 output: 11/22/19 8:04
PM.

Example 3 output: 2019-11-22

Example 4 output: 2019-11-22
20:04:00

Example 5 output: 11/22/19

All the examples produce the
output: $1,345,667.00
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Function Description

Link Provides the hyperlink from the
message.

Add Grid Inserts a table in the message body

Formatting the Landing Page
in the Account Established
communication event

Creates a user-friendly URL for the
agency landing page.

ORACLE

Variable Attribute

To support backward compatibility,
the following format is currently
available:

Example 3:

${CommunicationUtils.formatAmou

Input is expected to be the link
URL and the label that you want to
display:

${CommunicationUtils.format('url’,

${URL},${Label})}

${CommunicationUtils.format('url’,
${URL},'Setting Up Communication
Events’)}

To support backward compatibility,
the following format is currently
available:

${CommunicationUtils.setLink(${Ur]
${Label})}

This applies to specific
communication templates where
the Add Grid functionality is
enabled.

${CommunicationUtils.format('grid’,
'publicSectorFeeDues',

'Assessed Date, Currency
Code','${AssessedDate},
${FeeCurrencyCode}')}

To support backward compatibility,
the following format is currently
available:

${CommunicationUtils.insertGrid('p!
'Assessed Date, Currency
Code','${AssessedDate},
${FeeCurrencyCode}')}

Attribute display using a simple
format option:

${CommunicationUtils.format("base
${Permitting and Licensing
Landing Page})}

Attribute display using the format
and click here text option:

${CommunicationUtils.format("base
${Permitting and Licensing
Landing Page},"Click here")}

Chapter 11
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Output

The examples produce the output:
Setting Up Communication
Templates.

Inserts a table inside the
communication message.

The examples produce the output.
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Guidelines for Using Formatting Functions

When you are creating or updating communication templates, follow these guidelines to review and edit the usage of
the formatting functions such as setLink(), formatAmount(), formatDate(), and insertGrid() in the message:

- Creating New Template: You must use only format() functions as defined in the above table.

- Updating Existing Template: Currently, the system supports single references to these formatting functions
for a given communication. The communication will not be triggered if there are multiple usages of these
formatting functions within the communication definition. So, to avoid any errors in the communication
delivery, you must update the templates to ensure the usage of only format() functions.

- Nesting format() functions: Currently not supported.

- Format() to display grid: This is a special format function that handles the date and amount attribute formatting
as per agency setup options. So, there is no additional format() allowed for grid attributes.

« Using the $ symbol in message: To include a ‘¢’ character into the message text, you prefix the ‘¢’ with the
character “\’ (backslash key). This enables the communication processor to read the ‘$’ character as a string,
and not as an attribute.

Using Contact Type Attributes

After your agency sets up contact types, you can insert variables for contact type attributes when composing
communications for contacts by type, as well as for primary contacts or all contacts. For example, you might set up the
system to send contractors a copy of the email sent when a permit or planning application is withdrawn. In this case,
you would create a template for a withdrawn event with an Email or Emails and Notifications channel type, and insert
the email variable for the Contractor contact type attribute in the email Cc field. You can insert variables for contact
attributes into the address fields as well as the subject line and message body.

Here are the available contact type attributes and examples of the variables:

- Email: Inserts a variable for the email address of contacts with the specified contact type. Select this attribute to
send emails. This example shows the variable for email addresses of all contacts:
${CommunicationUtils.format('contact', 'publicSectorApplicationContactTypes', 'AllContacts', '${ContactEmailAddress
- Phone: Inserts a variable for the phone number of contacts with the specified contact type. Select this attribute
to send texts. This example shows the variable for phone numbers of primary contacts:
${CommunicationUtils.format('contact', 'publicSectorApplicationContactTypes', 'Primary
Contact', '${ContactPhoneNumber}')},
- User ID: Inserts a variable for the user ID of contacts with the specified contact type. Select this attribute to
send notifications. This example shows the variable for user IDs of contractors:
${CommunicationUtils.format ('contact', 'publicSectorApplicationContactTypes', 'Contractor','${ContactUserId}')},

- User Name: Inserts a variable for the name of contacts with the specified contact type. You can select this
attribute to insert the user's name in the message body to personalize the communication, such as "Dear
Linda." This example shows the variable for user names of business owners:

${CommunicationUtils.format ('contact', 'publicSectorApplicationContactTypes', 'Business
Owner','${ContactUserName}')},

For information about setting up contact types, see Setting Up Contact Types.
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Inserting Additional Attributes in Templates

Some attributes are available across resources for you to use when creating templates. You can insert a grid in the
message body that contains the additional attributes. This option is available only for events in the Permits Workflow
Communication resource. Formatting is not supported for related resource attributes.

The data for the attributes are displayed in the generated communication as a table. To add the grid to your template:

1. Select Communication Setup > Communication Events in the Navigator.
On the Communication Event page, select an event in the Permits Workflow Communication resource for which
you want to add a template.

3. Click Add in the Communication Template grid on the Communication Event Details page.

4. Set up the communication properties as described in Setting Up Communication Templates.
You must use the Emails, Emails and Notifications, or Notification channel type, and the MIME type must be
HTML to render the grid in the generated communication.

5. Click Add Grid. Add Grid is only available for certain communications events.
Use the Sequence Number, Sort By, and URL Display Name to order the attributes in the grid. You can sort
Ascending or Descending for only one attribute.
If the Attribute Name is a URL, you can create a URL Display Label for it which will create a clickable link.

6. On the Define Grid Attributes page, select up to 5 attributes that you want to appear in the generated table. The
attribute source name appears on the page.

7. Click Insert Grid in Message.

For example, if you select the Fee Description, Fee Item, and Fee Record attributes, and click Insert Grid in Message, the
following is inserted into the Message Body field of the communication template:

${CommunicationUtils.format('grid', 'publicSectorFeeDues', 'Fee Description,Fee Item, Fee
Record', '${Feedescription},${Feeltemld}, ${FeeRecordKey}')}

Each attribute name is displayed in the generated email or notification as a column title, and record values populate
each row. If you want to change the order of the columns, you can manually move the attributes around in the template.

Setting Up Fee Notices

Agencies can set up fee notices for permit and planning applications containing a combined list of fees due to be sent
on a regular basis.

The automated process sends notices with fees for an application consolidated into a list in each notification. Every time
a fee with a Due status is added or recalculated, the application is identified as updated in the system. The notice with
combined fees is sent out to the designated recipient on the schedule you define.

Fees are added to the notice for an application based on the date when:
- A fee with a Due status is added or changed.
- The fee status is changed to Due.
- The amount of a fee with a Due status is recalculated or changed.

You'll need a communication template with a fees grid for the notice, scheduled rules setup in the Business Rules
Framework, and processing instructions for communication frequency.
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Create a Communication Template

You set up a communication template specifically for the consolidated fees notice using designated communication
events and variables for fee attributes:

1. On the Communication Event page, select the Scheduled Rule: Updated Permit Fees Due or Scheduled Rule:
Updated Planning Application Fees Due communication event to create the template.

For more information, see Setting Up Communication Templates.

2. Inthe message body, insert variables for fee attributes in a grid format. Click Add Grid and select the fee due
attributes, such as Fee Item, Assessed Date, and Amount.

For more information, see "Inserting Additional Attributes in Templates" in Using Attributes in Communication
Templates.

Set Up a Scheduled Rule

You configure a scheduled rule in the Business Rules Framework that identifies the permit or planning application for
which the fee is updated and specifies the communication template to use. For more information about setting up
scheduled rules, see Setting Up Scheduled Rules.

After you create a communication template, set up the rule:

1. Select the Scheduled Rules tile in the Business Rules Framework and select a business objects, Permits
Workflow Communications or Planning and Zoning Workflow Communications.

2. Add the following criteria in the Criteria section of the rule to identify the permit or planning application for
which the fee is updated in the defined time frame:

o Fees Balance Due > O (includes only due fees) or

Fees Outstanding Balance > O (includes both due and pending fees)
o Fees Due Updated Date = ${Current Date} (for daily notices) or

Fees Due Updated Date > ${Current Date} - 7 (for weekly notices)

Note: You must enter both criteria to avoid notices sent whether fees are updated or not.

For more information, see Setting Up Business Rule Criteria.

3. Inthe Action section of the rule, select Send Communication and configure the action to use the template you
already created. For more information, see Setting Up Send Communication Actions.

Set Up a Scheduled Process

The Process Monitor uses the scheduled rule set up in the Business Rules Framework to initiate batch processing on a
regular basis. The process checks for any change in fee items with a status of Due for a permit or planning application
and sends the communications on the schedule you define here.

After you configure the communication template and rule, set up processing instructions for the rule:

1. To schedule the rule directly in the Process Monitor from the Business Rules Framework, click the Schedule
Rules link on the Scheduled Rule Details page. You can also use the Process Monitor link to set up a new
Schedule Rules process or see all of the scheduled and running processes.
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2. Enter values on the Schedule Rules page:

Tab Values
Parameters Select the scheduled rule that you set up in Business Rules Framework.
Schedule Run: Using a schedule

Frequency for daily notices: Daily and Every 1 Day
Frequency for weekly notices: Weekly and Every 1 Week

Start and End Date: Enter agency-determined values

Notification Not applicable

3. Click Submit.

For more information about using the Process Monitor, see Using the Process Monitor.

Setting Up Notifications for Plan Review Due Dates

You can set up communications to notify reviewers and plan coordinators about plan review cycle or department due
dates. Your emails and notifications for planning applications can also include the assigned planner.

Configure a communication template and scheduled rule to send either an in-app notification or email, on or before
the plan review due date. You can also configure the rule to schedule communications after the due date for overdue
reviews. The Business Rules Framework uses scheduled rules based on the plan review cycle due date and reviewer due
dates to determine when a communication is sent.

For information about other plan review communication events, such as when a plan review is finalized, completed, or
canceled, see Delivered Communication Events.

Communication Templates for Due Dates

Communication events work in conjunction with the scheduled rule in the Business Rules Framework to send the
notifications. Before you configure the scheduled rule, set up the communication templates for the delivered plan
review due date events.

Communication Event Description

Permit Plan Review Cycle Due Date Generates a communication when the plan review cycle due date approaches for a permit.

Scheduled Event
This communication can be sent to all of the plan reviewers, the person who created the plan review, or
a manually entered email value.
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Communication Event

Permit Plan Review Department Due Date
Scheduled Event

Planning Plan Review Cycle Due Date
Scheduled Event

Planning Plan Review Department Due
Date Scheduled Event

Chapter 11
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Description

Generates a communication when the plan reviewer due date approaches for a permit.

This communication can be sent to all of the plan reviewers, the person who created the plan review, or
a manually entered email value.

Generates a communication when the plan review cycle due date approaches for a planning
preapplication or planning application.

This communication can be sent to all of the plan reviewers, the person who created the plan review,
the assigned planner, or a manually entered email value.

Generates a communication when the plan reviewer due date approaches for a planning preapplication

or planning application.

This communication can be sent to all of the plan reviewers, the person who created the plan review,
the assigned planner, or a manually entered email value.

For sending notifications based on plan review cycle due dates, refer to the template attributes for plan check

coordinators and reviewers here:

Template Attribute Name

Assigned Planner Email

Assigned Planner Name

Assigned Planner User ID

Plan Check Coordinator Email

Plan Check Coordinator Name

Plan Check Coordinator User ID

Plan Reviewer Email List

Plan Reviewer User ID List

Field

The assigned planner email. Only available for the planning plan review event.

The assigned planner name. Only available for the planning plan review event.

The assigned planner user ID. Only available for the planning plan review event.

The Created By email.

The Created By name.

The Created By user ID.

The email list of all assigned reviewers.

The user ID list of all assigned reviewers.

For sending notifications based on reviewer departmental due dates, refer to the template attributes for plan check

coordinators and reviewers here:

Template Attribute Name

Assigned Planner Email

ORACLE

Field

The assigned planner email. Only available for the planning plan review event.
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Template Attribute Name Field
Assigned Planner Name The assigned planner name. Only available for the planning plan review event.
Assigned Planner User ID The assigned planner user ID. Only available for the planning plan review event.
Plan Check Coordinator Email The Created By email.
Plan Check Coordinator Name The Created By name.
Plan Check Coordinator User ID The Created By user ID.
Plan Reviewer Email The email of the reviewer on the department row.
Plan Reviewer Name The name of the reviewer on the department row.
Plan Reviewer User ID The user ID of the reviewer on the department row.

For more detailed information about configuring templates, see Setting Up Communication Templates.

Scheduled Rules

After creating templates, add new scheduled rules in the Business Rules Framework for the business objects that are
used to send plan review due date communications.

1. Select a business object:

o Permit Plan Review Cycle Due Date
o Permit Plan Reviewer Due Date
o Planning Application Plan Review Cycle Due Date
o Planning Application Plan Reviewer Due Date
2. Enter criteria.

Configure scheduled rules for each business object to include criteria for sending a notification. For example,
you can enter these criteria for a reviewer due date rule:

Criteria Sequence Field Operator Value Description
1 Plan Reviewer Due Date Equals ${Current Date}+4 The due date is within
four days of the current
date.
2 Plan Reviewer Review Equals In Progress The review is in progress.
Status
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Criteria Sequence Field Operator Value Description

To send the communication on the day the plan review is due, enter this value in row 1: ${Current Date}.
3. Configure the action.

Select the Send Communication action and the communication template that corresponds to the business
object.

4. Schedule the scheduled rule.

Select the rule name in the Parameters tab. On the Schedule tab, select As soon as possible in the Run field to
send the notification once. To send the notification on a regular basis, select Using a schedule in the Run field
and provide a frequency and start date.

For more information about setting up scheduled rules, see Setting Up Scheduled Rules
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12 Setting Up Analytics

Setting Up Reports

The report parameters that you define filter the data that is generated for the reports. You can use delivered or provide
customized reports.

For reports initiated from within Oracle Permitting and Licensing, you add and modify report IDs and configuration
details, which includes adding, modifying, and deleting report parameters, on the Report Configuration Details page.

For a list of delivered reports, their descriptions, and where you can find them, see Permitting and Licensing Analytics.

You can also create your own reports in Oracle Bl Publisher and allow users to access them through the available report
generation buttons. For example, users with appropriate permissions can click the Print button on some application
pages, such as the Print Deposit Slip page or the Inspection Detail page in the permit application details.

For more information on modifying and creating analytics and reports, see the Oracle Applications Cloud
documentation: Creating and Administering Analytics and Reports.

Adding Report Configuration Details

You can add a report in addition to the delivered reports.

Select the Setup and Maintenance tile on the Agency Springboard to access Functional Setup Manager.

From the Setup drop-down list, select your offering.

Select Analytics and Reporting from Functional Areas and then select the Manage Report Configurations task.
On the Report Configuration page, click Add.

Enter values for the following fields:

vihOUN

Page Elements Definition

Report ID and Description Enter an identifier and description of the report.

Path Enter a path to the desired report. For example, the path for the Inspection Summary
report in the Oracle Business Intelligence (BI) Catalog is /shared/Public Sector/Inspections/
InspectionSummary.xdo.

Output Format Select PDF or RTF to indicate the format of the generated report.

Report Category Select a product area to classify the report.

Available for Rules Framework Action Turn on if you want your report to be available to be generated based on a Business Rules
Framework rule.
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Page Elements Definition

For more information on generating reports using the Business Rules Framework, see Setting
Up Generate Report Actions

6. Click Save.

Updating Report Configuration Details

1. On the Report Configuration page, select the row for the report you want to modify.
2. On the Report Configuration Details page, you can:

o Update the description.

o Enter the Bl Catalog path for the report. For example, the path for the Inspection Summary report is /
shared/Public Sector/Inspections/InspectionSummary.xdo.

If you create your own report, you can point the existing report generation buttons on the application
pages to your custom report using this path.
o Select the output format, such as HTML, PDF, or RTF.

o Select the report category, such as Incident, Planning Application, and so on.

o Turn on Available for Rules Framework Action if you want your report to be available for being
generated based on a Business Rules Framework rule.

3. Click Save.

Adding Report Parameters

1. On the Report Configuration page, select the row for the report for which you want to add a parameter.
2. On the Report Configuration Details page, click Add in the Parameters grid.
3. Enter values for the following fields:

Page Elements Definition
Parameter ID and Parameter Name Enter a unique ID and name for the report parameter.
Parameter Data Type Enter the data type for the report parameter.

4. C(lick Save.

Modifying or Deleting Report Parameters

1. On the Report Configuration page, select the row for the report you want to modify.
2. On the Report Configuration Details page click the row in the Parameters grid that you want to modify.
3. On the Parameter Details page, you can:

o Update the report parameter field values.

o Delete the report parameter. You will be prompted to confirm the permanent deletion.
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4. Click Save.

Setting Up Dashboards

You add, modify, and delete dashboard configurations on the Dashboard Configurations page.

Dashboards are a collection of analyses grouped together to present data. A dashboard contains analyses and prompts
which filter information and other objects to present on one or more pages.

Dashboard Configuration enables you to configure existing out-of-the-box OTBI dashboards or custom dashboards
created by the agency. They are available in both Reports and Analytics and the Permitting and Licensing Dashboards
work areas.

For alist of delivered dashboards and their descriptions, see Permitting and Licensing Analytics.

Adding a Dashboard Configuration

1. Inthe Functional Setup Manager, select Setup: Public Sector <Offering> > Functional Area: Analytics and
Reporting > Task: Manage Dashboard Configuration.

2. Onthe Dashboard Configuration page, click Add.

3. Onthe New dashboard configuration drawer, enter values for the following fields:

Page Element Description

Dashboard ID Enter a unique name for the dashboard.

Description Enter a description of the dashboard

Path Enter the Oracle Business Intelligence (Bl) Catalog portal path for the dashboard. For example,

the portal path for the Permits dashboard is $2Fshared%2FPublic%20Sector%2F_portal
%$2FPublic%20Sector&page=Permits.

Sort Order Enter a unique integer in increasing order of value. This information is used to display the
configured dashboards in ascending order under the Reports and Analytics button.

Enabled Turn on this switch to activate this dashboard.

4. Click Save.

Modifying or Deleting a Dashboard Configuration

1. On the Dashboard Configuration page, select the configuration that you want to modify.
2. On the Dashboard configuration details drawer, you can:

o Update the dashboard configuration field values.
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Note: You can't edit the Dashboard ID.

o Delete the dashboard configuration. You will be prompted to confirm the permanent deletion.
3. Click Save.

Creating and Editing Dashboards

If you are an advanced user and administrator who wants to modify and create analytics and reports, and perform
generic setup and maintenance tasks for business intelligence that apply to some or all product families, see Oracle
Applications Cloud documentation: "Analyses, Reports, and Dashboards Modification" in Creating and Administering
Analytics and Reports.

Viewing Dashboards

Select Permitting and Licensing Dashboards on the Permitting and Licensing home page to open the agency's View
Dashboard page. Select a dashboard from the drop-down list.

This example illustrates the View Dashboard page for the Permits Dashboard.

186
ORACLE


https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FAACC
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FAACC

Oracle Public Sector Permitting and Licensing Chapter 12
Implementing Your Agency Setting Up Analytics

View Dashboard

Select a dashboard
Permit Dashboard

Permits Inspections  Plan Review  Parcels & 0

Year Quarter Permit Type Status

2026 - --Select Value- v (All Column Value: v -Select Value--  w

Permits
96.0 $34.2K 2. 7TM 0.0

Totals by Permit Status

Permit Count Job Cost Fee Amount E

Listing of Prebuilt Analytics

This reference points to the list of prebuilt analytics for Oracle Permitting and Licensing.
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Your Permitting and Licensing applications come with a variety of prebuilt analytics for your users. Use the prebuilt
analytics right out of the box, or make a copy and modify them however you like. See the Related Topics for a link to the
analytics listing in downloadable format.

Related Topics
» Oracle Permitting and Licensing Reports and Analyses

Permitting and Licensing Analytics

Analyze your agency and key performance indicators with analytics, reports, and interactive dashboards, which you can
access through transactional pages, the Reports and Analytics workarea, or the business intelligence (BI) catalog.

You can find information about the Bl reports and dashboards for Oracle Permitting and Licensing here.
For a complete list of delivered analytics, see the Listing of Prebuilt Analytics.

There are different ways to view and work with your analytics and reports. You view analytics, dashboards, and reports
in the course of your work on your usual pages. You can also find them on the Reports and Analytics workarea page
or in the Bl catalog. Click the Browse Catalog button to access reports and dashboards in the catalog. For information
about using the Reports and Analytics workarea, see Generating Reports.

For information about hiding access from registered public users, see the security topics for implementation in My
Oracle Support (Doc ID 2730290.1).

This table lists the delivered reports for Oracle Permitting and Licensing and where you can find them.

Report Name Description Location

Building Permit Displays permit-related information. - Overview page of the permit record details

See Viewing the Permit Overview.

Reports and Analytics or Bl Catalog:
Shared Folders > Public Sector > Permits

Business License Certificate Displays the generated business license - Overview page of the issued business
certificate. license

See Viewing the Business License.

Reports and Analytics or Bl Catalog:
Shared Folders > Public Sector >
Business License

Case Timeline Displays all the Code Enforcement events - Timeline page
associated with a particular case in a
chronological order. See Working with Case Timeline.

Reports and Analytics or Bl Catalog:
Shared Folders > Public Sector > Code
Enforcement > Cases)
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Report Name

Cashier Session Reconciliation

Citation Notice

Conditions of Approval

Deposit Slip

Health Metrics Report

Hearing Agenda Report

Hearing Notification Report

ORACLE

Description

Provides details about cashier session
reconciliation activity.

Displays information about the code violation
along with following details:

- Corrective actions
- Compliance date
- Appeal by date

- Citation fees

- Citation fees payment due date.

This report is sent to the party responsible for
the reported violation.

Displays the conditions of approval associated
with a planning application, including a
description of the work, the assigned planner,
and the conditions of approval.

Lists deposit information.

Health metric based insight into Permits,
Planning Applications and Business License
transactions based on their backlog, in
progress, duration and closure trends.

Displays the hearing agenda for the decision
making body.

Displays all hearing-related activities for a
planning application, such as the owner and
application addresses, hearing body name,
hearing schedule and hearing appeal details.

Chapter 12
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Location

- Reconcile Cashier Session page

See Reconciling Cashier Sessions.

« Reports and Analytics or Bl Catalog:
Shared Folders > Public Sector > Billing
and Payments

- Notice of Citation page

See Using the Code Technician WorKklist.

- Citations page

See Working with Citations.

« Reports and Analytics or Bl Catalog:
Shared Folders > Public Sector > Code
Enforcement > Notices)

- Conditions of Approval page

See Working with Conditions of Approval.

« Reports and Analytics or Bl Catalog:
Shared Folders > Public Sector >
Planning Application

«  Print Deposit Slip page

See Printing Deposit Slips.

- Reports and Analytics or Bl Catalog:
Shared Folders > Public Sector > Billing
and Payments

Shared Folders > Public Sector > Permits

- Hearing Scheduler page

See Working with Public Hearings.

- Reports and Analytics or Bl Catalog for the
Planning report: Shared Folders > Public
Sector > Planning Application

- Reports and Analytics or Bl Catalog
for the Code Enforcement report:
Shared Folders > Public Sector > Code
Enforcement > Cases

Reports and Analytics or Bl Catalog: Shared
Folders > Public Sector > Planning
Application
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Report Name

Inspection Activity

Inspection Job Card

Inspection Summary

Payment Invoice

Payment Receipt

Permit Activity

Permit Valuation and Revenue

Planning Application

ORACLE

Description

Displays all inspection activity for an agency
over a specified date range.

Displays a record of inspections made by the
inspector, who will make notes on it and sign it
during each visit to your job site.

Displays inspection-related information for the
permit or business license application.

Displays invoice information.

Lists payment receipt information.

Displays permit summary information for an
agency over a specified date range.

Displays permit information including valuation
and fees.

Displays planning activity over a specified
date range. You select which applications are
included the report. You can generate the
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Location

Reports and Analytics or Bl Catalog: Shared
Folders > Public Sector > Inspections

Reports and Analytics or Bl Catalog: Shared
Folders > Public Sector > Permits

- Inspection overview panel in the Inspector
Application for mobile devices.

See Working with Inspection Details.

- Inspections page in the permit application
details.

See Reviewing Inspection Details.

- Inspections page in the business license
activity details.

See Reviewing Inspection Details.

- Reports and Analytics or Bl Catalog:
> Shared Folders > Public Sector >
Inspections

- Invoice History page

See Viewing Invoice History.

- Reports and Analytics or Bl Catalog: >
Shared Folders > Public Sector > Billing
and Payments

- Payment Successful page

See Payment Flow Overview.

- Fees and Payments page of the permit
record details displayed in the Redwood
Experience

See Working with Fees and Payments.

« Reports and Analytics or Bl Catalog:
Shared Folders > Public Sector > Billing
and Payments

Reports and Analytics or Bl Catalog: Shared
Folders > Public Sector > Permits

Reports and Analytics or Bl Catalog: Shared
Folders > Public Sector > Permits

- See Working with Reports.
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Report Name

Primary Approved Permit

Public User Information

Refund Receipt

Transactions with Reconciled Provisional
Parcels

Violation Notice

Violation Notice Detail Report

Welcome Letter

ORACLE

Description

report for one or more specific applications, or
for all applications handled by your agency.

Displays applicant and detailed application
information, as well as a description of the
work, address, parcel, and district.

Lists information about public user accounts.

Lists refund receipt information.

Lists the transactions that refer to the
reconciled provisional parcels.

Using this report you can see the provisional
parcels that have been replaced with final
parcels as a result of parcel reconciliation. You
should update the provisional parcel IDs that
are referred in the transactions with the final
parcel IDs.

Displays information about the code violation,
corrective actions, and the compliance date.
This report is sent to the party responsible for

the reported violation.

Displays information about the code violation,
corrective actions, and the compliance date.
This report is sent to the party responsible for

the reported violation. This report retrieves

images (.jpg and .png) from case attachments.

Informs the applicant that the application has
been assigned and is under review. Provides
application and assigned planner information.
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Location

- Reports and Analytics or Bl Catalog:
Shared Folders > Public Sector >
Planning Application

- See Working with Reports.

- Reports and Analytics or Bl Catalog:
> Shared Folders > Public Sector >
Planning Application

Reports and Analytics or Bl Catalog:
Shared Folders > Public Sector > Account
Management

- Refund Detail page

See Viewing and Processing Refunds.

« Reports and Analytics or Bl Catalog:
Shared Folders > Public Sector > Billing
and Payments

Bl Catalog:
Shared Folders > Public Sector > Parcels

See Reconciling Provisional Parcels.

- Notice of Violation page

See Using the Code Technician Worklist.

- Notices page

See Working with Notices.

- Reports and Analytics or Bl Catalog:
Shared Folders > Public Sector > Code
Enforcement > Notices

- Notice of Violation page

See Using the Code Technician Worklist.

- Notices page

See Working with Notices.

- Reports and Analytics or Bl Catalog:
Shared Folders > Public Sector > Code
Enforcement > Notices

- See Working with Reports.

- Reports and Analytics or Bl Catalog:
Shared Folders > Public Sector >
Planning Application
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Dashboards organize analytical content and catalog objects, and present them in a meaningful way. Oracle Permitting
and Licensing delivers a selection of prebuilt dashboards.

Access dashboards by clicking Reports and Analytics and selecting the Browse Catalog button in the header. Go to
Shared Folders > Public Sector > Dashboards. For more information, see Setting Up Dashboards. For a complete list of
delivered dashboards and analytics, see the Related Topics for a link to the analytics listing in downloadable format.

Hiding Catalog Folders

You may want to remove access to predefined catalog folders so that those associated with offerings you don't

use aren't displayed. You can hide the entire predefined catalog or selectively display root catalog folders for

offerings, which are controlled by the Custom Bl Web cat Reporting Duty role and associated roles for each offering.
Administrators with IT Security Manager privileges can hide predefined folders by removing their associated roles from
the duty role.

For more information, see Oracle Cloud Applications documentation: Manage Predefined Catalog Permission in Creating
and Administering Analytics and Reports.

Related Topics
- Listing of Prebuilt Analytics

Creating Deep Links

Create deep links in your analytics that let you navigate from an analytic to specific attributes and objects in your
transaction pages without navigating through the menu structure.

You can use deep links to easily view the transaction details in Oracle Permitting and Licensing from your Oracle
Transactional Business Intelligence (OTBI) reports.

Here’s how to create deep links:

1. Click the Reports and Analytics header icon on the Agency Springboard, and select Bl Catalog.

2. Create or edit an analysis. Use a subject area that includes the attribute you want to link to in the transactional
pages. For example, use Public Sector Cloud - Permits Real Time.

In the Selected Columns pane on the Criteria tab, click ﬂ (Options) for the attribute column on which you
want a deep link.

Select Column Properties.

Open the Interaction tab in the Column Properties dialog box.

In the Primary Interaction list in the Value section, select Action Links to display the Action Links table.
Select the Do not display in a pop-up if only one action link is available at runtime option.

Click Add Action Link.

In the New Action Link dialog box, enter the link text for the navigation.

10. Click the Create New Action icon and select Navigate to a Web Page.

11. In the Create New Action dialog box, enter the URL to navigate to, which references parameters you define in
the prompt. For shared analyses, enter a URL with your website host name:

©CvVvOgOo U

http://<hostname>/fscmUI/deeplink?root=@{1}&context=LnpRecordKey%253D@{2}
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o Replace <hostname> with the host name of your Oracle Permitting and Licensing instance.
o Replace deeplink with the Public Sector homepage. For example, publicSector.html.

12. Click Define Parameters to add corresponding parameters for the URL.
13. In the Define Parameters section, click Add Parameter to add the following mandatory parameters:

Name Prompt Type of Value Value Fixed Hidden Optional

1 root Value PSCLNP_ Selected Selected Selected
RECORD_DETAIL

2 context Column Value "<table.name>"."< Selected Selected Selected

For example, the context could be “Construction”.”<LNP Record Key>,” where the LNP Record Key is “Permit
Number.” This creates a deep link on the permit number to navigate to the permit transaction detail page.

14. C(lick Options to set how the page opens.
15. In the Action Options dialog box, select Open in New Window to open the page in a new window.

16. Save your work.
17. If you have provided the Return Application name, a Return icon is available in the transactional page to return

to the analysis.
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15 Setting Up Subject Areas

Subject Areas Overview

This topic describes how subject areas work.

A subject area is a grouping of information pieces pulled from your transactional database that relate to each other in a
particular context. Examples of context are permits, inspections, plan reviews, planning applications, and so on. These
contexts correlate to key aspects of your business transactions, and are designed to provide answers to questions about
how well things are going. Prebuilt subject areas come right out of the box to answer key business questions.

Any information your organization tracks can be grouped into a subject area, then used to build analytics. All you have
to do is drag columns from your subject area to your analytics editor and you have an analytic. You can edit prebuilt
analytics the same way, by adding or removing columns from your subject area. When you edit prebuilt analytics, don't
forget to make a copy and give it your own name.

Subject Areas and Business Questions

This topic describes how business questions form the basis of your subject areas and analytics.

Subject areas are designed around business questions. All analytics are built from subject areas. So whether you're
creating your own analytics, or modifying the analytics that come with your Public Sector applications, you first want to
figure out what questions you want answered.

Here are some examples of subject areas and the business questions they can answer.

Subject Area Name Example Business Questions

Public Sector Cloud - Permits Real Time - What is the busiest time for permit applications?
- When does the agency issue the most permits?

- What is the total permit activity by permit type in a given period?

Public Sector Cloud - Permit Inspection - What is the workload distribution across all inspections?
Activity Real Time

- What are the primary reasons for major inspection violations?
- What is the total demand for inspections in a given period?
Public Sector Cloud - Plan Review Real - How long on average are plan review cycles?
Time
- How many plan review cycles on average are needed for an application?

« How many plan reviews had override decisions?
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Subject Area Context and Analytic Results

This topic discusses the subject area context and the column details of the analysis.

If your analytic doesn't look right, or columns of information aren't showing up, it could be an issue with context. The
context defines what column details the analysis displays. Adding a permit type column doesn't mean all permit type
show up in the analysis. It depends on the context you're using to create the analysis. If you build an analysis, and it
doesn't show what you're expecting, be sure that you're adding your columns and facts in context.

The subject area dimension folders contain the columns and the facts folders define the relationship of the columns. If
you add the permit type column to your analysis, and then add the Fact, Permit Count to the same analysis, then only
the permit types that have one or more permit show on this analysis in this context. There might be hundreds of permit
types that doesn’t have permits associated, so they don't show up on your permit activity analysis.

The following is an example that might help explain this further. In this exercise you will build a permit activity analysis.
To build a simple permit activity analysis from a subject area:

1. Click New and select the Analysis option.
2. Select Public Sector Cloud - Permits Real Time:
o From the dimension Permit Type, add Permit Type.
o From the dimension Permit - Applicant, add Full Name.
o From the dimension Permit, add Permit Application Date.
o From the Permit Amounts (fact) folder, add Permit Count.

3. You can filter Permit Application Date to see a specific date range. Edit the filter by clicking or hovering over the
button next to its name.
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4. Select the filter to show only a specific date range and click OK.
This figure illustrates choosing a filtering option to show only records in a specific date range.

New Filter O x

Column  Permit Application Dal £,

Operator s between v
Value  (01/01/2019 EE
Value  (03/31/2019 EE
Add More Options v Clear All
[ ] Protect Filter
[ ] Convert this filter to SQL
OK | Cancel

5. Click Results. The Results tab shows your analysis at this point. Move back and forth from Criteria to Results at
any time to see your analysis.
This figure illustrates the results of a simple permit activity analysis from a subject area:

Compound Layout

Al & X
Example

4] I / X
Permit Type  Full Name Permit Application Date Permit Count
CV0B23 William B 8i23M9 4
PSCPERMITZ Elaine W 8i22M9 1

6. Name and save your analysis.

Note: You can't use Direct Database Query in your analysis. Direct Database Query isn't supported in SaaS OTBI. To
create direct database SQL report, you can create a Bl Publisher SQL data model and then create a report.

Multiple Subject Areas in a Single Analytic

This topic discusses how to use multiple subject areas in a single analysis.
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Subject areas can be tricky to master, but once you get familiar with them you can easily mix and match subject area
components for your analytics. The reason you would want to do this is just for flexibility. You might want to look at your
business from different perspectives.

You can create an analysis that combines attributes and metrics from custom permit and standard permit-related
subject areas that share a common dimension. Or, if that isn't enough, you can create an analysis that combines data
from multiple standard subject areas.

To start with, let's learn how to add a subject area to the editing palette. Whether you're creating a new analysis, or
using an existing analysis to add objects from your custom subject area, the steps for adding multiple custom or
standard subject areas to your palette are the same.

To add multiple subject areas to editing palettes:

1. Create your analysis using a single subject area.
2. Inthe Subject Areas section, click the Add / Remove Subject Areas icon.

This shows the Add / Remove Subject Areas icon.

DRAC'_E Transactional Business Intelligence

Untitled

Criteria | Results Prompts Advanced

]

4 SubjectAreas O flv | P> T ¢ BB

k

o | ) . .
| a4 Public Sectar Cloud - Permits Real Tir

4 Selected Columns
Agency

Contact Double click an column n
Fee Schedule

Farcel

Parcel Owner

Permit

Permit Amounts

Permit Application Date J 7

Permit Issue Date Add filters to the analysis

v W v w w wv w w w wv A

Permit Type

3. Select or remove one or more standard or custom subject areas from this analysis by selecting or deselecting
subject area. If you have created custom subject areas, they also appear in this list under the name you
assigned to them.

Cross Subject Area Queries

Each subject area contains a collection of attributes and measures relating to the one-dimensional STAR model and
grouped into individual folders. The term STAR refers to the semantic model where a single fact is joined to multiple
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dimensions. You can create an analysis that combines data from more than one subject area. This type of analysis is
referred to as a cross-subject area query. Cross-subject area queries are classified into three broad categories:

- Combining queries from multiple subject areas.

o Using common (conformed) dimensions.

o Usinglocal and common (conformed) dimensions.

- Using a “set” operation (Union or Union All, for example) to combine more than one result set from different
subject areas.

- Combining Logical SQL using the Advanced tab.

A common dimension is a dimension that exists in all subject areas that are being joined in an analysis. For example, the
Contact dimension is the common dimension for the Public Sector Cloud - Permit Inspection Activity Real Time and
Public Sector Cloud - Permits Real Time subject areas.

Alocal dimension is a dimension that exists only in one subject area. For example, Inspection Type and Inspection
Status are local dimensions for the Public Sector Cloud - Permit Inspection Activity Real Time subject area.

The following are some general guidelines to follow when working with multiple subject areas:

- If all metrics and attributes needed for the analysis are available in a single subject area and fact metrics, use
that subject area only and don't create a cross-subject area query. Such an analysis performs better and is
easier to maintain.

- When joining two subject areas in an analysis, make sure at least one attribute from a common dimension is
used in the analysis.

- When using common dimensions always choose attributes from the common dimension from a single subject
area. For instance if you're using the Contact dimension to build a query between subject area 1and subject
area 2, then select all Contact dimension attributes from either subject area 1 or from subject area 2. (Not
some contact attributes from subject area 1and some from subject area 2.) In some scenarios, the common
dimension may have more attributes in one subject area than the other. In such a situation, you can only use
the subset of common attributes for a cross-subject area query.

- Always include a measure from each subject area that's being used in your analysis. You don't have to display
measures or use them, but you should include them. You can hide a measure if not needed in the analysis.

- When using common and local dimensions use SET VARIABLE ENABLE_DIMENSIONALITY=1; in the Advanced
SQL tab.

Queries from Multiple Subject Areas

The simplest and fastest way to generate an analysis is to use a single subject area. If the dimension attributes and fact
metrics that you're interested in are all available from a single subject area, then you should use that subject area to
build the analysis. Such an analysis results in better performance and is much easier to maintain.

If your analysis requirements can't be met by any single subject area because you need metrics from more than one
subject area, you can build a cross-subject area query using common dimensions. There's a clear advantage to building
a cross-subject area query using only common dimensions, which is recommended.

Keep in mind that if you use three subject areas for an analysis, your common dimensions must exist in all three subject
areas. Joining on common dimensions gives you the benefit of including any metric from any of the subject areas in a
single analysis.
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While you can create an analysis joining any subject area to which you have access, only a cross-subject area query that
uses common dimensions returns data that's at the same dimension grain. This happens so that the data is cleanly
merged and the result is an analysis that returns exactly the data you want to see.

Knowing how cross-subject area queries are executed in Bl helps you understand the importance of using common
dimensions when building such an analysis. When a cross-subject area analysis is generated, separate queries are
executed for each subject area in the analysis and the results are merged to generate the final analysis. The data
that's returned from the different subject areas is merged using the common dimensions. When you use common
dimensions, the result set returned by each subject area query is at the same dimensional grain, so it can be cleanly
merged and rendered in the analysis.

Common Dimensions for an Analysis

Here is an example of combining common dimensions. In this case, we combine the Permit Count, Permit Type,
Inspection Count, and Inspection District Type. The common dimension in both subject areas used for this analysis is
Permit Type and different fact metrics are pulled from each subject area.

The following subject areas are used for this example analysis:

- Subject area 1: “Public Sector Cloud — Permits Real Time”

- Subject area 2: “Public Sector Cloud — Permit Inspection Activity Real Time”

Customer is the common dimension used for this example analysis:

« “Public Sector Cloud - Permits Real Time”.“Permit Type” — Permit Type

- “Public Sector Cloud - Permit Inspection Activity Real Time* — Permit Type

The following are the metric measures for this example analysis:

- “Public Sector Cloud — Permits Real Time“.“Permit Amounts” — Permit Count

- “Public Sector Cloud - Permit Inspection Activity Real Time“.“Inspection Amounts” — Inspection Count

Local and Common Dimensions for an Analysis

This example pulls the Permit Count by Permit Type and Inspection Count by Inspection District Type. Permit Type is

a common dimension in both subject areas used for this query. Inspection District is a local dimension to the Public
Sector Cloud - Permit Inspection Activity Real Time subject area. Different fact metrics are pulled from each subject
area. Note that use of local dimension may impact the grain of the analysis. In such cases the metrics may get repeated
for each of these rows.

The following are the subject areas used for this example analysis:

- Subject area 1: “Public Sector Cloud — Permits Real Time”

- Subject area 2: “Public Sector Cloud — Permit Inspection Activity Real Time”

Permit Type is the common dimension for this example analysis: “Public Sector Cloud — Permits Real Time”.“Permit
Type” - Permit Type.

The following is the local dimensions used for this example analysis: “Public Sector Cloud - Permit Inspection Activity
Real Time".“Inspection District” — Inspection District.
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The following are the metrics (measures) used for this analysis:

+ “Public Sector Cloud — Permits Real Time”.“Permit Amounts” — Permit Count
« “Public Sector Cloud - Permit Inspection Activity Real Time“.“Inspection Amounts” — Inspection Count
The following is the logical SQL used for this analysis:
SET VARIABLE ENABLE DIMENSIONALITY=1;SELECT
0 s_0,
"Public Sector Cloud - Permits Real Time"."Permit Type"."Permit Type" s_1,
"Public Sector Cloud - Permit Inspection Activity Real Time"."Inspection District"."District Type" s_2,
"Public Sector Cloud - Permits Real Time"."Permit Amounts"."Permit Count" s_3,
"Public Sector Cloud - Permit Inspection Activity Real Time"."Inspection Amounts"."Inspection Count" s_4
FROM "Public Sector Cloud - Permits Real Time"

ORDER BY 1, 2 ASC NULLS LAST, 3 ASC NULLS LAST

FETCH FIRST 75001 ROWS ONLY

Set Operations to Combine Result Sets from a Subject Area
This example creates a compound analysis query that's a union of two result subsets from two subject areas, combining
results from:

« Permit Count by Permit Type from the Public Sector Cloud — Permits Real Time subject area (result 1)

- Inspection Count by Inspection District from the Public Sector Cloud - Permit Inspection Activity Real Time
subject area (result 2)

SELECT saw_0, saw_1 FROM ((SELECT 'Permits ~ ' ||"Permit Type"."Permit Type" saw_0, "Permit Amounts"."Permit
Count" saw_1 FROM "Public Sector Cloud - Permits Real Time")

UNION

(SELECT 'Inspection ~ ' ||"Inspection District"."District Id" saw_0, "Inspection Amounts"."Inspection Count"

saw_1 FROM "Public Sector Cloud - Permit Inspection Activity Real Time")) tl1 ORDER BY saw_0

Logical SQL Using the Advanced Tab

If your requirement can't be met by either of the two methods already discussed, then there's another advanced
technique you can try. This technique lets you join multiple logical SQL statements based on common IDs or keys, which
can be written against the same or different subject areas, just as used in normal SQL. Both Outer and Equijoin are
supported.

This example illustrates how you can combine Permits and Fees data in an analysis by combining the logical SQL found
on the Advanced tab.

Step 1: Write a Bl Answers query using the “Public Sector Cloud — Permits Real Time” subject area to show the Fee
amount and Applicant Name. Once the correct results are achieved, go to the Advanced tab and grab the logical SQL
associated with this query.

Logical SQL for Query 1:

SELECT
0 s_0,
"Public Sector Cloud - Permits Real Time"."Applicant"."Applicant Name" s 1,
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"Public Sector Cloud - Permits Real Time"."Permit"."Permit Number" Per_ No,
"Public Sector Cloud - Permits Real Time".'"Permit Amounts".'"Fee Amount" s_3
FROM "Public Sector Cloud - Permits Real Time"

Step 2: Write a second Bl Answers query using the " Public Sector Cloud - Receipts Real Time"."Transactions" subject
area to show fees paid for the permit. Once the correct results are achieved, go to the Advanced tab and grab the logical
SQL associated with this query.

Logical SQL for Query 2:

SELECT
0 s O,
"Public Sector Cloud - Receipts Real Time".'"Transactions"."Application ID" s_1,

"Public Sector Cloud - Receipts Real Time".'"Fact - Receipts"."Amount Received for a given period" s_2
FROM "Public Sector Cloud - Receipts Real Time"

Step 3: Go to the Advanced tab in Bl Answers and copy/paste the following logical SQL which is an OBIEE - Equijoin of

the two previous SQL statements based on Opportunity ID. Use any text editor to combine the logical SQL statements
copied from Steps 1and 2.

SELECT

permit.s_1, permit.Per No, permit.s_3, fees.s_2
FROM

(
SELECT

0s O,
"Public Sector Cloud - Permits Real Time"."Applicant"."Applicant Name" s 1,
"Public Sector Cloud - Permits Real Time"."Permit"."Permit Number" Per_ No,
"Public Sector Cloud - Permits Real Time"."Permit Amounts"."Fee Amount" s_3
FROM "Public Sector Cloud - Permits Real Time"
) permit,
(
SELECT
0 s_0,
"Public Sector Cloud - Receipts Real Time"."Transactions"."Application ID" s_1,
"Public Sector Cloud - Receipts Real Time".'"Fact - Receipts".'"Amount Received for a given period" s_ 2
FROM "Public Sector Cloud - Receipts Real Time"
) fees
WHERE permit.Per No = fees.s_1

Note: If you create a new analysis using this SQL, any hierarchical columns, member selection, groups or formatting
is stripped out.

Custom and Standard Subject Areas Joins

Analyses can be build using combinations of standard, as well as both custom and standard subject areas. The add
subject area option appears once you have created an analysis from a single subject area. You can delete subject areas
using these same steps. When you create your analysis, you select a single subject area during the creation steps. Once
the analysis is created, you add additional standard or custom subject areas.

Listing of Subject Areas for Oracle Permitting and
Licensing

This reference points to the list of subject areas for Oracle Permitting and Licensing.
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Oracle Permitting and Licensing comes with a variety of standard subject areas for permits, planning applications, code
enforcement, and business licenses. See the Related Topics for a link to the subject area list.

Related Topics
« Subject Areas for Transactional Business Intelligence in Oracle Permitting and Licensing

203
ORACLE


https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=PSSAG

Oracle Public Sector Permitting and Licensing Chapter 13
Implementing Your Agency Setting Up Subject Areas

204
ORACLE



Oracle Public Sector Permitting and Licensing Chapter 14
Implementing Your Agency Setting Up Custom Subject Areas

14 Setting Up Custom Subject Areas

Custom Subject Areas

Oracle Permitting and Licensing Cloud contains prebuilt subject areas, but you can also create your own subject area for
your unique reporting needs.

The subject areas that you create is called a custom subject areas.

Concepts and Terminology in Custom Subject Areas

Before creating a custom subject area, you should understand the concepts and terminology used with custom subject
areas. These concepts are discussed in their related topics in detail.

- Objects: Objects within Oracle Permitting and Licensing Cloud represent an entity; for example, a contact list.
When you create entities such as permit types within Oracle Permitting and Licensings, you create custom
objects.

Fields or attributes: A field, also called an attribute, is where entity information is stored. A contact type is
stored in a field under the contact list entity or object.

Measures: Measures are a set of functions that you can apply on date, numeric, or currency type fields of the
selected primary or child objects while defining a custom subject area.

Date Leveling: Date leveling is a date hierarchy representation between dates and their associated measures.
For example, total actual annual gross revenue by month.

Creating Custom Subject Areas

This topic covers how you create and edit custom subject areas, and how you can activate or inactivate a custom subject
area while editing.

You cannot modify a predefined report subject area, however, you can create custom subject areas to meet your
reporting needs.

Note: Before you create a custom subject area, review all the included subject areas to see if the one you want is
already available.

Adding a Custom Subject Area

You add custom subject areas using train stops that appear at the top of the page. These train stops enable you to
move back and forth during the configuration process. You can also save your configuration at a logical point and then
continue to create later.

I Note: You can only create custom subject areas when you are not in an active sandbox.
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To create a custom subject area using train stops:

1.

Navigate to Application Composer.

2. C(lick Custom Subject Areas on the Overview page of Application Composer.
3. Select Create from the Actions menu.

These are the steps in the train stops that you can use for configuring your custom subject area:

1.

Define Custom Subject Area

In this step, you provide the name for your subject area and select the primary object that is the basis for

the reports you create later using the custom subject area. Subject areas usually have names or labels that
correspond to the type of information they contain. Display labels have the Custom: prefix added automatically.
Select Child Objects

In this step, you select the child objects whose data you want to use in your reports. You can add child objects
only if the primary object has child objects. Otherwise, the add icon is disabled. You can only add one child
object per level. The parent-child-grandchild-grand grandchild hierarchy supports adding up to three levels of
child objects with one child object at each level, for example, parent-child1-child1.1-child1.1.1.

Configure Fields

In this step, you select the fields that you want to display on your reports. You typically add at least one field
from each of the objects that you have selected for your custom subject area.

Select the desired measures to generate for number, date, or currency fields from all the available objects so
that the subject area includes only those measures that you want to analyze. Also, define at least one measure.

In the Measure Aggregations column, select an option from the list of predefined formulas that you can apply
to the Measure field. When you select the formula, the application applies the selected formulas to the selected
field and measures.

Note: You can choose measures only for the lowest child. For example, if only a primary object exists with no
children, you can select measures for the primary object. Otherwise, if any child objects exist, you can select
measures only at the lowest child object level, not for the parent object.

You can change the display labels of the fields that you select in this step. Additionally, you can use the Select
Fields dialog to remove fields that belong to the primary object. The Select Fields dialog appears when you click
Select Fields when configuring fields for your custom subject area.

After you publish your custom subject area, the fields you have selected for your subject area are automatically
added to their owning object's folder. If you have also defined measures, those fields are automatically added to
the Facts folder. If you did not define a measure, then one is automatically created for the custom subject area.

For more information on measures, see Measures.
Configure Date Leveling

If required, select the Date columns for date leveling. For more information on date leveling, see Date Leveling.
Configure Security

Select the required security level for the Everyone Role Name, which is added by default, or add additional Role
Names by clicking in the + icon and define the security level for each one of them.

The security definition here only controls who can access the custom subject area definition to create reports. It
doesn't control data visibility which is automatically controlled based on the user running the reports.
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For more information on securing custom subject areas, see Custom Subject Area Security.
6. Review and Submit

Review the custom subject area configuration for all added objects, attributes, and measures, and if satisfied,
click Submit. If changes are required click Back to navigate back to the required screen.

After you submit, the custom subject area configuration is prepared for publishing. You can create and submit
a custom subject area either immediately or save and close the custom subject area at any point and submit it
later. You must first submit a custom subject area for publishing before you can select it from within Oracle Bl

Composer. After you save or submit a custom subject area, you cannot modify its primary object.

To access the published custom subject area in Bl:
o From the Navigator menu, select Tools > Reports and Analytics.
o Inthe Contents pane, click Create.
o Select the published custom subject area and start creating your report.

Editing Custom Subject Areas

You can edit a published or saved custom subject area and then republish it when your changes are done. Modifying a
custom subject area does not affect the reports that you had created using that custom subject area before making the
changes. You can use the modified custom subject area if you need to enhance existing reports.

To edit a custom subject area:

1. On the Overview page of the Application Composer, click Custom Subject Areas.
Locate the custom subject area that you want to edit, and click the Edit icon.

You can filter out inactive custom subject areas in Application Composer by viewing custom subject areas in
Active status. This is safer than deleting them, because the inactive subject areas are still available and can be
found by searching.

3. Make the desired changes and then click Submit to republish the custom subject area.

While you can edit a custom subject area in any status, there are considerations on what you can or can't do when
editing. When editing a published custom subject area, it is not possible to:

- Change the primary object.

- Add or remove child objects.

- Remove previously added measures.

- Add more aggregation types for measures that are already published.

Note: You cannot modify a predefined report subject area. Instead, you must create separate custom subject areas to
meet your reporting needs. Before you create a custom subject area, be sure to review all the included subject areas to
see if the one you want is already available.

Activating or Inactivating Custom Subject Areas

When editing custom subject areas, you can activate or inactivate custom subject areas when your reporting or
business requirements change. This step enables you to control what information is displayed on the reports that use
the information from custom subject areas.
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You can inactivate only those custom subject areas that are published and have a status of OK, and can activate only
previously inactivated custom subject areas.

To inactivate a custom subject area, select it in the list and then click the Inactivate button. To activate an inactive
custom subject area, select it and click Activate. Note that if no custom subject area is selected in the list, the button
doesn't appear.

When searching for custom subject areas, you can filter out inactive custom subject areas in Application Composer by
viewing only those in Active status. Inactivating a custom subject area is safer than deleting it, because the inactive
subject areas are still available and can be found by searching.

Objects in Custom Subject Areas

This topic covers how you use the various types of objects in the Application Composer to create custom subject areas.
A custom subject area is a set of entities (objects), attributes, and measures that you use to build reports.

Objects can be classified under broad categories of custom objects and standard objects. Every custom subject area
has a primary object, which is the focus of any reports that you create. You can also optionally add child objects to the
custom subject area. Custom subject areas support both custom and standard objects. The objects that you create are
called custom objects.

Before designing your custom subject area, use Intake Form Designer to identify or create the objects and fields that
you want to use.

Primary Objects

A primary object is any top-level object. You create a custom subject area based on the primary object. Additionally, the
primary object is the focus of the report that you create based on the custom subject area.

The list of available primary objects includes all objects, which are either top-level custom objects, or standard objects
that are configured by the owning application. After you save your custom subject area, you can't change its primary
object; but you can create another custom subject area using a different primary object.

Based on how you want to configure your custom subject area, you can add one child to an object.

Child Objects

A child object is an object that has a one-to-many relationship with a parent object and can be a parent object of
another child object. Add a child object to a custom subject area if you want your report to include data from both the
primary object and its children. If an object's parent object is already a child object (of another parent object) then the
object is a grandchild object. For example, if object Y is a child of object X, and object Z is a child of object Y, then object
Z is a grandchild of object X. Custom subject areas support parent-child-grandchild-great-grandchild objects.

You can only add one child object to the primary object per level, as long as there are child objects available. If there are
no child objects for the chosen primary object, the list that enables selecting child objects does not appear.

The parent-child-grandchild-great-grandchild hierarchy supports adding up to three levels of child objects with one
child object at each level; for example, parent-child1-child1.1-child11.1.

I Note: Once you publish a custom subject area, you can't add or remove child objects.
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Fields or Attributes in Custom Subject Areas

This topic explains the various types of fields or attributes that you use for configuring your custom subject area.

Fields or attributes store entity information in the application. Fields can be standard or custom.

Types of Reporting Fields

The fields you can use to create reports are as follows:

« Text
Number
Date
Percentage
Date time
- Currency
« Check box
Fixed choice list
Dynamic choice list

Long text

Note: You cannot create reports using the Rich text area field.

When you create a custom field, you can create reports for the following data types:
Boolean

Note: Note: If you are using the Boolean data type for fields other than checkboxes, those fields are displayed
as either 0 or 1 on your custom reports.
Number
« Currency
Date
- String
Percentage
Phone
Date time

Long text
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Measures

Measures are a set of functions. Examples include a SUM of the actual gross revenue in USD, or a COUNT of the number
of building permits worth over $500,000.

The designer defines the aggregation function (SUM, COUNT, and so on) for custom measures, so end users don't need
to do so themselves when they create an analysis. You can apply these functions on fields of type Date, Numeric, or
Currency.

Measures available to a particular type of field may differ depending on the field type. After you define the measures
for the required fields and publish the custom subject area, you can select these fields and the applied measures when
creating your report in the Oracle Bl Composer. You can only specify aggregate formulas to apply to a measure when
creating a custom subject area. It is not possible to edit a measure in an already published custom subject area.

Here are some measures you can apply to fields of type Numeric, Currency, or Date.

« For Numeric and Currency fields, a measure can be:

[e]

All

Note: Allis not a measure, but an option in the Ul that selects all of the measures.

Sum: Calculates the sum of the values.

Average: Calculates the mean value.

Count: Calculates the number of rows that are not null.

Count Distinct: Calculates the number of rows that are not null. Each distinct occurrence of a row is
counted only once.

Note: Although Count Distinct is usually used in cases requiring a count on a foreign key (because a
count of distinct rows is what's wanted), it is not required. If your requirements allow multiple instances
of the same foreign key value to be counted multiple times, you can use Count rather than Count
Distinct.

Maximum: Calculates the highest numeric value.

Minimum: Calculates the lowest numeric value.

First: Selects the first occurrence of the item.

Last: Selects the last occurrence of the item.

Median: Calculates the middle value.

Standard Deviation: Calculates the standard deviation to show the level of variation from the average.

Standard Deviation Population: Calculates the standard deviation using the formula for population
variance and standard deviation.

For Date fields, a measure can be:

o

o

o

All
Maximum
Minimum

210

ORACLE



Oracle Public Sector Permitting and Licensing Chapter 14
Implementing Your Agency Setting Up Custom Subject Areas

You can select measures based on your reporting needs. For example, you can use measures to view product sales per
store, state, or country. Or, to view the number of support tickets opened or closed per day, week, or month, and so on.

If you do not define a measure, then one will be automatically created for the subject area when you submit the custom
subject area for publication.

Date Leveling

Date leveling is a hierarchy representation of dates and associated measures, which enables you to view the data over
different periods of time.

To use this hierarchy, create a report that shows the total Actual Gross Revenue amount for each year. Drill down from
year to show gross revenue per quarter, sales per month, gross revenue per week and gross revenue per day, and
then drill back up to gross revenue per year. The date hierarchy aggregates the measures by the required hierarchy or
leveling period.

To configure date leveling when defining a custom subject area, use the Configure Date Leveling step of the train stop
to either allow or disallow leveling. You may need to expand the field list in the Date field to select or clear the Date
Leveling checkbox, as applicable.

For more information on where the Configure Date Leveling step appears in the train stop, see Creating Custom Subject
Areas.

Custom Subject Area Security

You can secure a custom subject area by granting or revoking access rights from the role names that access the custom
subject area. This topic covers how you can grant or revoke access rights from those role names.

For information about custom subject area data source security in Oracle Analytics Publisher, see Public Sector
Compliance and Regulation Custom Subject Area Security Guide for Implementation (Doc ID 2730290.1) in My Oracle
Support.

Managing Role Names and Access Rights

While defining a custom subject area using the train stops, you can use the Actions list in the Configure Security step to
manage role names and access rights.

I Note: You cannot delete the role name listed as Everyone.

Read access is granted by default. If you want to revoke Read access from a listed role name, select No access for that
role name.

You can create custom subject areas even for the objects in which you do not have access to the data, which allows you
to build custom subject areas without compromising data security.
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Publication Statuses of Custom Subject Areas

This topic covers what happens when you submit a custom subject area for publishing, and what the submission
statuses indicate.

After you successfully publish your custom subject area, you can start building reports using Oracle Business
Intelligence (Bl) Composer based on your published subject area.

What Happens When You Submit for Publishing

When you submit a custom subject area for publishing, two processes occur in the background. The first process is
synchronous and creates Oracle Applications Development Framework (Oracle ADF) artifacts. You must wait until this
first process is over. The second process is asynchronous and creates centralized metadata repository (RPD) fragments
and submits them to the Oracle Bl server.

Note: You must refresh the status to know whether the custom subject area is submitted successfully. You may have
to refresh the status multiple times, because the creation of Oracle ADF and RPD artifacts may require some time.

A custom subject area can have one of the following statuses:

Pending: This status indicates either of the following:
o You saved and closed the configuration process for a custom subject area before submitting it for
publishing.
o A failure occurred in the background processes when creating Oracle ADF and RPD artifacts.
In Process: This status indicates that the data is in the process of being published to Oracle Bl.

Note: If the in-process status doesn't change to OK, even after multiple refresh attempts, then there could be
an error in publishing. If an error occurs, then the details are displayed, as well as information about how to fix
problems, where applicable. These error status details allow you to pinpoint and fix problems quickly.

- OK: This status indicates that the custom subject area has been published successfully. You can use Oracle Bl
Composer to create reports using the objects, attributes, and measures that you have configured in the subject
area.

Including Custom Fields on Reports

This topic discusses how to create a custom subject area using an attribute and create a report.

Creating a Custom Subject Area

In this example, you create a custom subject area using the LNP1KitchenRemodel object.

1. If you are working in a sandbox, exit the sandbox.
2. Click the Navigator menu at the top.
3. Click the Application Composer link.

212
ORACLE



Oracle Public Sector Permitting and Licensing

Implementing Your Agency Setting Up Custom Subject Ar

L4

0 ® 30

10.

12.
13.
14.
15.

16.
17.

18.
19.
20.

21.
22.
23.
24.
25.

26.

Note: You might need to click the more >> link first.

You are on the main page of Application Composer, where you create a custom subject area using the
LNP1KitchenRemodel object.

Change the Application from CRM Cloud to ERP and SCM Cloud.
In the Overview region, click the Custom Subject Areas link.

You are on the Custom Subject Areas page. You can use this page to search or create custom subject areas.
In the Search Results region, click the Create button.

Enter a name for the custom subject area that you are creating. Enter Kitchen Remodel in the Label field.
In the Primary Object region, click the Primary Object list.

Click the LNP1KitchenRemodel list item.

In the upper-right region of the page, click the Next button.

In the upper-right region of the page, click the Add Child Object button.

In the Add Child Object dialog box, click the Child Object list.

Click the ContactList list item.

Click OK.

In the upper-right region of the page, click Next.

You now define the fields for the LNP1KitchenRemodel primary object.

Chapter 14
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Ensure that the selected value in the Fields Fromlist is LNP1KitchenRemodel. Click the Select Fields button.

On the Select Fields modal page, select the fields that you want to include for the LNP1KitchenRemodel
primary object.

Repeat steps 16 and 17 for the ContactList child object.

In the upper-right region of the page, click Next.

You now select fields to apply date leveling. In the Date Field Leveling table, click the Expand button of the
LNP1KitchenRemodel object.

Select the Allow Leveling option for the Business Start Date field.

In the upper-right region of the page, click Next.

Leave the default role access of Read for Everyone. In the upper-right region of the page, click Next.
Review your custom subject area. In the upper-right region of the page, click Save.

In the upper-right region of the page, click Submit.

A confirmation message appears.
Click OK.

You successfully created a custom subject area.

Creating a Report Using a Subject Area

In this example, you create a report in Oracle Business Intelligence Composer (Bl Composer) using the Kitchen Remodel
subject area.

1.

Click the Navigator menu at the top.

2. C(lick the Reports and Analytics link under Tools.

Note: You might need to click themore >> link first.

The Reports and Analytics page appears.
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In the left pane, click Create and select Analysis.

From the Select Subject Area dialog box that appears, you must first select a subject area to build your report.
In this activity, you are building a report using the Kitchen Remodel subject area.

In the Select Subject Area dialog, select the checkbox next to Custom:Kitchen Remodel and click Continue.

Tip: You can add more than one subject area to a report by selecting the checkbox next to additional subject
areas.

You are in the Select Columns step of Oracle Business Intelligence Composer (Bl Composer) wizard. In the left
box, click the Expand button of the Custom:Kitchen Remodel tree.

Add the following fields to the Selected Columns box on the right:

RecordNumber under LNP1KitchenRemodel tree.
Submission Date under LNP1KitchenRemodel tree.
Status under LNP1KitchenRemodel tree.
Expiration Date under LNP1KitchenRemodel tree.
Female Owned under LNP1KitchenRemodel tree.
First Name under ContactList tree.
Last Name under ContactList tree.
Gender under ContactList tree.
Phone Number under ContactList tree.

j. State under ContactList tree.
In the upper-right region of the page, click Next.

~ 70 -0 20T

You are in the Select Views step of the wizard.

Enter Kitchen Remodel Permits in the Title field.

Click the Table list.

Click the Table (recommended) list item.

Click the Preview option on the right of the Title field to view a preview of the table. Click OK.
In the upper-right region of the page, click the Next button.

You are in the Edit Graph step of the wizard.

In the upper right region of the page, click Next.
You are in the Sort and Filter step of the wizard.

In the upper right region of the page, click Next.

You are in the Highlight step of the wizard.
In the upper right region of the page, click Next.

You are in the Save step of the wizard.

Enter Kitchen Remodel Permits in the Analysis Name field.

In this activity, you will save your report in only My Folders. In the Save In area, click the My Folders tree.
In the upper right region of the page, click Submit.

A confirmation message appears.

Click OK.

You can now view the report you just created. Click the Expand button of the My Folders tree.
Locate the report you just created.

You successfully created a report in Bl Composer using the Kitchen Remodel subject area.

214

ORACLE



Oracle Public Sector Permitting and Licensing Chapter 14
Implementing Your Agency Setting Up Custom Subject Areas

Custom Subject Areas: Frequently Asked Questions

This topic provides answers to some frequently asked questions regarding custom subject areas.

Can | change a custom subiject area's primary object?

No. Once you save a custom subject area, you cannot change its primary object; however, you can create a new custom
subject area with a different primary object.

What happens if | change a custom subject area after it is published?

You can edit a published custom subject area and then republish it after your changes are done. Modifying a custom
subject area does not affect the reports that you created using that custom subject area before making the changes.
You can use the modified custom subject area should you need to enhance existing reports.

Note: You cannot edit a primary object when you modify a custom subject area. Should you need to do so, create a
new custom subject area using a different (new) primary object.
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15 Setting Up Time Recording

Time Recording Overview

Time recording enables agencies to track the amount of time their employees spend on various activities.

Agencies can use this recorded time to:

- Bill for time spent.
- Report on key performance indicators.
To set up your agency for time recording, you define:
1. Time recording categories and subcategories.
See Setting Up Time Categories and Subcategories.

Note: This step is not strictly required because you can add time entries without categories or subcategories.
You must define time recording categories and subcategories, however, before associating them with time
entry types.

2. Time entry types.

See Setting Up Time Entry Types.
3. Fee schedules.

See Setting Up Fee Schedules.

Note: This step is required for billing based on time spent.

Once you've setup up your time recording framework, agency staff can enter time and assess fees on the transaction
pages. For more information, see Adding Time Entries and Assessing Fees for Time Entries.

Setting Up Time Categories and Subcategories

Time categories and subcategories enable agencies to classify how their staff is spending their time.

Categories and their subcategories are reusable across transactions and products, and can be used to calculate fees and
generate reporting information.

You add, modify, and delete time categories and subcategories on the Time Category page (Time Recording Setup >
Time Category).

This example shows the Time Category page

Time Category

LS eard ALY
Category ID Category Description Enabled

MEETING MEETING VEETING Yes

TRAVEL TRAVEL TRAVEL
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Adding a Time Category

1. Onthe Time Category page, click Add.

2. Onthe Time Category Details page, enter a Category ID, a Category, and a Description for the category.

3. Turn on the Enable switch to make this category available to select for time entry types. This switch is turned
off by default for new time categories.

4. Add a subcategory.
I Note: You must have values defined for all required time category fields before you can add a subcategory.

5. Click Save.

Adding a Time Subcategory

1. Click a row on the Time Calendar page.

2. Onthe Time Category Details page, click Add.

3. On the Time Subcategory Details page, enter a Subcategory ID, a Subcategory, and a Description for the
subcategory.

4. Ensure that the Enable switch is turned on so that the subcategory is available to select for time entry types.
This switch is turned on by default for new time subcategories.

5. Click Save.
Modifying a Time Category

1. Click a row on the Time Calendar page.
2. Onthe Time Category Details page, you can:

o Update the time category fields.

Note: You can't edit the Category ID field.

o Enable or disable the time category.
o Delete the time category. You will be prompted to confirm the permanent deletion.
o Add, modify, or delete time subcategories.

3. Click Save.

Modifying a Time Subcategory

1. Click a Time Subcategory row on the Time Category Details page.
2. On the Time Subcategory Details page, you can:

o Update the time subcategory fields.

Note: You can't edit the Subcategory ID field.

o Enable or disable the time subcategory.
o Delete the time subcategory. You will be prompted to confirm the permanent deletion.

3. Click Save.
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Deleting Time Categories

1. On the Time Category page, click Select Multiple.
2. Select the checkboxes next to all the time categories you want to delete.
3. Click Delete. You will be prompted to confirm the permanent deletion.

Deleting Time Subcategories

1. On the Time Category Details page, click Select Multiple.
2. Select the checkboxes next to all the time subcategories you want to delete.
3. Click Delete. You will be prompted to confirm the permanent deletion.

Setting Up Time Entry Types

Chapter 15

Setting Up Time Recording

Time entry types enable you to associate time categories and subcategories with the transactions where they can be

used to record time.

Each time entry type represents a unique, reusable combination of time category, time subcategory, classification, and

transaction. For example, you might create a time entry type for air travel associated with a permit inspection.

You add, modify, and delete time entry types on the Time Entry Type page (Time Recording Setup > Time Entry Type).

This example shows the Time Entry Type page

Time Entry Type
+

Time Type Code Classification Transaction
PR BA

INSP_BA

INSP_Disable

INSP_BAO

Adding a Time Entry Type

Category

MEETING

MEETING

TRAVEL

TRAVEL

TRAVE!

TRAVEL

MEETING

MEETING

TRAVEL

TRAVEL

2 lel el e

W22 0202 N2

+  © © ©
+ © © ©
. © © ©

. © © © ©
" ©

p— « © O

. © © © ©
. © © ©

1. Onthe Time Entry Type page, click Add.
2. For the new time entry type row, enter values for the following fields:

Page Element

Time Type Code

Classification

ORACLE

Description

o

N H

s &8 & = @ s s == @ =@ @

Enter the code that agency staff members use to enter all the default values associated with

this time entry type when adding time entries.

Select a product area, such as Permit or Planning and Zoning.
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Page Element

Transaction

Category and Subcategory

Billable

Assess Now

Override

Enabled

3. Click Save.

Chapter 15
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Description

Select a specific transaction, such as Plan Review, Inspection, or Planning Application.
Note:
The transactions that are available to select depend on the Classification you selected.
Select the time category and subcategory for the time entry type. For more information on time

categories and subcategories, see Setting Up Time Categories and Subcategories.

Note:
You can leave these fields blank. You can’t select a subcategory without first selecting a
category.

Turn this switch on to make entries associated with this time entry type billable by default.

Turn this switch on to immediately assess fees for entries associated with this time entry type
by default.

Note:
This switch is available only when the Billable switch is turned on.

Turn this switch on to enable agency staff to override the Billable default setting when adding a
time entry.

Turn this switch on to make the time entry type available to select when adding time entries.

Modifying a Time Entry Type

Once you save a time entry type, you can no longer edit the following fields:

- Time Type Code
- Classification

- Transaction

- Category

- Subcategory

ORACLE
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You can toggle the four switches:

Billable
+ Assess Now
- Override
Enabled

Deleting a Time Entry Type

Click the Delete button next to a time entry type row to delete it.

I Note: You can’t delete a time entry type if it is used for any time entries.
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